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Intended use of the system 

The NL3000 [CereTom Elite] is intended to be used for x-ray computed tomography applications for 
anatomy that can be imaged in the 25cm field of view, primarily head and neck. 

 

The CT system is intended to be used for both pediatric and adult imaging and as such has preset dose 
settings based upon weight and age. The CT images can be obtained either with or without contrast. 

Clinical Benefit 

Computed Tomography (CT) provides real time imaging of bone, soft tissue and blood vessels that can 
provide detailed information to diagnose, plan treatment for, and evaluate many conditions in adults and 
children. Additionally, the detailed images provided by CT scans may eliminate the need for exploratory 
surgery. 
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Consumer information 

Proprietary rights 

NeuroLogica®, CereTom® Elite and NEU-CT-GENIII® Scanner Driver System (SDS) are registered 
trademarks of NeuroLogica Corporation, a subsidiary of Samsung Electronics Co., Ltd., in the United 
States, other countries, or both.  Catphan® is a registered trademark of Phantom Laboratory, Inc.  ACR 
Appropriateness Criteria® is a registered trademark of the American College of Radiology.  Image 
Gently® is a registered trademark of Society for Pediatric Radiology.  Doro® is a registered trademark of 
pro med instruments, Inc. 

Legal disclaimer 

This user manual is intended as a guide for material supplied by NeuroLogica Corp.  It provides the 
operator (you) with necessary information to carry out specific procedures and maintain NeuroLogica 
produced equipment.  Use this manual in conjunction with instruction and training supplied by qualified 
NeuroLogica personnel. 

Any information or descriptions contained in this manual may not be reproduced and released to any of 
the general public, or used in conjunction with other professional instruction without written consent of 
NeuroLogica Corp., USA – a subsidiary of Samsung.  Direct any written inquiries to the appropriate 
address found in the section “Contact information”. 

Unauthorized copying of this user manual may not only infringe copyright but also reduce the ability of 
NeuroLogica Corp. to provide accurate and up-to-date information to users: limited and restricted 
operators, and administrators. 

This user manual, though complete and accurate, may not provide answers to undocumented changes or 
unexpected results that could occur from system anomalies. 

Contact information 

Keep user information readily available to contact Customer Service about general assistance or reporting 
on serious incidents (should they occur). 

In the case of a serious incident or adverse event, please notify NeuroLogica at the below contact 
information and establishments local competent authorities. 

To provide any comments, suggestions, or corrections to this user manual, please write to and include 
chapter title and page number: 

NeuroLogica Corporation 
• Customer Service  • 14 Electronics Avenue, Danvers, MA 01923 USA 
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• USA and Canada • 1-888-564-8561 
• International  • 1-978-564-8561 
• Email • support@neurologica.com 

Not e  I f  you  have  que s t i on s  abou t  t h e  c l i n i ca l  u se  o f  your  sy s t em ,  s peak  w i th  t h e  
C l in i ca l  Repre s en t a t i v e .  

 I f  you  have  que s t i on s  abou t  t h e  se r v i c e  o r  f unc t i on a l  ope r a t i on  o f  t h e  sy s t em ,  
sp eak  w i th  t h e  Techn i ca l  Repr e s en t a t i v e .  

Damage in transportation 

Closely examine all packages at the time of delivery.  If you see damage, notate “damage in shipment” on 
all copies of the freight bill before you accept or sign for delivery (by the hospital receiving agent). 

Whether damage is noted immediately or concealed (noticed after delivery), damage MUST be reported 
to carrier immediately upon discovery, or within 14 days after receipt, and content and containers held 
for inspection by carrier. 

Keep in mind – the transportation company will not pay a claim for damage if an inspection is not 
requested within the 14-day period. 

User requirements 

The equipment can only be operated by users who have received professional medical education and 
training, such as physicians, radiologists, and other medical specialists. 

You, the user (the limited or restricted operator or the administrator), are a trained person who is 
certified to operate such systems before scanning or diagnosing patients.  This training must include 
medical and x-ray education, and NeuroLogica applications training. 

Everyone that uses this equipment must read, understand, and follow all instructions, precautions, and 
warnings. 

Keep this user manual near the equipment.  It is important to review the procedures and safety 
precautions periodically. 

 
CAUTION  

 

Due to the mobility of the system, an external interlock is not available; however, a 
prescribed scan can, at any time, be terminated from the scanner or the workstation.  
When the user activates the scan, a 10-second, countdown-clock, scan delay (adjustable to 
99 seconds) triggers.  This countdown allows the user time to perform needed tasks before 
the scan begins. 
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About this user manual 

The instructions in this user manual describe how to use the NeuroLogica NL3000 CereTom Elite 
Computed Tomography (CT) system, manufactured by NeuroLogica Corp. 

The manual applies to both old and new colors of NL3000 CereTom Elite. 

NL3100 OTOScan is no longer documented in this user manual; it is covered in its own manual          
(1-NL3100-060). 

This user manual does not provide medical explanations, but does suggest potential applications for some 
of the software features.  This user manual describes potential safety problems and how to avoid them. 

Anyone who operates this system should have received prior training before attempting to scan or 
diagnose patients, to include medical and x-ray education, in addition to NeuroLogica applications 
training. 

This manual is made available in electronic format to the customer as part of each product delivery. For 
electronic manuals, please go to: Forms.samsungneurologica.com. Click on “Downloads” and choose “CT 
Manuals”. The site will ask for the serial number of your product and a password. The password can be 
provided from Field Service.  

Translation of this manual is available for any country that does not allow for English labeling. Please 
reach out to NeuroLogica directly if translation is required.  

Identified symbols and system classifications 

The specifications and details of this user manual may change in order to improve the product or to 
enhance its performance. 

Throughout this user manual, a yellow triangle with a black border and exclamation point is used to 
draw attention to those conditions or situations that fit one or more of the following criteria, which are 
definitions from ANSI Z535.5: 

 
DANGER  

 

Indicates a hazardous situation, which if not avoided will result in death or serious injury. 

 
WARNING  

 

Indicates a hazardous situation, which if not avoided could result in death or serious 
injury. 

 
CAUTION  

 

Indicates a hazardous situation, which if not avoided could result in minor or moderate 
injury. 
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Conventions used in this user manual 

Table 1: Conventions used in this user manual 

Convention Use 

Commands to perform 
actions 

To perform a string of commands, this user manual will present 
them as follows:  Customize > System 

This means click Customize and then click System. 

Bold  

When content refers to commands, windows, screens, dialog 
boxes, popups, tabs, buttons, options, keyboard keys, statuses, and 
modes, these items appear in bold for faster identification, 
especially in a procedure. 

Italic Identifies a word that is emphasized for your attention. 

Numbered steps 

Numbered paragraphs represent sequential steps that require you 
to take the action in the sequence provided – unless otherwise 
instructed. 

Procedures that are numerical mean that the sequence is 
important to follow.  You may perform some procedures out of 
the recommended sequence; however, the results may vary. 

Notes 

The appearance of a note is as such: 

No te  Ind i ca t e s  add i t i ona l  i n f o rma t i on  t o  h e l p  you  
ope ra t e  t h i s  p roduc t .  

Hyperlink (an electronic 
cross-reference) 

A cross reference appears in the electronic (.pdf) user manual as a 
hyperlink.  To retrieve an electronic copy of this user manual (in 
.pdf), click Help > User Manual from the workstation. 

A hyperlink is a quick way to go to another area of the user 
manual (the referred-to content) with a simple click.  Hyperlinks 
appear like this: “Understanding the types of users” on page 91.  
In this case, hover the mouse pointer over the (gray) hyperlink 
text.  The pointer changes to .  Press the Ctrl key on your 
keypad and (simultaneously) left-click the mouse button.  After 
you left-click the hyperlink, the hyperlink takes you to the 
referenced area in the user manual. 

Click vs left-click 

In this user manual, click means to press the right mouse button.  
To left-click means to press the left mouse button.  This user 
manual never says ‘right click’ as it is assumed that is the 
traditional way to click; however, it does point out when to left-
click the mouse button. 
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Understanding the use of “you” in this user manual 

Unless specifically noted, the implied “you”, in this user manual, is the user (or limited operator).  It is 
assumed users/operators are certified and medically trained personnel, qualified to use these systems.  If 
the user is not the (implied) limited operator, the user will be specifically identified as administrator. 

The following identifies those actions each user is permitted to perform: 

• Administrator Full access permission (rights) to the system and its configuration.  Can 
create protocols, user names and passwords, and all functions of the system. 

• Limited operator 
Modified access permission (rights).  Can modify protocols during system 
use but cannot create and save protocols; has no access to system 
configuration. 

• Restricted operator No access to create, modify, save, or delete protocols; has no access to 
system configuration. 

Active and inactive objects 

When a menu command, option, button, tab, field, and so on are dim, the item is not active (that is, not 
enabled).  When the item is dim, it can mean additional and required tasks must be completed first or 
you (the user) do not have permission to complete the action.  Inactive commands, buttons, and tabs are 
gray.  An active menu command, option, button, tab, and field means you (the user) can use the item to 
perform an action.  Active items are blue and/or highlighted – in other words, not dim. 
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Applicable versions of CereTom Elite 

This manual is applicable to all versions of CereTom Elite, despite the color variations. 

      
Figure 1: Current cover (left) and former cover (right)  
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Chapter 1     Compliance and Safety Requirements 
It is important that you (all users: administrators, operators, and restricted operators) are aware of and 
familiar with compliance and safety requirements to ensure you (all users), the patient, and the systems 
are safe at all times. 

IEC classification and symbols 

   In accordance with International Safety Standard IEC 60601-1, the NL3000 CereTom Elite CT 
scanner is classified as Type B equipment; Class 1 equipment, internally powered equipment, 
and continuous connection to the supply mains in standby state and for specified loading. 

Type B equipment provides an adequate degree of protection against shock, in particular regarding: 

• Allowable leakage current. 
• Reliability of the protective earth connection. 
• (In accordance with the International Safety Standard IEC 60601-1), the manufacturer is not 

responsible for any consequences caused by the unauthorized modification of this equipment. 
• Earth leakage current. 

 
WARNING Equipment is not suitable for use in the presence of a flammable anesthetic mixture with 

air or with oxygen or nitrous oxide. 

 
WARNING Equipment is not suitable for use with oxygen or oxygen-enriched atmospheres. 

Mode of operation is a continuous connection to the supply mains in standby state and for specified 
loading conditions. 

The NL3000 CereTom Elite CT scanner is patient-environment equipment. 

Table 2: Applicable  symbols 

Symbo l  Desc r i p t i on  

 Alternating current 

 
Protective earth (ground) 

 
Caution: consult accompanying documents 

 
Caution: risk of electrical shock 
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Symbo l  Desc r i p t i on  

 
Electrostatic sensitive devices 

 
Type B equipment 

 
X-ray warning 

  
(InTriangle) 

X-ray source assembly emitting 

 
Non-ionizing radiation 

 
Warning: laser in use 

 

Warning:  Laser Radiation Do Not Stare Into Beam Class 2 Laser 
Product 

 Laser Output and Standards Information Label 

 
Warning: FDA Laser Information 

 
Warning: high temperature 

 
Emergency switch 

 
Crush warning 

 
Foot/toe crush warning when lowering machine 

 System up 

 System down 
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S ymbo l  Desc r i p t i on  

 
Load limit for scan board 

 
Temperature limits 

 
Keep away from rain for packaging 

 
Humidity limit for packaging 

 Warning: battery charging 

 Fuse usage 

 

Refer to instruction in user manual/booklet 

 
Legal Manufacturer Symbol 

 

CE Mark or Conformité Européenne; number below CE represent 
Notified Body number 

 

Intertek ETL (Edison Testing Laboratories) Mark 

 European Authorised Representative Symbol 

 
Medical Device Symbol 
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WARNING  

 

This x-ray unit may be dangerous to patient and operator unless safe exposure factors and 
operating instructions are observed. 

Environmental specifications 

 
CAUTION  

 

The specified environment must be constantly maintained: 24-hours a day, seven days a 
week. 

Table 3: Operating environment 

Ope ra t ing  

Ambient temperature 15º C to 35º C (59º F to 95º F) 

Relative humidity 20% to 85% (non-condensing) 

Altitude 0-3010 m (0-10,000 ft.) 

S t o r ag e  

Temperature -25º C to 70º C (-13º F to 158º F) 

Relative humidity 20% to 85% (non-condensing) 

Power ing  sy s t em 

Time period prior to powering the 
system 24 hours1 

Considerations when preparing gantry for use 

 
CAUTION  Check for obstructions before moving and system setup. 

 
CAUTION  Monitor scanner motion to prevent collision with surrounding environment and foreign 

objects. 

 
CAUTION  Press red EMERGENCY STOP button immediately in case of abnormal or unexpected 

motion. 

 
WARNING Verify scanner is on its centipedes (fully down position) prior to positioning patient at 

scanner entrance. 

 
WARNING Make sure all extremities are not under scanner while lowering or raising it. 

 

 
1 If the system is in a facility outside the noted operating temperature, it is recommended to allow the noted time for the system to acclimate to the 
environment. 
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WARNING Keep patient in view at all times.  Ensure that the patient can be seen when the operator is 

near the LCD (touch screen) and EMERGENCY STOP button.  Never leave the patient 
unattended when the patient is in the gantry. 

NeuroLogica advises complying with local regulations and/or site recommendations as specified by the 
facility physicist or certified representative for the following: 

• Use mobile x-ray protective-shielding devices.  Technicians should be at correct location and 
consider wearing personal radiation protective equipment. 

• A radiation safety plan in the working-area boundaries, to optionally include as needed, mobile x-
ray protective shielding devices.  Otherwise assign a larger, working area to avoid radiation to the 
public.  Effective dose for people outside the working area should be less than 0.25mSv annually 
(equals to 5 uSv weekly).  The air kerma rate 0.3 meters away from the working area will be 
smaller than 2.5 uGy/h.  Have monitoring and personal dose management for occupational 
exposure and related public health care personnel. 

• There should be a working plan before scanning.  The plan should include CT condition, time, 
location, working area, scanning plan, and site-clearing method; clearly state the responsibilities 
of working, protection and management personnel.  Keep a good record of the whole process. 

• Restrict the working control and monitor area.  Place obvious warning signs at the control-area 
boundaries to prevent unauthorized personnel from entering.  Installation of a working status 
indication light is recommended. 

• In accordance with the safety plan, self-monitor during the scanning process.  A certified 
radiation representative should monitor the working area and take measurements immediately if 
abnormal circumstances are detected.  Additionally, this should be reported to the local 
environmental administrative and health departments.  There should be a public notice at the 
working area, to include the nature of work, time, location, control area, name of the working 
department, person in charge of the project, contact telephone number, radiation report 
telephone number. 

Site specification 

Table 4: Site specification 

I s sue  Comment  

Receiving area Secured 

Packing material and waste Near availability of a trash receptacle for dunnage 

Room dimensions for use 10ft x 10ft room with a finished level floor; recommended the 
room be well lit 

Power availability 120 VAC/15 amp wall outlets (2x) 

Floor flatness < 0.120in. (3mm) over 10in. (250mm) 
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No t e  No t  a l l  bed s  a r e  c ompa t i b l e  f o r  t h i s  sy s t em .   P l ea s e  con t a c t  Cus t omer  S e rv i c e  
f o r  a s s i s t ance .  

No te  Fo r  good  image  qua l i t y ,  t h e  r e commended  pra c t i c e  i s  t o  k e ep  th e  sy s t em f r e e  
f rom v ibr a t i on  and  t o  ma in t a in  t h e  f l a t ne s s  sp ec i f i c a t i on  no t ed .  

 

Table 5: System operating parameters 

Ope ra t ing  vo l t ag e  100-240 VAC 

Ope ra t ing  f r e quen cy  50Hz-60Hz 

Appa ren t  r e s i s t an ce  o f  s upp l y  ma in s  a t  1 20VAC 0.3 ohms 

Ope ra t ing  cu r r en t  a t  1 20VAC 13 amps 

Hea t  d i s s i pa t i on   1672 watts 
 

Table 6: Battery operating parameters 

Ope ra t ing  vo l t ag e  42-54.4 VDC 

Outpu t  cu r r en t  ( p e a k )  48.6 amps 

Hazardous substances 

Table 7: Hazardous substances table 

Subs t an ce /ma t e r i a l  ≅  We igh t / sy s t em  

Lead 7.48kg (16.5lbs.) 

Cadmium 0.035kg (0.078lbs.) 

Mercury 0kg (0lbs.) 

Hexavalent chromium 0kg (0lbs.) 

PolyBrominated Biphenyls (PBB) <0.45kg (<1lbs.) 

PolyBrominated Diphenyl Ethers (PBDE) <0.45kg (<1lbs.) 

Part numbers and product-marking plates 

Table 8: Core-system-component part numbers and product-marking plate locations 

Componen t  Pa r t  numbe r  Produ c t -mark ing  p l a t e  l o ca t i ons  

CereTom Elite gantry 0-NL3000-000 Near the main input plug or on the side of 
the system.  See Figure 9. 

CereTom Elite workstation 10-00028-001 On the back of the workstation. 
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Componen t  Pa r t  numbe r  Produ c t -mark ing  p l a t e  l o ca t i ons  

QA phantom 10-00011-001 On the back of the phantom. 
 

Note  The  app l i c a b l e  com ponen t s  m ak ing  up  th e  NL3000  CT scanner  i s  i d en t i f i e d  
w i th  t h e  namep l a t e  s t a t emen t  “Th i s  p roduc t  com pl i e s  w i th  r ad i a t i on  
pe r f o rmance  s t anda r d s ,  2 1  CFR sub- chap t e r  J . ”  

Table 9: Core-system component dimensions and weight 

Componen t  
S i z e  ( i n che s )  

(w  x  h  x  d )  

S i z e  ( c en t ime t e r s )  

(w  x  h  x  d )  

We igh t  

( l b s )  

We igh t  

(kg )  

NL3000 system 52in. x 60in. x 28.7in. 134in. x 153in. x 72.89in. 966lbs  438kg 

 
Figure 2: Scanner dimensions 

Locating the product-marking plate 

  
Figure 3: Product-marking plate on side of scanner 
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Class 1 Type B medical devices 

This equipment generates, uses, and can radiate radio-frequency energy.  The equipment may cause 
radio-frequency interference to other medical and non-medical devices and to radio communications.  To 
provide reasonable protection against such interference, this product complies with emission limits for 
Class 1 medical devices as stated in EN 60601-1-2. 

However, there is no guarantee that interference will not occur in a particular installation.  If this 
equipment is found to cause interference (which can be determined by switching the equipment on and 
off), the user should attempt to correct the problem using one or more of the following measures: 

• Re-orient or relocate the affected device(s). 
• Increase the separating space between the equipment and the affected device. 
• Power the equipment from a source different from that of the affected device. 
• Consult the point of purchase or the service representative for further suggestions. 

NeuroLogica Corp. is not responsible for any interference caused either by the use of interconnect cables 
other than those recommended or by unauthorized changes or modifications to this equipment.  
Unauthorized changes or modifications could void the user’s authority to operate the equipment. 

To comply with the regulations applicable to an electromagnetic interface for a Group 1 Class A medical 
device, note the following: 

• All interconnect cables to peripheral devices must be shielded and properly grounded. 
• Use of cables not properly shielded and grounded may result in the equipment causing radio-

frequency interference in violation of the European Union’s Medical Device Directive and FCC 
regulations. 

 
CAUTION  

 

Ensure there is no potentially detrimental interaction of system’s 
irradiation with a patient’s active and implantable medical devices and/or 
body-worn and active medical devices. 

 
CAUTION  

 

Do not use devices that intrinsically transmit radio waves, such as a 
cellular phone, radio transceiver, mobile radio transmitter, radio-
controlled toy, and so on.  Use of these devices near this equipment could 
cause this equipment to malfunction.  Keep power of these devices turned 
off when near this equipment. 

• Medical staff in charge of this equipment are required to instruct technicians, patients, and other 
people who may be around this equipment to fully comply with the above regulations. 
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Focal spot 

The x-ray tube has a single, focal spot with nominal dimensions of 1.0mm wide by 1.0mm long, with a 
range of 1.0 to 1.4mm, as defined by IEC 336-601.  The spot does not move by more than ±0.2mm due to 
thermal expansion in any direction.  The tube does have a positional tolerance of ±1mm from the end of 
the anode and from the window. 

Filtration 

The x-ray tube’s total filtration of the irremovable layers is 4.5mm of aluminum. 

Source to Detector Distance (SID) 

The SID value is 408.593mm. 

Compliance statement 

Note  A l l  ed i t i ons  and  y ea r s  o f  r ev i s i on s  f o r  s t anda rd s  no t ed  in  t h i s  chap t e r  a r e  
s t a t i c  a s  o f  R ev i s i on  31  o f  t h i s  C ereTom E l i t e  U se r  Manua l .  

The NL3000 CereTom Elite system complies with the regulatory requirements of the following:  

• CAN/CSA C22.2 No 601.1-M90 (1990), 2nd Edition, Medical Electrical Equipment - Part 1: 
General Requirements for Safety. 

• CAN/CSA C22.2 No 60601-1-08 Medical electrical equipment - Part 1: General Requirements for 
Basic Safety and Essential Performance. 

• CAN/CSA C22.2 No 60601-1-14 Medical electrical equipment - Part 1: General Requirements for 
Basic Safety and Essential Performance. 

• CENELEC EN 60601-1 2nd Edition, Medical Electrical Equipment - Part 1: General 
Requirements for Safety, includes Amendment A1:1993 and A2:1995. 

• IEC 60601-1:2005 Medical electrical equipment - Part 1: General Requirements for Basic Safety 
and Essential Performance, 3rd Edition. 

• IEC 60601-1:2012 Medical electrical equipment - Part 1: General Requirements for Basic Safety 
and Essential Performance 

• IEC 60601-1-1 (2000) 2nd Edition: Medical Electrical Equipment, Part 1: General Requirements 
for Safety- Collateral Standard: Safety Requirements for Medical Electrical Systems. 

• IEC 60601-1-2:2007 Ed3.0 Medical Electrical Equipment - Part 1-2: General Requirements for 
Basic Safety and Essential Performance - Collateral Standard: Electromagnetic Compatibility - 
Requirements and Tests Ed2.1 (Edition 2:2001 Consolidated with Amendment 1:2004). 
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• IEC 60601-1-2:2014 Ed4.0 Medical Electrical Equipment - Part 1-2: General Requirements for 
Basic Safety and Essential Performance - Collateral Standard: Electromagnetic Disturbances 

• IEC 60601-1-3:2008 Ed3.0 Medical Electrical Equipment-Part 1-3: Collateral Standard: General 
Requirements for Radiation Protection in Diagnostic X-ray Equipment. 

• IEC 60601-1-3:2012 Medical Electrical Equipment-Part 1-3: Collateral Standard: General 
Requirements for Radiation Protection in Diagnostic X-ray Equipment. 

• IEC 60601-1-4 (2000) Edition 1.1 Consolidated Edition, Medical Electrical Equipment Part 1-4: 
General Requirements for Safety – Collateral Standard: Programmable Electrical Medical 
Systems. 

• IEC 60601-1-6:2010 Ed3.0 Medical Electrical Equipment - Part 1-6: General Requirements for 
Basic Safety and Essential Performance - Collateral Standard: Usability. 

• IEC 60601-1-6:2012 Ed3.1 Medical Electrical Equipment - Part 1-6: General Requirements for 
Basic Safety and Essential Performance - Collateral Standard: Usability. 

• IEC 60601-2-32 (1994) Part 2-32, Particular Requirements for Safety sections 2.32 Specification 
for Associated Equipment of X-ray Equipment. 

• IEC 60825-1:2014 Safety of Laser Products - Part 1: Equipment Classification, and Requirements 
3rd Ed. 

• IEC 60825-1:2007 Safety of Laser Products - Part 1: Equipment Classification, and Requirements 
2nd Ed. 

• IEC 62133:2012 Secondary Cells and Batteries Containing Alkaline or Other Non-acid 
Electrolytes - Safety Requirements for Portable Sealed Secondary Cells, and for Batteries Made 
from them, for use in Portable Applications. 

• IEC 62366:2007 Application of Usability Engineering to Medical Devices. 
• IEC 60601-2-44:2009 Ed3.0 Medical Electrical Equipment - Part 2-44: Particular Requirements for 

the Basic Safety and Essential Performance of X-ray Equipment for CT. 
• IEC 60601-2-44:2012 Medical Electrical Equipment - Part 2-44: Particular Requirements for the 

Basic Safety and Essential Performance of X-ray Equipment for CT. 
• IEC 62304:2015 Ed1.1 Medical Device Software – Software lifecycle processes 
• NEMA XR-25 Specifies an Equipment Feature for CT Scanners to Produce Dose-related 

Notification and Alert Messages to Inform Operators Prior to Scanning if the Estimated Dose 
Would Exceed the Preset Levels. 

• NEMA XR-29 Standard Attributes on CT Equipment Related to Dose Optimization and Manual. 
• International Electrotechnical Commission (IEC) International Standards Organization, when 

applicable. 
• Intertek Testing Service (ITS), an independent testing laboratory. 
• Medical Device Good Manufacturing Practice Manual Issued by the FDA (Food and Drug 

Administration).  Department of Health, USA. 
• NeuroLogica Corporation is ISO 13485:2016 and MDSAP certified. 
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EMI/EMC terms 

Electromagnetic Compatibility 

Electromagnetic Compatibility (EMC) is the branch of electrical sciences that studies the unintentional 
generation, propagation, and reception of electromagnetic energy with reference to the unwanted effects 
(Electromagnetic Interference (EMI)) that such energy may induce.  The goal of EMC is the correct 
operation, in the same electromagnetic environment, of different equipment, which use electromagnetic 
phenomena and the avoidance of any interference effects. 

In order to achieve this, EMC pursues two different kinds of issues.  Emission issues are related to the 
unwanted generation of electromagnetic energy, to the countermeasures that should be taken in order to 
reduce such generation, and to avoid the escape of any remaining energies into the external environment.  
Susceptibility or immunity issues, in contrast, refer to the correct operation of electrical equipment in the 
presence of unplanned electromagnetic disturbances. 

Interference, or noise, mitigation, and hence EMC is achieved by addressing both emission and 
susceptibility issues, that is., quieting the sources of interference, making the coupling path between 
source and victim less efficient, and making the potential victim systems less vulnerable. 

Electromagnetic Interference 

Electromagnetic Interference (EMI), also called Radio Frequency Interference (RFI) is an unwanted 
disturbance that affects an electrical circuit due to electromagnetic radiation emitted from an external 
source.  The disturbance may interrupt, obstruct, or otherwise degrade or limit the effective performance 
of the circuit.  The source may be any object, artificial or natural, that carries rapidly-changing electrical 
currents, such as an electrical circuit, the sun, or the northern lights. 

Susceptibility 

Susceptibility is the capability of an electronic system to respond to unwanted electrical energy. 

EMI/EMC compliance 

This equipment complies with IEC 60601-1-2 EMC standard for medical devices. 

The NL3000 CereTom Elite system is suitable to be used in an electromagnetic environment, as per the 
limits and recommendations described in the tables hereafter: 

• Emission compliance level and limits (Table 11). 
• Immunity compliance level and recommendations to maintain equipment clinical utility (Table 

12, Table 13, and Table 14). 
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No te  Th i s  sy s t em compl i e s  w i th  t h e  abov e  men t i oned  EMC s t anda rd  when  u s ed  
w i th  supp l i ed  ca b l e s .   I f  d i f f e r en t  c a b l e  l eng th s  a r e  r equ i r e d ,  con t a c t  a  
qua l i f i ed  se r v i c e  r e pr e sen t a t i v e  f o r  adv i c e .  

Table 10: Acronyms and abbreviations 

Acronym  and  
abb rev i a t i on  De f in i t i on  

CT Computed Tomography 
HIS Hospital Information System 
PACS Picture, Archiving, and Communication System 
RIS Radiology Information System 
SCU Service Class User 
SCP Service Class Provider 
CBV Cerebral Blood Volume 
CBF Cerebral Blood Flow 
MTT Mean Transit Time 
AEC Automatic Exposure Control 

 

 
WARNING Medical, electrical equipment needs special precautions regarding EMC and needs to be inst   

put into service according to EMC information provided in accompanying documents. 

 
CAUTION Portable and mobile RF communications equipment can affect medical electrical equipment. 

 
CAUTION Do not use or stack the equipment or system with other equipment and if adjacent or 

stacked use is necessary, the equipment or system should be observed to verify normal 
operation in the configuration in which it will be used. 

No te  The  EMC t ab l e s  and  o th e r  gu ide l ine s  i n c l ud ed  in  t h i s  u se r  manua l  p rov id e  
in fo rma t i on  t o  t h e  u se r  e s sen t i a l  i n  de t e rm in ing  t h e  su i t a b i l i t y  o f  t h e  
equ i pment  o r  sy s t em fo r  t h e  e l e c t romagne t i c  env i ronment  o f  u se ,  and  in  
manag ing  t h e  e l e c t romagne t i c  env i ronment  o f  u se ;  t o  pe rm i t  t h e  equ ipment  o r  
sy s t em t o  p e r f o rm i t s  i n t ended  u se  w i thou t  d i s t u rb i ng  o th e r  equ i pment  and  
sy s t em s  o r  non -med i ca l  e l e c t r i c a l  equ i pment .  

No t e  The  EMISS IONS cha ra c t e r i s t i c s  o f  t h i s  equ ipment  make  i t  su i t ab l e  f o r  u s e  in  
indus t r i a l  a r ea s  and  hosp i t a l s  (C ISPR 11  c l a s s  A ) .  I f  i t  i s  u sed  in  a  r e s i den t i a l  
env i ronment  ( f o r  wh i ch  CISPR 11  c l a s s  B  i s  no rma l l y  r e qu i r ed )  t h i s e qu ipment  
m igh t  no t  o f f e r  adequa t e  p ro t e c t i on  t o  r ad io - f r equen cy  com muni ca t i on  
se r v i c e s .  The  u se r  m igh t  need  t o  t ak e  m i t i g a t i on  mea su re s ,  such  a s  r e l o ca t ing  
o r  r e - o r i en t ing  t h e  equ i pment .  
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Table 11: Emission Declaration for NL3000 system 

NL3000 CereTom Elite system is intended for use in the electromagnetic environment specified below.  The 
user of the NL3000 CereTom Elite system should assure it is used in such an environment. 

Emi s s i ons  
t e s t  Compl i ance  E l e c t romagne t i c  e nv i ronment  gu ide  

RF emissions 

CISPR 11 
Group 1 

The NL3000 system uses RF energy only for internal function.  
Therefore, the RF emissions are very low and are not likely to 
cause any interference in nearby electronic equipment. 

 

RF emissions 

CISPR 11 

 

Harmonic 
emissions, 

IEC 61000-3-2 

 

Voltage 
fluctuations/ 

flicker 
emissions, 

IEC 61000-3-3 

Class A 

 

 

Class A 

 

 

Complies 

The NL3000 CereTom Elite system is predominantly intended for 
use in non-domestic environments, and not directly connected to 
the public mains network.  The NL3000 CereTom Elite system is 
predominantly intended for use (for example, in hospitals) with 
an appropriate power supply and the recommended shielding for 
portable use. 
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Table 12: EMC Immunity Declaration for the NL3000 CereTom Elite system 

NL3000 CereTom Elite system is intended for use in the electromagnetic environment specified below.  
The user of the NL3000 CereTom Elite system should assure it is used in such an environment. 

Immuni t y  t e s t  IEC  60601 - 1 -2  
t e s t  l e v e l  Compl i ance  l e v e l  E l e c t romagne t i c  

env i ronment  gu idanc e  

Electrostatic 

Discharge (ESD) 

IEC 61000-4-2 

± 8 kV contact 

± 2kV,  
± 4kV, ±8kV, 
±15kV air 

± 8 kV contact 

± 2kV, ± 4kV, ±8kV, 
±15kV air 

Floors should be wood, concrete, 
or ceramic tile.  If floors are 
covered with synthetic material, 
the relative humidity should be 
at least 30%. 

Electrical fast 
transient/burst 

IEC 61000-4-4 

±2kV for power 

supply lines 

±1kV for input/ 

output lines 

±2kV for power 
supply lines 

±1KV for 
input/output lines 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Surge 

IEC 61000-4-5 

± 1kV line-line 

± 2kV line-ground 

± 1kV line-line 

± 2kV line-ground 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Voltage dips, 
short 
interruptions and 
voltage variations 
on power supply 
input lines IEC 
61000-4-11 

0% UT; 0.5 cycle At 0°, 
45°, 90°, 135°, 180°, 
225°, 270° and 315° 

 

40% UT; 5 cycles 

 

70% UT; 25 cycles 

 

0% UT; 250 cycles 

  

0% UT; 0.5 cycle At 0°, 
45°, 90°, 135°, 180°, 225°, 
270° and 315° 

 

40% UT; 5 cycles 

 

70% UT; 25 cycles 

 

0% UT; 250 cycles 

 

Mains power quality should be 
that of a typical commercial or 
hospital environment.  If the 
user of the NL3000 CereTom 
Elite system requires continued 
operation during power 
interruptions, it is recommended 
that the NL3000 CereTom Elite 
system be powered from its 
internal batteries. 

Power frequency 
(50/60Hz) 

magnetic field 

IEC 61000-4-8 

30 A/m, 50Hz or 
60Hz 

30 A/m, 50Hz or 
60Hz 

Power-frequency magnetic-fields 
should be at levels characteristic 
of a typical location in a typical 
commercial or hospital 
environment. 

Clause 8.10 Per  
Table 9 Per Table 9 Reference to said table in IEC 

60601-1-2: 2014 

Countermeasures against EMC related issues 

Generally, it is very difficult to grapple with issues related to EMC.  It may take a variable amount of 
time and cost to identify issues causing interference. 
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General countermeasures of electromagnetic interference with other equipment: 

• Electromagnetic interference may be alleviated by positioning other equipment far from system. 
• Electromagnetic interference may be mitigated by changing relative location (installation angle) 

between system and other equipment. 
• Electromagnetic interference may be eased by changing wiring locations of power/signal cables of 

other equipment. 
• Electromagnetic influence may be reduced by altering the power-supply path of other equipment. 
• Electromagnetic environment specified (Table 12 and Table 13). 

Table 13: EMC Immunity Declaration 

NL3000 CereTom Elite system is intended for use in the electromagnetic environment specified below.  The 
user of the NL3000 system should assure it is used in such an environment. 

Immuni t y  t e s t  IEC  60601 - 1 -2  
t e s t  l e v e l  

Compl i ance  
l e v e l  

E l e c t romagne t i c  
env i ronment  gu idanc e  

Conducted 

RF 

IEC 61000-4-6 

3 Vrms 

150kHz to 80MHz 
V1 = 3 Vrms 

Portable and mobile RF 
communications equipment 
should be used no closer to any 
part of the NL3000 CereTom Elite 
system, including cables, than the 
recommended separation distance 
calculated from the equation 
appropriate for the frequency of 
the transmitter. 

Recommended separation 
distance: see Table 14. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 1    Compliance and Safety Requirements  Page 47 of 374 

NL3000 CereTom Elite system is intended for use in the electromagnetic environment specified below.  The 
user of the NL3000 system should assure it is used in such an environment. 

Immuni t y  t e s t  IEC  60601 - 1 -2  
t e s t  l e v e l  

Compl i ance  
l e v e l  

E l e c t romagne t i c  
env i ronment  gu idanc e  

Radiated RF 

IEC 61000- 4-3 

(alternative method: 
IEC 61000-4-21) 

3 Vrms 

80MHz to 2.5GHz 
E1 = 3 V/m 

 
 

Where P is the maximum power 
rating in watts and d is the 
recommended separation distance 
in meters. 

Field strengths from fixed 
transmitters, as determined by an 
electromagnetic site survey, should 
be less than the compliance levels 
(V1 and E1). 

Interference may occur in the 
vicinity of equipment marked with 
the following icon:  

 
 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 48 of 374 Countermeasures against EMC related issues 

Table 14: Recommended separation distances 

Recommended  s epa ra t i on  d i s t ance s  b e tween  po r t a b l e  and  mobi l e  RF communi ca t i on s  
equ i pment  and  th e  NL3000  CereTom E l i t e  sy s t em  

NL3000 CereTom Elite system is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled.  The user of the NL3000 CereTom Elite system can help prevent electromagnetic 
interference by maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the NL3000 CereTom Elite system as recommended below, according to the maximum 
output power of the communications equipment. 

Ra t ed  max imum 
ou tpu t  Power  (P )  i f  
t r an smi t t e r  Wat t s  
(W)  

150kHz t o  80MHz 

Sepa ra t i on  d i s t an ce  
me t e r s 2  

8 0MHz t o  800MHz 

Sepa ra t i on  d i s t an ce  
me t e r s 2 

8 00MHz t o  2 .5GHz 

Sepa ra t i on  d i s t an ce  
me t e r s  2  

0.01 .12 .12 .23 

0.1 .38 .38 .73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the separation distance is estimated using 
the equation in the corresponding column, where P is the maximum output power rating of the transmitters in 
Watts (W) according to the transmitter manufacturer. 

No te      A t  80MHz and  800MHz,  s e pa ra t i on  d i s t an ce  f o r  h i ghe r  f r equ ency  
r ange  app l i e s .  

 

No te       These  gu id e l i ne s  may  no t  app l y  in  a l l  s i t ua t i on s .   
E l e c t romagne t i c  p ropaga t i on  i s  a f f e c t ed  by  a bso rp t i on  and  
r e f l e c t i on  f rom s t ru c tu r e s ,  o b j e c t s ,  and  p eop l e .  

 
2Separation distance according to frequency of transmitter (m). 

 

 
2 Separation distance according to frequency of transmitter (m) 
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Use recommendations 

This product complies with IEC 60601-1-2 standard for medical devices and with radio frequency 
emission requirements per CISPR11 Group 1 Class A standard limits.  The NL3000 CereTom Elite 
system is predominantly intended for use in hospitals. 

Do not use devices that intentionally transmit RF signals (cellular phones, transceivers, or radio 
controlled products) in the vicinity of this equipment as it may cause performance outside the published 
specifications.  Keep the power to these types of devices turned off when near this equipment. 

Adhering to the distance separation (recommended in Table 14) between 150kHz and 2.5GHz, will 
reduce disturbances recorded at the image level, but may not eliminate all disturbances; however, when 
installed and operated as specified herein, the system will maintain its essential performance by 
continuing to safely acquire controlled, radiological, x-ray exposures in a mobile radiography 
environment.  For example, a 1W mobile phone (800MHz to 2.5GHz carrier frequency) will be put 2.3 
meters apart from the NL3000 CereTom Elite system (in order to avoid image interference risks). 

The use of accessories, transducers, and cables, other than those specified, may result in degraded, 
electromagnetic compatibility of the NL3000 CereTom Elite system. 

The medical staff in charge of this equipment is required to instruct technicians, patients, and other 
people who may be around this equipment to comply fully with the above equipment requirements. 

Installation recommendations 

This system complies with above-mentioned EMC standard when used with supplied cables. 

In order to minimize interference risks, the following requirements apply. 

Cable shielding and grounding 

All interconnect cables to peripheral devices must be shielded and properly grounded.  Use of cables not 
properly shielded and grounded may result in the equipment causing radio-frequency interference. 

Adjacent components and equipment 

NL3000 CereTom Elite system should not be used adjacent to or stacked with other equipment; if 
adjacent or stacked use is necessary, the NL3000 CereTom Elite system should be tested and verified to 
make sure normal operation in the configuration in which it is used.  Consult NeuroLogica and Facility 
Technical Support staff regarding device/system configurations. 
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Static magnetic field limits 

In order to avoid interference on the NL3000 CereTom Elite system, static-field limits from the 
surrounding environment are specified.  Static field is specified less than <1 Gauss around the unit. 

Electrostatic discharge environment and recommendations 

• In order to reduce electrostatic-discharge interference, install a charge-dissipative floor-material to 
avoid electrostatic charge-buildup. 

• The relative humidity must be at least 30 percent. 
• The dissipative material must be connected to the system ground-reference. 

Facility IT-NETWORK 

The CereTom Elite system utilizes the IT-NETWORK for the customer (as applicable) to communicate 
with the modality worklist and for supplemental, image-storage space.  As part of the installation, the 
applicable IT-NETWORK is reviewed to create the appropriate setup to the system.  Setup is done to 
ensure no potential concerns arise with the system. 

 
CAUTION It is possible that the IT-NETWORK connection from the system could result in 

previously unidentified issue(s) to the respective population.  Should this occur, please 
contact Customer Service right away to identify, analyze, evaluate, and resolve the issue(s). 

 
CAUTION It is possible that any changes to the IT-NETWORK made by the facility could introduce a 

new issue where Customer Service needs to be contacted to address the concern, right 
away. 

Changes to the IT-NETWORK include – but are not limited to the following: 

• Changes in network configuration 
• Connection to additional items 
• Disconnection to items 
• Updating equipment 
• Upgrading equipment 

Hazard Information 

Please review this material before using the system and observe basic, common-sense safety rules when 
operating this scanner. 
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General safety considerations and statements 

Review the following before using the system and observe basic, common-sense safety rules when 
operating the scanner: 

• Become familiar with the functional hardware to help recognize serious problems. 
• Do not use scanner if it appears damaged or fails. 
• Wait for qualified personnel to correct any problem. 

 
WARNING The health software is installed on a medical device and is required for its operation.  In 

order to remove the software from use, the system must be decommissioned.  

 
WARNING Modification of this equipment is not allowed. 

 
CAUTION All non-medical electrical equipment will comply with relevant IEC and ISO safety 

standards. 

 
CAUTION Federal law restricts the use of this device without a prescription by a physician. 

 
CAUTION Always store and/or use unit in a well-ventilated area.  Keep air pollution to a minimum.  

Keep floor clean at all times. 

 
CAUTION Do not touch parts of non-medical electrical equipment in patient environment and 

patient simultaneously. 

 
CAUTION For disposal of any material emanating from the system; follow local regulations. 

 
CAUTION This system was designed for use by individuals trained in CT system operation.  The 

user should be familiar with this user manual before scanning patients. 

 
CAUTION It is the user’s responsibility to make sure that after installation or subsequent 

modification, the system will be in compliance with the requirements of collateral 
standard IEC 60601-1. 

 
WARNING Installation of this product is performed in accordance with Installation Manual (1-

NL3000-059).  All installation processes and qualified personnel are outlined in that 
document. 

 
WARNING Proper disposal of batteries is required to ensure compliance with environmental safety 

guidelines.  Contact authorized NeuroLogica representative for instructions. 

 
WARNING Observe safety-exposure factors and operating procedures to protect patient from physical 

harm during contact with this x-ray scanner. 

 
WARNING Observe safety requirements to prevent excessive dose exposure to patient and/or 

operator. 

 
CAUTION Improper system usage could endanger patients and/or users and void the warranty if 

not operated correctly. 

 
CAUTION Should the workstation encounter a computer related virus, be sure to contact Technical 

Support for assistance with removing said virus from the equipment. 

 
CAUTION Radiation dose exposure to patients should not exceed maximum of 1Gy CTDI. 
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CAUTION For proper disposal of material at equipment’s end-of-useful life; contact NeuroLogica 

for instructions. 

 
CAUTION Equipment in which protection against electric shock relies on basic insulation only, 

should not be used in this system. 

Laser safety  

  

The laser itself is mounted internally to the disk assembly, which spins (as prescribed by the control 
panel) within the system’s bore.  Therefore, the laser’s output light will always be aimed at, and rotating 
within the bore itself. 

Laser parameters 

• Wavelength  = 650nm 
• Output Power  = 1mW 

 
Figure 4: Laser aperture’s direction 

 
WARNING Complies with 21 CFR 1040.10 and 1040.11 except for conformance with IEC 60825-1 Ed. 3., 

as described in Laser Notice No. 56, dated May 8, 2019. 

This statement will be a label placed on the User Interface side of the system   

 
WARNING Viewing the laser output with certain optical instruments (for example, eye loupes, 

magnifiers, and microscopes) within a distance of 100mm may pose an eye hazard. 

 
CAUTION Instruct the patient to close his/her eyes before activating (turning ON) the alignment light. 

 
CAUTION Closely monitor infants and infirm patients to prevent them from accidentally staring into 

the beam. 

 
CAUTION Class 2 laser radiation when open.  Do not stare into the beam or view directly with 

optical instruments. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 1    Compliance and Safety Requirements  Page 53 of 374 

 
CAUTION Use of controls or adjustments or performance of procedures other than those specified 

herein may result in hazardous radiation exposure. 

 
CAUTION The warning label (below, for “laser in use”) is located on the front of the scanner cover 

and also inside the scanner to identify the presence of a laser. 

Scanner mobility safety 

 
CAUTION  

 

Due to the mobility of the system, an external interlock is not available; however, a 
prescribed scan can, at any time, be terminated from the scanner or the workstation.  
When the user activates the scan, a 10-second, countdown-clock, scan delay (adjustable to 
99 seconds) triggers.  This countdown allows the user time to perform needed tasks before 
the scan begins. 

 
CAUTION To prevent healthcare provider injuries, the scanner and workstation should not be moved 

simultaneously by a single healthcare professional.  When moving the scanner about the 
facility, NeuroLogica recommends (in the absence of the Scanner Drive System (SDS)) 
that at least two people move the scanner (lengthwise, only).  Be especially cautious when 
moving the system about an inclined floor.  To prevent population injuries, a single 
healthcare professional should never move the scanner and workstation at the same time 
when the system is not connected to the SDS. 

 
WARNING To prevent involuntary movement, do not position scanner on an incline while in 

Transport mode. 

 
WARNING Contact Technical Support for assistance when movement is required on an incline. 

No te  Be  su r e  t h e r e  a r e  no  obs t a c l e s  i n  f ron t  o f  t h e  s cann er  wh i l e  you  move  t h e  
s canner .  

 
CAUTION Check to ensure proper clearance is provided to allow removal of patient from scanner in 

case of a power failure.  This is accomplished by moving patient’s support (after unlocking 
wheel-locks) away from scanner. 

 
CAUTION To prevent patient entrapment or entanglement with accompanying equipment, slowly 

move scanner away from patient using the LCD (touch screen) while observing patient. 

 
CAUTION Do not station or operate the system on an uneven floor.  The flatness requirement is 

3mm over a distance of 250mm. 

 
CAUTION Prior to transporting the scanner, verify that power cord is unplugged from wall to avoid 

damage to cord and outlet.  Verify that ethernet cable is unplugged from workstation to 
avoid damage to cable and connector. 

Floor level (even) 

For proper operation, the system must be operated on an even, level, hard surface. 
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Carpeting 

Do not use the system on a carpeted floor.  Poor image quality could result due to unevenness of the 
floor. 

Electrical safety 

 
WARNING The system’s external AC power cord should be checked prior to use to verify there are no 

exposed wires or damaged insulation/prongs.  Damaged prongs could result in sparking 
and fire.  In case of such damage, contact Customer Service, immediately. 

 
CAUTION Check to ensure the AC outlet is working properly before plugging in the system’s AC 

power cord. 

 
WARNING To prevent electrical shock, do not connect items that are not specified as part of the 

system. 

 
WARNING To prevent electrical shock, do not remove the covers from the equipment.  The covers 

protect the user and the patient from moving parts or electrical shock.  Hazardous voltages 
are present within this equipment.  The covers provide protection from radiation exposure 
given off from the x-ray tube.  The covers also protect the equipment. 

 
WARNING An electrical shock hazard: no user should apply serviceable parts; refer to qualified service 

personnel for any service. 

 
WARNING Always electrically isolate this equipment from the main electrical supply before cleaning 

and disinfecting it to prevent short-circuiting or possible electrical shock. 

 
WARNING Never position the mobile system in a manner that prohibits access to unplugging it or 

prohibits pressing the EMERGENCY STOP button. 

 
WARNING To minimize shock hazard, the system chassis must be connected to an electrical ground.  

The system is grounded through the ground conductor of the supplied, three-conductor 
power cord.  The power cord must be plugged into a three-conductor electrical outlet 
receptacle.  Do not alter the ground connection. 

 
WARNING Avoid all contact with any electrical conductor as follows: 

• Allow only people who know the proper procedures and use the proper tools to install, 
adjust, repair, or modify the equipment. 

• Only use this equipment in rooms or areas that comply with all applicable laws (or 
regulations having the force of law) concerning electrical safety for this type of 
equipment. 

• The detachable cord is the disconnecting device, which is used to remove mains power 
from the wall socket. 

• The system is internally powered. 

 
WARNING For Class 1 equipment (for example, the workstation cart, AC power cord, and so on) 

using an alternate internal source: a warning to use the alternate source if the integrity of 
the protective earth conductor is in doubt. 

 
WARNING Do not position the system so that it is difficult to access the AC power cord. 
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CAUTION Protect the system power cord against mechanical damage. 

Where the integrity of external, protective conductor in the installation or its arrangement is in doubt, 
equipment is operated from its internal electrical power source. 

Parts of non-medical electrical equipment in the patient environment that, after removal of covers, 
connectors, and so on, without the use of a tool, may be contacted by the operator during routine 
maintenance and calibration, will operate at a voltage not exceeding 25VAC or 60VDC or peak value 
supplied from a source that is separated from the supply mains in accordance by one of the methods 
described in IEC 60601-1. 

 
CAUTION To help prevent tripping hazards, use care in the arranging of any cords (for example, AC 

cord, ethernet cable, and so on) when connecting to the system/workstation. 

 
CAUTION To prevent damaging electrical outlet cords, check to ensure they have been removed and 

properly stored before transporting the scanner. 

 
CAUTION All systems within the patient environment provide the same level of safety as medical 

equipment complying with IEC 60601-1. 

 
WARNING The NL3000 CereTom Elite CT scanner contains high-voltage circuits for generating x-

rays.  Only trained and qualified personnel should be permitted access to the internal parts 
of this equipment. 

 
CAUTION Use the Universal Serial Bus (USB) terminal located near the EMERGENCY-STOP (E-

STOP) button for archiving to USB, only. 

 
CAUTION For proper disposal of material at the end of the useful life of the equipment, contact 

NeuroLogica for instructions. 

Mechanical safety 

 
WARNING In case of unwanted movement or motion, press the EMERGENCY STOP (E-STOP) 

button. 

 
WARNING Physically assist all patients on and off the bed and into position on the scan board.  

Adjust the bed to the specified height for patient loading and unloading (see “Positioning 
the patient” on page 85). 

 
WARNING When positioning the scanning platform, be careful when moving the patient support to 

avoid having it hit the scanner covers. 

 
WARNING Position any lines (IVs and so on) attached to the patient so the lines cannot catch on the 

scanner during scanner travel. 

 
CAUTION Prevent pinching or crushing of the patient’s extremities.  Keep patient’s hands on the side 

of his/her body.  Watch the patient and equipment carefully at all times during scanner 
movement. 
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CAUTION To prevent pinching or crushing of the operator’s feet/toes, be sure extremities are not 

positioned under the scanner when it is being lowered from Transport mode to Scan 
mode. 

Radiation safety 

 
Figure 5: Dangerous to patient and operator label 

  
WARNING Improperly used x-ray equipment may result in unwanted radiation exposure.  Read and 

understand the instructions in this user manual before attempting to operate this 
equipment. 

 
CAUTION Use technique factors prescribed by the radiologist or diagnostician.  Use a dose that 

produces the best diagnostic results with the least x-ray exposure. 

 
CAUTION All persons authorized to use the equipment must understand the dangers posed by 

excessive x-ray exposure.  NeuroLogica recommends use of protective materials and 
devices. 

 
WARNING Everyone having anything to do with x-ray must take adequate steps to insure protection 

against injury. 

 
CAUTION The use of this device requires its users to receive proper training in accordance with local 

and national laws. 

 
CAUTION Never perform calibration with patients in the scanner or while personnel are present in 

the vicinity of the scanner. 

 
CAUTION Amber indicator lights (on the top of the scanner) illuminate during x-ray exposure. 

 
CAUTION Ensure that there is no potential for detrimental interaction of the system’s irradiation with 

a patient’s active implantable medical devices and/or body-worn, active, medical devices. 

X-rays can only be produced during the following conditions: 

•   The scanner is in the down (Scan mode) position. 
•  The Start button is activated. 
•  The workstation is connected. 

Fire and explosion safety 

 
DANGER This equipment is not suitable for use in presence of a flammable anesthetic mixture with 

air or with oxygen or nitrous oxide. 

 
DANGER This equipment is not suitable for use in the presence of oxygen or oxygen-enriched 

atmosphere. 
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• Fire regulation for the type of medical area being used should be fully applied, 
observed, and enforced.  Fire extinguishers should be provided for both electrical 
and non-electrical fires. 

• All operators of the NL3000 CereTom Elite scanner should be fully aware of and 
trained in the use of fire extinguishers and the firefighting equipment, and in local 
fire procedures. 

 
WARNING Only use extinguishers on electrical or chemical fires that are specifically labeled for those 

purposes.  Using water or other liquids on an electrical fire can lead to fatal or other 
serious injury. 

If it is safe to do so, attempt to isolate the equipment from electrical and other supplies 
before attempting to fight a fire.  This will reduce the risk of electrical shocks. 

EMERGENCY STOP button 

 
CAUTION Check the EMERGENCY-STOP (E-STOP) button at least one time a month to ensure 

proper function. 

 
CAUTION Every user should take a few minutes to locate the E-STOP before scanning the first 

patient. 

 
CAUTION In case of emergencies, stop scanner movement immediately by pressing the E-STOP red 

push-button located on the scanner, below the LCD (touch screen). 

 
Figure 6: NL3000 CereTom Elite E-STOP locations 

 Press the E-STOP button to perform the following: 

• Stop system (if it loses control). 
• Stop all system motion and x-ray. 
• Remove power to the gantry drives and x-ray system. 
• If the CereTom Elite system starts to move unexpectedly. 
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 Twist the E-STOP button clockwise until the button pops out. 

• To restore the system after pressing the E STOP button. 

 Make sure to resolve the situation. 

No te  When  E -STOP  i s  a c t i v a t ed ,  t h e  mov ing  g an t ry  may  ove r run  by  l e s s  t h an  
10mm.  

Battery safety and information 

The workstation battery capacity status icon shows an indication of battery capacity, which is identical to 
the indicator on the scanner.  The user should always check the indicator on the scanner to verify the 
batteries’ status; there are four 12-volt batteries in the scanner. 

 
CAUTION The system unit contains batteries and will always be charging when plugged into AC 

mains. 

 
CAUTION In case of battery leakage, do not handle the batteries themselves nor continue to operate 

the system.  Contact NeuroLogica for service.  See “Contact information” on page 26. 

System battery capacity 

The range is 0 to 100.  Battery voltage and current are used to calculate the system’s battery capacity 
based on charging (plugged in) state. 

Run time operation 

During normal, run-time operation (all components, up and running), the battery capacity is being 
calculated one time per second.  The capacity to the scanner’s Liquid Crystal Display (LCD) – a touch 
screen – is updated at this time as well. 

No te  The  u s e r  c a pa c i t y  i nd i ca t o r  on  t h e  s cann er ’ s  LCD ( t ou ch  s c r een )  i s  d i sp l ay ed  
in  5% inc r emen t s  when  abov e  10%.   When  10% and  be l ow ,  t h e  d i sp l ay ed  
capa c i t y  i s  i n  1% inc r emen t s .   Tha t  i s ,  a bove  10% us e r  c a p ac i t y ,  t h e  d i sp l ay ed  
va l ue  i s  a lway s  round ed  t o  t h e  c l o s e s t  mu l t i p l e  o f  5  ( f o r  ex ampl e ,  9 3  g e t s  
rounded  t o  95 ,  4 2  g e t s  rounded  t o  40 ,  4 7  g e t s  rounded  t o  45 ,  and  so  on ) .  

State changes 

After each periodic update, capacity is checked to make sure it does not fall below certain thresholds, as 
follows: 

• Low voltage alarm state 

When user capacity goes below 25%, a periodic alarm will sound.  It will remain in this state 
until the user capacity has gone back up to 27% or higher. 

• Low voltage lock-out state 
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When the user capacity goes below 1%, the LCD (touch screen) Main tab’s buttons are disabled 
and starting a scan is prohibited; for example, positioning (the ability to move the scanner) and 
certain protocol buttons are disabled.  It will remain in this state until the user capacity has gone 
back up to 2% or higher.  The low voltage alarm will continue to be active in this state. 

Predictive scanning 

Before each scan, battery usage for that scan is predicted based on the selected load factors (for example, 
kV, mA, time, and so on), and is compared against the available user capacity.  In the case that there is 
not enough user capacity to scan, a popup appears on the workstation screen.  The user can cancel the 
scan at that time or continue the scan, with the understanding that the scan may abort due to a low-
power fault. 

The percentage of the tube capacity required for a scan = ((kV x mA x scan time(s))/180000) x 100%.  
Approximately 0.11% capacity is regained each second during cooling. 

Under voltage protection 

When the system battery voltage drops below the low-voltage cutout-level while unplugged, a system 
power-down sequence is initiated (turns off various sub-components, including the internal power 
sources). 

Recovering the system 

 Make sure the system is plugged into an operational wall outlet. 

No t e  I f  t h e  s cann er ’ s  LCD ( t ou ch  s c r een )  do e s  no t  au t oma t i ca l l y  appea r ,  u se  
R es e t  t o  r eboo t .  

 You  can  in se r t  a  pap e r c l i p  i n  t h e  r i gh t  p inho l e  ( t h a t  i s  l abe l ed  Re se t )  t o  
r eboo t  t h e  ba s e  comput e r .  

 
WARNING  

 

Do not use the left-base, power-supply pinhole under the LCD (touch screen).  Pressing 
this will adversely affect the system. 

No t e  The  sy s t em w i l l  no t  boo t  up  f u l l y  un t i l  t h e  sy s t em r ea che s  10% cha rg e .  
Th i s  c an  t ak e  up  t o  2  hour s .   Fu l l  cha rg e  can  t ak e  up  t o  8  hour s .  

 If the system does not resume normal operation as the batteries recharge, there is likely a fault in 
the battery system; contact NeuroLogica for service. 

Workstation 

Acquisition (on the workstation) shows an indication of battery capacity, which is identical to the above-
referenced LCD (touch screen).  Placing the mouse pointer over the battery icon will show the capacity of 
the battery, ranging from 0 to 100%.  The main screen also displays an icon for when the scanner is 
plugged in and charging.  This screen is only active if the workstation is connected to an operational 
scanner.  The user should always check the touch screen to verify the status of the batteries. 
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Figure 7: Workstation battery capacity icon 

No te  The  sy s t em s c r e en  p rov ide s  a  way  t o  v e r i f y  t h a t  t h e  s canner  i s  p l ugged  in  and  
cha rg ing .   I f  t h e  t ouch  s c r e en  i s  b l a ck ,  t h e  sy s t em i s  no t  ch a rg ing  and/o r  t h e  
ba t t e r i e s  a r e  pe rmanen t l y  damaged .   A  s e r v i c e  c a l l  i s  r e qu i r ed .  

The battery system is designed to be replaced by authorized and trained NeuroLogica service personnel, 
only. 

 
CAUTION The workstation will not report the proper battery capacity and status if a network 

connection is not made. 

 
CAUTION The system can only be charged from a correctly rated wall outlet.  A rating information 

plate is located on the product-marking plate (lower backside panel or lower left side 
panel, see Figure 8 and Figure 9). 

 

 
Figure 8: Product-marking plate on side of scanner 

 
 

Figure 9: Product-marking plate on back of scanner 
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No t e  Sy s t ems  manu f a c tu r ed  on  o r  a f t e r  S ep t em ber  24 ,  2 016  w i l l  h ave  t h e  p rodu c t -
mark ing  p l a t e  shown in  t op  l e f t  p i c t u r e  a f f i xed  on  th e  sy s t em a s  shown in  t op  
r i gh t  p i c t u r e .   Sy s t em s  manu f a c tu r ed  be fo r e  S ep t embe r  24 ,  2 016  w i l l  h ave  t h e  
p rodu c t -mark ing  p l a t e  shown in  bo t t om l e f t  p i c t u r e  a f f i xe d  on  th e  sy s t em a s  
shown in  bo t t om r i gh t  p i c t u r e .  

 
CAUTION The system (including the workstation) should be plugged in at all times when not in 

Transport mode, being transported or in scanning use, to help maintain battery life and 
proper system operation.  Failure to do so could result in permanent battery damage, 
which will require a service technician to repair. 

  
CAUTION The system may not complete a scan when below 25% battery capacity while unplugged. 

 
CAUTION If the system is unplugged and battery capacity reports to be 0%, permanent battery 

damage can occur. 

 
CAUTION The system can be charged only from a correctly rated wall outlet. 

 
CAUTION The power cord selection must not be less than 220v/16A, made of 2.08mm (diameter) 

copper wire in accordance with local power supply cable standards. 

No te  Med i ca l  g r ad e  power  co rd s  sh ou ld  be  u sed  a t  a l l  t imes .  

Maintenance and service 

 
WARNING Equipment maintenance of non-medical electrical equipment should not be performed in 

the patient environment. 

 
WARNING Maintenance checks and all service must be performed by NeuroLogica trained 

technicians.  Service personnel use Service manual (1-NL3000-062) to effectively perform 
needed service and preventive maintenance and inspection on the system.  See “Contact 
information” for NeuroLogica’s contact information. 

 
WARNING The only calibration performed by the user on this system is called daily calibration and is 

described in detail later in this user manual.  All other calibration needs that arise must be 
performed by trained technicians at NeuroLogica Corp.  See “Contact information” for 
NeuroLogica’s contact information. 

 
CAUTION Service personnel must complete training at NeuroLogica Corp. for the system and its 

accessories prior to conducting any service activities. 

Users are not to perform service or maintenance on the system at any time.  This includes 
battery maintenance. 

No te   NeuroLog i ca  r e commends  t h a t  a  s i x -month  pr ev en t i v e  ma in t enance  be  
condu c t ed  by  NeuroLog i ca ’ s  s e r v i c e  pe r s onne l / t r a ined  f a c i l i t y  b i o - eng ine e r .  
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 NeuroLog i ca  r e commends  a  s em i - annua l  s e r v i c e  con t r a c t .  

 In s t ru c t i ons  f o r  r e p l a c ing  se r v i c ea b l e  pa r t s  a r e  i d en t i f i ed  i n  t h e  S e rv i c e  
Manua l  (1 -NL3000 - 062 )  

Cleaning the system 

Keep the equipment clean.  Remove body fluids to prevent a health risk and damage to internal parts. 

No t e  NeuroLog i ca  r e commends  a  s o l u t i on  o f  ≥99% pure  I sopr opy l  A l coho l  ( I PA)  
t o  su f f i c i en t l y  c l e an  t h e  equ ipment .  

When the system is between uses, NeuroLogica recommends keeping it clean as described below.   

 
WARNING Do not use flammable or potentially explosive disinfecting sprays, since resultant vapor 

could ignite, causing personal injury and/or damage to the equipment. 

 
WARNING In order to prevent short-circuiting or possible electrical shock, do not spray cleaning 

agents or spill liquid cleaning agents directly onto the machine. 

 
WARNING Always electrically isolate this equipment from the main electrical supply before cleaning 

and disinfecting it to prevent short-circuiting or possible electrical shock. 

 
CAUTION The unit surfaces may be cleaned with a soft cloth and the recommended solution or a 

similar mild non-abrasive cleaning solution.  General purpose liquid disinfectant may also 
be used as necessary.  Apply the cleaning solution to the cloth, not directly to the unit. 

 
CAUTION To help maintain good working conditions for the system, be sure to keep dust and like 

debris from collecting in the area.  This will keep the cooling fans and filters used 
throughout the system free of clogging and promote optimum use of the system. 

Cybersecurity 

 
WARNING Upon detection of a cybersecurity threat to the system or workstation, do the following: 

• Immediately contact Technical Support. 

• Discontinue use of system (enabling the EMERGENCY-STOP if needed). 

• Remove any ethernet and/or wireless connection that has been made with the facilities’ 
IT-network. 

Continued use of the system can occur after Technical Support has assessed the siutation 
and provided the go-ahead to do so. 

No t e  NeuroLog i ca  Corp .  r e c ommends  t h e  cu s t omer  f a c i l i t y  u t i l i z e  an  IT-ne twork  
t h a t  p rov ide s  su f f i c i e n t  means  o f  cybe r s e cu r i t y  con t ro l  t o  h e l p  ma in t a in  t h e  
r equ i r emen t s  o f  HIPAA .  
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Contraindication(s) 

There are no contraindications associated with CT x-ray scanning. 

Personnel privileges and terminology 

Qualified operator 

The operator (for example, technologist, radiologist, and so on) as determined by the healthcare facility 
and assigned by a user with administrative privileges – who by their education, certification, experience 
and training, are sufficiently qualified to competently perform clinical scans on the particular model of 
CT system which they are to use.  See “Understanding the types of users” on page 91 for a description of 
the types of users. 

Operator of record 

The operator of record is an operator or health care professional currently logged onto the CT system 
with a unique username and password identifier. 

Scanning privileges 

Scanning privileges are granted to a qualified operator, assigned by a user with administrative privileges, 
to conduct clinical scans on the particular model CT system which they are to use.  This privilege level 
allows use of all clinical protocols to properly scan the patient. 

Protocol privileges 

Protocol privileges are granted to a qualified healthcare professional (for example,  radiologist, 
technologist, physicist), as determined by the healthcare facility and assigned to users with administrative 
privileges, who by their education, certification, experience and training, is sufficiently qualified to 
competently save clinical protocols (either new or modified) on the particular model CT system they 
working on.  A healthcare professional with protocol privileges does not necessarily have to have 
scanning privileges on the particular CT system. 
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Administrative privileges 

Administrative privileges are granted to qualified healthcare professionals (for example,  radiologist, 
technologist, physicist, department administrator, etc.) as determined by the healthcare facility who by 
their education, certification, experience and training, is sufficiently qualified to competently assign, 
maintain, and oversee the assignments of personnel to scanning privileges and/or protocol privileges on 
the particular CT system which they administer.  In addition, qualified healthcare professionals are 
authorized and qualified to pull system logs associated with this standard for quality assurance review.  
Healthcare professionals with administrative privileges do not necessarily have to have scanning privileges 
or protocol privileges on the particular CT system. 

Clinical operation 

CT system operation that involves scanning live humans and/or creating or editing protocols intended for 
use on live humans. 

Clinical scanning 

CT system operation that involves scanning of live humans. 

Clinical protocol 

A protocol on the system intended for use on live humans. 
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Chapter 2     System Overview 
To understand general aspects of the system, this chapter gives a brief, initial overview of the parts of the 
system.  For example, it provides basic skills for powering on and off the scanner, familiarizing yourself 
with the LCD (touch screen) when the scanner is on, as well, how to locate and use E-STOP and the 
Rocker-Switch-Lift UP and DOWN buttons that let you initiate mobility of the scanner. 

After you are familiar with basic parts of the system, you can learn how to use the scanner, the 
workstation, and the Scanner Drive System (SDS) – if the SDS was purchased – in subsequent chapters. 

No te  Whethe r  you  t u rn  on  th e  s canner  o r  t h e  work s t a t i on  f i r s t  ( s e e  Chap te r  4 )  
doe s  no t  ma t t e r ;  howeve r ,  i t  i s  adv i s e d  t o  power  up  t h e  NL3000  CereTom E l i t e  
sy s t em ha rdwa re  ( f i r s t ) ,  t o  a l l ow  t ime  f o r  t h e  s cann er  (h a r dware )  t o  wa rm up .  

The NL3000 CereTom Elite CT system lets you scan patients in a room or ward, an Intensive Care Unit 
(ICU), an Emergency Room (ER), a medical satellite facility, an Operating Room (OR), and a private 
office or clinic. 

NL3000 CereTom Elite system 

The NL300 CereTom Elite is an 8-slice, portable, battery-operated CT scanner and software system with 
Axial, Helical, and Dynamic, capabilities.  It has eight rows of 1.25mm detectors in the Z axis; with each 
rotation, the scanner covers 10mm of anatomy.  Total coverage is 640mm. 

The CereTom Elite core system consists of the scanner, scan board, bed adapter, QA phantom, interface 
cables, lead (shielding) curtains, and the CereTom Elite workstation.  Consider the following: 

• The scanner and workstation communicate using a wireless connection.  They also communicate 
using an ethernet connection, if necessary. 

• The CereTom Elite workstation is a computer with custom software that allows the user to 
employ pre-defined system protocols or devise unique protocols for performing that user’s patient 
studies.  It also allows the user to update patient information and store images.  The viewing 
portion of the CereTom Elite workstation allows the user to view images in more detail and 
includes tools to help facilitate diagnosis by a physician. 

• The scanner uses a minimum, slice-thickness: 1.25mm and a maximum coverage: 640mm.  The 
maximum scout length is 640mm. 

• Scan boards are a headboard that supports the patient’s head and neck while the patient 
undergoes a scan or study. 
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Figure 10: CereTom Elite system configuration 

The LCD touch screen 

The Liquid Crystal Display (LCD) screen is a touch screen that is located to the side of the scanner.  The 
touch screen displays patient information, machine-positioning buttons (for a scan), and scanner-status 
information. 

The touch screen contains two tabs that show different information, actions, options, and buttons to 
activate: the Main and Options tabs.  The Main tab and the Options tab are blue when active.  An 
inactive tab appears gray.  To make a tab active, and to see what actions you can perform from the tab’s 
panel, press the tab. 

  
Figure 11: Main and Options tabs on the touch screen 

The Main and Options tabs are described later in this user manual.  See “Overview of the scanner’s LCD 
touch screen” on page 72. 

The shielding curtains 

The shielding curtains diminish radiation to those around the patient. 
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To learn more about the US and European findings regarding the scatter radiation measurements with 
opened or no curtains and with closed curtains, see “Scatter radiation” on page 212.  To learn how to use 
the shielding curtains, see “Using the curtains for shielding” on page 87. 

      
Figure 12: Shielding curtains: opened and closed 

The workstation 

The workstation is an accompanying part of each scanner; it is the control unit that operates all 
respective functions of the system.  All basic information related to the workstation (for example, 
operating distance, warnings and cautions, connectivity, functionality, and so on) appears in Chapter 4    
. 

Laptop 

 
Figure 13: CereTom Elite workstation 

The workstation is a special laptop, set up either wirelessly or hardwired to the scanner.  The hardwire 
setup uses an ethernet cable to connect the workstation to the scanner. 

The administrator makes sure wireless is enabled when creating a wireless connection between the 
workstation and the scanner (with System Configuration > Scanner Setup, using the workstation).  See 
“Assigning the remote support setup” on page 119. 
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No te  Wi re l e s s  c onne c t i on s  can  be  s l ower  t h an  a  h a rdw i r ed  ( e th e rne t )  s e t up .   I f  an  
unexpe c t ed  de l ay  o r  d i s c onne c t i on  (du e  t o  env i r onment a l / bandwid th  
in t e r f e r enc e )  o ccu r s  when  u s i ng  w i r e l e s s ,  i t  i s  r e commended  t o  h a rdw i r e  an  
e th e rne t  c a b l e  t o  t h e  s c anner  f o r  con t inu ed  communi c a t i on .  

 
CAUTION Do not connect or use equipment beyond what is specified by NeuroLogica Corp.; this 

practice may lead to a reduced level of system safety. 

The recommended distances, provided in Figure 14, relate only to distances specified by IEC 60601-1 and 
do not relate to specific distances required for ionizing radiation and/or stray radiation protection for 
operators and bystanders. 

 
Figure 14: Workstation safe distance location (two views) 

Keyboard and mouse 

The workstation comes with a keyboard and a mouse (1 for left-mouse button; 2 right-mouse button). 

        
Figure 15: Workstation keyboard and mouse 

Scanner Drive System 

The NEU-CT-Gen III Scanner Drive System (SDS) is a self-contained, rechargeable, battery-powered, 
transportation system that is designed to transport the CereTom Elite x-ray CT scanner. 
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Figure 16: Scanner Drive System 

SDS Overview 

The NEU-CT-Gen III SDS, through mechanical, pneumatic, and electrical components, gives the scanner 
mobility, when attached to the scanner (in the docking position to an on-site location). 

You will learn later in this user manual how to dock the SDS into the scanner for mobility. 

The joystick, identified earlier in this user manual, is attached to a programmable module that operates 
the two independent drive motors, which lets you control and drive the SDS. 

 
CAUTION  

 

Failure to heed CAUTION warnings may cause injury to the user (administrator, or 
limited or restricted operator), to others, or damage to the equipment. 

SDS considerations before use and when stored 

Before using the SDS, consider the following: 

• If a problem is detected with the SDS, make sure repairs or adjustments have been made to the 
SDS before using it. 

• Make sure the SDS operates easily and freely and all parts work smoothly. 
• Check for excess noise, vibration, or a change in ease-of-use.  Noise, vibration, or change in ease-

of-use can be signs of a problem and a need for servicing. 
• During scanner storage or non-use: undock the drive system before storing the CereTom Elite 

scanner to prevent damage to the drive wheels; failure to detach the drive unit from the scanner 
during extended storage time will result in flat spots on the wheels where they contact the floor. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 70 of 374 The silhouette scan board and universal transfer board 

• Store the scanner in a dry, well-ventilated, climate-controlled area.  When not in use, plug the 
scanner into a 120V (or other compatible) outlet to charge the batteries.  Make sure the scanner 
is locked (see "Locking and unlocking the scanner” on page 76).  Store the SDS in Transport 
mode. 

• Docking height: the docking mechanism does not automatically adjust to match the scanner and 
must match the scanner docking-adapter height; the height is set during installation by 
NeuroLogica; the mechanism should engage without forcing. 

See “Chapter 14    Scanner Drive System” on page 337 for more specific information. 

 
Figure 17: SDS control panel 

The joystick 

The joystick, is attached to a programmable module on the scanner that operates the two independent 
drive motors, which lets you control and drive the Scanner Drive System (SDS).  See “Joystick features” 
on page 339 for information on REM421 and REM35 joystick models. 

  
Figure 18: SDS joystick 

The silhouette scan board and universal transfer 
board 

A scan board is supplied with the system.  The silhouette scan board is always used with an adapter; the 
universal transfer board is always used with mattress stiffeners. 
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Figure 19: Silhouette scan board and universal transfer board 

Parts that potentially come into contact with the 
patient 

While you (the operator) use the system, be mindful that the patient may come into contact with the 
following parts: 

• The CereTom Elite system, especially the painted, external surfaces of the system’s scanner covers 
• Neonate scan platform 
• Pediatric scan board 
• Silhouette scan board 
• Universal transfer board 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 72 of 374 Powering on and off the CereTom Elite system 

Chapter 3     Basic Scanner Operations 
Basic scanner skills include powering on and off the scanner, learning how to use and navigate the use of 
the touch screen, how to use E-STOP, and how to use the Rocker-Switch-Lift UP (green) and DOWN 
(red) buttons to lift and lower the scanner. 

Scanning basics you should know before you scan a patient include how your system should be setup, 
how to position the scanner and the patient before the scan, and how to perform a scan from the touch 
screen. 

No te   CT Ang iog ra phy ,  CT Per fu s i on ,  and  o th e r  o p t i ona l  pa ckage s  may  o r  may  no t  
be  a c t i v a t ed  depend i ng  on  th e  sy s t em .  

Powering on and off the CereTom Elite system 

The CereTom Elite is not intended to turn on and off; however, if the system should lose power, it is 
advised to power on the CereTom Elite scanner (first), to allow time for the scanner (hardware) to power 
up. 

Consider the following: 

• Make sure the scanner is properly plugged in, whenever possible; be sure the outlet(s) provides 
the required power. 

Plugging in the electrical cord into the wall powers on the system and charges the batteries; the 
batteries are the power source for what makes the scanner operational. 

• When plugging in the scanner, make sure the cable lays flat on the floor to ensure the safety of 
hospital personnel.  In addition, make sure that the floor behind the scanner is free of any 
obstructions or debris that could interfere with the centipedes during scanning. 

Overview of the scanner’s LCD touch screen 

The LCD touch screen appears on the side of the scanner.  The touch screen lets you (the operator) set 
up and activate a scan; however, there are functions that are not available when scanning from the touch 
screen.  After the patient is registered (using the workstation to register the patient), you can select a 
protocol from the touch screen and scan a patient.  In an emergency situation, you can register a patient 
directly from the touch screen.  See “Registering an emergency patient from the touch screen” on page 
229. 

Keep the following in mind before performing a scan, using the touch screen. 

• Scouts cannot be performed from the touch screen. 
• Scouts, protocols with bolus tracking, or AEC protocols cannot be uploaded to the scanner. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 3    Basic Scanner Operations  Page 73 of 374 

• Protocols must be uploaded to the scanner to scan from the touch screen. 
• Scanning from the touch screen is not possible if Dose Check is enabled.  See “Setting Dose 

Check” on page 136. 
• To determine where personnel should stand during a scan, consult with the hospital physicist. 

No t e  NeuroLog i ca  r e commends  t h a t  an  a i r  c a l i b r a t i on  i s  pe r f o rmed  eve ry  6 - 8  hour s .   
I f  t h e  a i r  f r e shne s s  f a l l s  b e l ow  50%,  o r  t h e  s canne r  i s  mov ed  t o  an  a r ea  w i th  a  
d r ama t i c  change  in  humid i t y  o r  t empera tu r e ,  pe r f o rm ano t he r  a i r  c a l i b r a t i on  
t o  en su r e  op t imum image  qua l i t y  du r ing  pa t i en t  s cann ing .   S ee  “Pe r fo rming a  
da i l y  ( a i r )  c a l ib ra t ion  f rom the  LCD touch  s c reen”  on  p age  190  t o  l e a rn  
more .  

 I f  r oom- t empera tu r e  f l u c tua t i ons  h ave  o ccu r r ed ,  you  may  n eed  t o  pe r f o rm 
more  t h an  one  a i r  c a l i b r a t i on s .   In  add i t i on ,  s canner s  c an  d r i f t  ou t  o f  
a l i gnment ;  make  su r e  you  pe r f o rm a  Qua l i t y  Te s t  w i th  t h e  t e s t  phan tom be fo r e  
s cann ing  a  pa t i en t .  

The Main and Options tabs 

The touch screen (LCD) contains two tabs: Main and Options.  To make a tab active, press the tab with 
your finger.  Each tab contains buttons, icons, text boxes, and status indicators to perform actions.  There 
are some items that remain on both tabs: Current Pos/Settings, Battery and Tube capacity status, Patient 
information, Lift status, and Daily Cal status. 

Active and inactive buttons 

In general, buttons that appear on the Main and Options tabs are active when blue.  Inactive buttons are 
gray (or dim). 

 
Figure 20: Button status 

Main tab 

The Main tab contains various buttons, symbols, and information to perform actions; see the figure and 
table below for a brief overview. 
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Figure 21: Main tab 

Table 15: Main tab buttons and actions 

Bu t t on  Desc r i p t i on  Ac t i on  

 Laser On and Laser Off 
Turns on and off the laser. 

The scanner must be in Scan status before the 
Laser On and Laser Off buttons are active. 

 Select Cal 

Performs a daily calibration and QA.  Daily 
calibration is required before beginning a scan if 
the system has not been used within a 12 hour 
period.  Be sure to close the lead (shielding) 
curtains (if fitted) before starting the daily 
calibration. 

A QA is performed to verify the system’s state 
and to perform image-quality verification. 

See “Performing a daily (air) calibration from 
the LCD touch screen” on page 190. 

See “Starting Quality Assurance from the touch 
screen” on page 193; "Starting Quality 
Assurance from the workstation” on page 196; 
and “Scanning from the touch screen” on page 
245. 

 Directional arrows 

Controls the movement of the scanner (in mm) 
in either direction and lets you determine how 
far the scanner will move (with the directional 
buttons). 

See “Moving the scanner for manual transport” 
on page 81. 

 
Zero Ref 

 
Sets the scanner to zero before starting a scout 
or scan. 
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Bu t t on  Desc r i p t i on  Ac t i on  

 Stop Stops the current movement. 

 Prepare Starts a protocol. 

Options tab 

The Options tab contains various buttons, icons, and information; see the figure and table below for a 
brief overview. 

   
Figure 22: Options available when Dose Check is enabled and not enabled 

Table 16: Options tab buttons and actions 

Bu t t on  Desc r i p t i on  Ac t i on  

 
Scan Delay Adjusts the scan (start) countdown. 

 Transfer Transfers a previous scan’s images from the Recon 
computer to the workstation or the USB. 

 Emergency Patient 
Registers an emergency patient to allow scanning if 
there is no patient registered from the workstation. 

Dose Check cannot be enabled to see this button. 

 Finalize 
Completes the current patient and clears current 
patient information from the scanner. 

Dose Check cannot be enabled to see this button. 

 
Training Mode On and 
Off 

Toggles between having the scanner in or out of 
Training mode, which lets you use the scanner 
without activating the x-ray. 

See “Using Training mode to simulate a scan for 
training purposes”, on page 251. 
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Dialog and toggle buttons 

Dialog buttons (see Figure 22) that include an ellipsis (three dots (…)) indicate that a popup appears after 
the button is pressed.  For example, press the Scan Delay… button (Options tab); it displays several scan-
delay times to select. 

 
Figure 23: Select Scan Delay times popup 

Toggle buttons are buttons that, when pressed, act one way and then when pressed again, have the 
opposite or different action. 

The five icons that remain constant on the Main and Options tabs 

There are five icons that appear on both the Main and Options tabs in the same location: at the top-right 
corner of the touch screen. 

Table 17: Constant icons on Main and Options tabs on touch screen 

I con  Desc r i p t i on  

 Lock mode 

 Machine-system state 

 Plugged-in status 

 USB-connected status 

 
Workstation-connection status 

The inactive and active modes are pictured in Figure 24, below; inactive items are gray and active items 
are in color. 

 
Figure 24: Touch screen’s inactive icons (left) and active icons (right) 

Locking and unlocking the scanner 

You can lock the touch screen if the scanner will be unattended.  Locking the touch screen removes any 
patient data from view. 
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The last scan with the relevant patient’s information shows in the Patient Information boxes. 

 
Figure 25: Patient information 

 Press the Lock or Unlock button (Main tab). 

The numeric keypad popup appears. 

 
Figure 26: Numeric keypad popup 

 Enter the three digit code: 911. 

The padlock represents whether the scanner is in unlocked mode (dim) or locked mode (color). 

 
Figure 27: Unlocked and locked padlock 

Identifying the scanner’s mode 

This orb changes color depending on the state the system is in.  See Table 19 to learn more about all the 
system states that exist and the color of the orb associated with each system state.  This gives you a quick 
way to identify what the system may be doing. 
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Figure 28: Scanner’s mode in Idle mode 

Identifying if the system is plugged in or not 

If the system is plugged in, the following shows: 

 
Figure 29: System plugged in (left) or not plugged in (right) 

Check that the system plug is properly inserted in a wall socket. 

Identifying if the system is using a USB connection 

If there is a USB connection, the following shows: 

 
Figure 30: System USB connected or not connected 

Check that the USB is properly inserted in the USB port. 

Identifying if the workstation is connected to the scanner  

If the workstation is connected to the scanner, the following shows: 

 
Figure 31: Workstation connected or not connected 

Check that the workstation is properly connected (wirelessly or by an ethernet cable). 
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The administrator makes sure wireless is enabled when creating a wireless connection between the 
workstation and the scanner (with System Configuration > Scanner Set Up, through the workstation).  
See “Assigning the remote support setup” on page 119. 

Note  Wi re l e s s  c onne c t i on s  can  add  l ag  t ime  a s  compar ed  w i th  a  h a rdw i r ed  
(e th e rn e t )  s e t up .   I f  an  unexpec t ed  de l ay  o r  d i s connec t i on  (due  t o  
env i ronment a l /bandwid th  in t e r f e r en ce )  o c cu r s  when  u s ing  w i r e l e s s ,  i t  i s  
r e commended  t o  h a rdw i r e  an  e th e rne t  c a b l e  t o  t h e  s c anner  f o r  con t inu ed  
communi ca t i on .  

Current Pos/Settings 

The Current Pos/ Settings (Pos means Positional) option is shown in the figure below; which includes 
the scanner’s position and the scan delay (the countdown (in seconds) before a scan begins). 

 
Figure 32: Current Pos/Settings 

Capacity battery status 

The Battery icon indicates the amount of battery-capacity (by percentage) remaining for a scan.  See 
“Battery safety and information” on page 58.  Below the Battery icon is the Charging icon, which lights 
up when the battery is charging. 
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Figure 33: Battery capacity percentage and Charging icon 

Capacity tube status 

The Tube icon indicates the amount of tube-capacity (by percentage) remaining. 

 
Figure 34: Tube capacity and percentage 

Patient information 

The patient information that appears on the touch screen is there to help you double-check that the 
correct patient information will appear on the scan you perform.  To learn more about how to enter 
patient information, see “Registering the patient” on page 223. 
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Figure 35: Patient information 

Lift status and Daily Cal status 

The Lift status indicates if the scanner is in either Transport, Invalid, or Scan mode.  The Daily Cal status 
gives the status or freshness of the daily (air) calibration: New, Fresh, or Old.  See “Moving the scanner” 
on page 81 for more information on Lift status.  See “Performing a daily (air) calibration from the LCD 
touch screen” on page 190. 

 
Figure 36: Lift and Daily Cal status 

Moving the scanner for manual transport 

The Rocker-Switch-Lift UP (green) and DOWN (red) buttons are located on the side of the scanner, near 
the touch screen.  These UP and DOWN buttons prepare the scanner to move up for transporting or 
down for positioning the scanner for scanning a patient. 
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 Press and hold the Rocker-Switch-Lift UP button to raise the scanner for transport. 

Notice the touch screen: the Lift Status changes from Scan, up through Invalid, and then to 
Transport mode.  When the Lift Status is in Transport, you can move the scanner, manually. 

   
Figure 37: Lift Status: Scan, Invalid, and Transport modes 

 Manually position the CT scanner, using the double-curved handles on the sides of the device, so 
the back of the scanner’s largest opening rests at least 1 foot (30cm) from a wall. 

The device will move away from the patient as it performs the scan. 

 
Figure 38: CereTom Elite scanner 

Positioning the scanner before a scan 

 Press and hold the Rocker-Switch-Lift DOWN (red) button until it lowers the scanner and reaches 
Scan status. 

 
Figure 39: Rocker-Switch-Lift Up and Down buttons 
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Notice on the touch screen: the Lift Status changes from Transport, down through Invalid and then 
to Scan.  Wait for the Lift Status to be in the Scan status before you begin a scan. 

The buttons are activated. 

 
Figure 40: Active Left and Right buttons, and Set (mm) button 

 To change the distance the scanner will move, perform the following: 

• Press  (Set (mm)). 

A numeric keypad popup appears. 

• Enter the value to indicate how far to move the scanner forward or backward (in mm). 

• Press the  (Enter button) to set the movement distance. 

 Do one of the following: 

• Press  to electronically move the scanner forward the distance indicated (step 2). 

• Press  to electronically move the scanner backward the distance indicated (step 2). 

 Press the  (Stop) button to stop the scanner’s movement. 
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Positioning the scanner using the laser light 

The scanner provides a rotating laser light to guide you to properly position the patient.  The laser 
indicates the center of the scan plane.  The laser light is centered on the actual x-ray beam at all times.  
For multi-slice protocols, this means that the laser light will indicate the middle position of all 
simultaneous tomograms being acquired.  There is no offset between the laser light plane and the actual 
scan plane.  The accuracy of the position of the laser plane, with respect to the scan plane, is +/- 2mm. 

To activate the laser l ight on the touch screen 

 Press  (Laser On button) on touch screen as indicated, in Figure 41. 

 
Figure 41: Phantom with laser light 

The laser will automatically shut off, 30 seconds after pressing the Laser On button to activate the 
laser.  Alternatively, you can terminate the laser by clicking the Laser Off button. 

See the precautions regarding the laser in “Laser safety” on page 52. 

 If the patient is conscious, request the patient remain still with eyes closed throughout the entire 
scan. 

 If the patient is unconscious, secure the patient. 

 Follow the appropriate facility guidelines when scanning unconscious patients if the patient’s eyes 
remain open. 

No t e  I f  t h e  pa t i en t  be come s  nau sea t ed  o r  i s  unab l e  t o  b e  s t i l l  (m o t i on l e s s ) ,  s t op  t h e  
s canner  immed i a t e l y  u s ing  t h e  E - STOP bu t t on  l o ca t ed  und er  t h e  t ouch  sc r een ,  
and  r e l e a se  t h e  pa t i en t  f rom the  h ead  suppor t .  
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Positioning the patient 

 
WARNING Prior to scanning, properly position the patient to ensure that extremities, hair, life support 

equipment, and so on  have sufficient clearance to prevent patient injury with the scanner 
itself and/or when used with accessories/options. 

 
WARNING Ensure the patient support is properly positioned (height and alignment) to prevent injury 

during scanning. 

 
WARNING Make sure the foot pedal brake on the patient support/bed is engaged to prevent it from 

moving during the scan. 

 
WARNING Never raise or lower (using the Rocker-Switch-Lift (UP and DOWN) buttons located near 

the touch screen) on the scanner when a patient is positioned into the system’s bore.  
Always slide the patient support away (by disengaging its brake) from the system before 
raising or lowering the system itself. 

 
CAUTION The following-instructions for patient positioning should be performed in accordance with 

NeuroLogica Corp.’s clinical training. 

No t e   To  de t e rm ine  where  pe r sonne l  shou ld  s t and  dur i ng  a  s can ,  consu l t  w i t h  t h e  
ho sp i t a l  phy s i c i s t .   NeuroLog i ca  r e commend s  a  d i s t an ce  o f  8 - 10  f e e t .  

 Attach bed adapter to the bed. 

 
Figure 42: Bed adapter without posts insertion 

 Attach the silhouette scan board to the bed adapter. 
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Figure 43: Bed adapter with T-square 

 When attaching the scan board with the bed adapter to the patient’s bed, insert the scan board into 
the adapter block. 

 
Figure 44: Attaching the scan board with bed adapter to patient’s bed 

 Position the patient until the patient’s head rests on the pad of the scan board as shown below. 

 
Figure 45: Positioning the patient on the bed 

 Position the patient in front of the scanner opening.  The patient’s shoulders should rest flat against 
the face of the device. 
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Figure 46: Positioning the scanner over the patient 

 Make sure the patient is centered in the scanner bore. 

 
Figure 47: Ensuring placement of patient’s neck directly under rotating laser light 

 Lock the gurney or bed wheels before proceeding with scan. 

Using the curtains for shielding 

Using shielding curtains is recommended when performing equipment calibrations and patient scans, to 
ensure maximum efficiency and patient safety. 

 Unroll the back curtain ensuring that the curtains lie flat against the back of the scanner. 
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Figure 48: Shielding curtains open and then laying flat 

 Check to ensure that the patient is properly positioned and comfortable. 

 Position the front curtains, using the adjustment knobs, as close to the patient as possible to 
minimize the space between them. 

Not e  Fo r  ca l i b r a t i ons ,  t h e  cu r t a in s  shou ld  be  compl e t e l y  c l o se d  a ga in s t  t h e  
f ron t  o f  t h e  s cann er .  

The lead (shielding) curtain minimum thickness is 0.5mm. 

 
Figure 49: Shielding curtains positioned with knobs 

 Before scanning the patient, check to ensure that nothing interferes with the patient’s life support or 
other external medical devices. 
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Operating the E-STOP button 

 
Figure 50: NL3000 CereTom Elite E-STOP location 

Using E-STOP to stop the system 

 Press the E-STOP button to perform the following: 

• Stop the system (for example, if it loses control). 

• Stop all system motion and x-ray. 

• Remove power to the gantry drives and x-ray system. 

• If the CereTom Elite starts to move unexpectedly. 

No te  When  E -STOP  i s  a c t i v a t ed ,  t h e  mov ing  g an t ry  may  ove r run  by  l e s s  t h an  10mm.  

Restoring the system with E-STOP 

If you have pressed E-STOP to stop the system, follow these steps to restore the system, using E-STOP. 

 Twist the E-STOP button clockwise until the button pops out to restore the system. 

 Make sure any hazard is removed. 

Rebooting the system 

If your scanner needs to be rebooted (for example, if it is no longer connecting with the workstation), 
unwind a paperclip and gently insert the clip into the right side (pin-hole), underneath the touch screen, 
to reboot the system.  Look for the Reset label and arrow on the side of the touch screen. 
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No t e  You  can  in se r t  a  pap e r c l i p  i n  t h e  r i gh t  p inho l e  ( t h a t  i s  l abe l ed  Re se t )  t o  
r eboo t  t h e  ba s e  comput e r .  

 
WARNING  

 

Do not use the left-base, power-supply pinhole under the touch screen.  Pressing this will 
adversely affect the system. 
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Chapter 4     Basic Workstation Operations 
Basic workstation information includes understanding the different kinds of user access, learning how to 
power on and off the workstation, and getting familiar with the workstation screen, and menus and tabs. 

No te  Whethe r  you  t u rn  on  th e  s canner  o r  t h e  work s t a t i on  f i r s t  ( s e e  Chap te r  4 )  
doe s  no t  ma t t e r ;  howeve r ,  i t  i s  adv i s e d  t o  power  up  th e  NL3000  CereTom E l i t e  
sy s t em ha rdwa re  ( f i r s t ) ,  t o  a l l ow  t ime  f o r  t h e  s cann er  (h a r dware )  t o  wa rm up .  

Understanding the types of users 

There are three types of users for the workstation: administrator, limited operator, and restricted 
operator.  Each user type has a username and password; each user is tied to a specific user type.  The 
following are the types that permit different access levels: 

• Administrator Full access permission (rights) to the system and its configuration.  Can 
create protocols, user names and passwords, and all functions of the system. 

• Limited operator Modified access permission (rights); can modify protocols during system use 
but cannot create and save protocols; has no access to system configuration. 

• Restricted operator No access to create, modify, save, or delete protocols; has no access to 
system configuration. 

Powering on and off the workstation 

 Press the Power on button on the workstation (laptop computer). 

 
Figure 51: Workstation’s Power on button (in this illustration, workstation mounted in SDS) 

No t e  Depend i ng  on  th e  work s t a t i on ,  t h e  Powe r  on /o f f  bu t t on  may  no t  be  in  
t h i s  l o ca t i on .  

The workstation will boot up and the Login popup appears. 
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Figure 52: Login popup 

Logging in to the workstation 

To gain access to the workstation application, you must provide the system with credentials.  These 
credentials consist of a user identification (ID) and password.  Make sure you have a valid user ID and 
password before you log into the system. 

If you do not have a valid user ID and password, ask your supervisor or administrator for one. 

 Enter your user ID in one of two ways: 

• Click the User ID dropdown list, and click the appropriate access level. 

 
Figure 53: User ID dropdown box 

• Select the User ID from the dropdown. 
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Figure 54: User ID dropdown list 

 Click in the Password field and enter (type) your password in the field. 

All (created) passwords must contain at least one uppercase, lowercase, numeral and symbol; the 
entire password must be a minimum of 8 to 12 characters.  Passwords are case sensitive.  Make sure 
to turn off the Caps Lock key. 

 
Figure 55: Password text box 

 Click the Login button. 

If the user ID and/or password are invalid, a prompt appears to re-enter the information. 

No te  You  have  a  l im i t ed  amount  o f  l og in  a t t empt s  be fo r e  t h e  sy s t em l o ck s  t h e  
a ccoun t .   An  admin i s t r a t o r  can  pe r f o rm un l ock ing  t h e  a ccoun t .   S ee  “Sys tem 
and  Use r  Conf i gur a t ion  and  Se tup”  on page  107  f o r  more  de t a i l s  a bou t  
un l ock ing  an  a c coun t .  

When the user ID and password are verified, you are logged into the system. 

The main screen to the workstation software appears with the Patient Registration tab open (active). 
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Figure 56: Patient Registration tab 

 Verify that the correct user name appears at top and center portion of the screen. 

 
Figure 57: User name, current date, and time 

If the correct user name does not appear, contact your supervisor or administrator user to verify the 
account. 

Locking and unlocking your workstation system 

The Lock button indicates whether your system is in lock or unlocked mode.  This button is a toggle; in 
other words, if the workstation is locked, the Unlock button shows; however, if the workstation is 
unlocked, the Lock button shows.  To protect your work you can lock your workstation or you can log 
off. 

To guard your work while you are away from the workstation computer; that is, to lock out unwanted 
users, you should lock your workstation if you intend to walk away for any period of time.  When you 
lock the workstation, it remains on, but no one can access the workstation without your username and 
password. 
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Using Lock to protect your work if you need to step away from the workstation 

 Click the Lock button located at top-and center of the workstation screen. 

 
Figure 58: System Lock button 

The Lock/Unlock System popup appears. 

 
Figure 59: Lock/Unlock System popup to lock the workstation 

 Enter the user ID and password by selecting the option from the dropdown and entering 
information in the Password field. 

 Do one of the following: 

• Click the Lock button to lock your system. 

If you (the administrator, operator, or restricted operator) select this option, the Lock button 
changes on the workstation screen. 

• Click the Cancel button to return to your work. 

Using Unlock to view your work 

   
Figure 60: Unlock button 
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Figure 61: Lock/Unlock System popup to unlocked the workstation 

 Click the Unlock button. 

 Enter the user ID and password by selecting the options from the dropdown options. 

 Do one of the following: 

• Click the Unlock button to lock your system. 

If you select this option the button changes to the Lock button. 

• Click the Cancel button to return to your work. 

Navigating around the workstation’s main screen 

The workstation screen shows similar information, regardless if the screen elements change when you 
perform different actions.  These constant screen elements are as follows: 

• Main menu options Appear in the top left corner of the screen that shows the File, Tools, 
Customize, and Help commands. 

• User, date, and time Appear in the center of the screen that displays a greeting for the 
user, the signed-in user’s name, the current date, and time. 

• Scanner and workstation 
status 

Appear in the top right corner of the screen that displays status 
information for both the scanner and workstation. 

The main screen to the workstation software always opens with the Patient Registration tab open. 

The next figure shows where to verify that the (your) correct user name appears at top and center portion 
of the screen. 
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Figure 62: User name, current date, and time 

Brief overview of the main menu 

The main menu provides you access to the basic functions from the commands: File, Tools, Customize, 
and Help. 

The main menu appears on every screen and is always located in the same location, regardless of what 
you are doing. 

 
Figure 63: Main menu 

No te  To  s e l e c t  c ommands ,  c l i ck  t h e  f i r s t  command  and  th e  sub sequen t  command s .   
Fo r  e xampl e  i f  you  see  C u s t omiz e  >  Sy s t em  tha t  means ,  c l i ck  Cus tomize  f rom 
th e  ma in  menu  and  th en  c l i ck  Sys tem .  

Brief overview of the File menu 

When you log off, restart, or shutdown the application and/or the computer (workstation), you must use 
your username and password to get back in. 

Logging off the system 

 Click File from the main menu. 
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Figure 64: File menu 

 
Figure 65: File > Log Off 

 Click Log Off from the dropdown to shut down the software (only) and not to shut down the 
workstation computer. 

The Login popup appears. 

 
Figure 66: Login popup 

This is also the login and shutdown portal.  In other words, you can login or shutdown the 
workstation from this popup. 

 Click the Shutdown button. 

The workstation application will exit the system and shut down (turn off) the workstation. 

Restarting the workstation (application) or restarting the computer 

You can restart the workstation in two ways: restarting the application only (and not turning off the 
(laptop) computer) or restarting both the application and the workstation. 

 Click File from the main menu. 
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Figure 67: File dropdown menu 

 Perform one of the following: 

• Click Restart Application from the dropdown to shut down the application, only. 
• Click Restart Computer to shut down the application and the workstation (laptop 

computer). 

The following Restart Application or Restart Computer popup appears. 

   
Figure 68: Restart Application or the Restart Computer popup 

 Perform one of the following: 

• Click the Yes button to restart the workstation (computer). 

• Click the No button to return to the screen. 

Shutting down the workstation (laptop computer) 

You can restart the workstation in two ways: restarting the application only (and not turning off the 
(laptop) computer) or restarting both the application and the workstation. 

 Click File from the main menu. 

 
Figure 69: File dropdown menu 

 Click Shutdown Computer from the dropdown. 

The Shutdown Computer popup appears. 

 Perform one of the following: 

• Click the Yes button to shutdown the workstation. 

• Click the No button to return to the screen. 
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Brief overview of the Tools menu 

This menu provides you with tools to store and print, set up protocols (for various actions), and test your 
system to ensure it is operating at optimum performance. 

 
Figure 70: Tools dropdown menu 

 Click Tools from the main menu. 

 Click one of the following from the dropdown: 
• Store/Print Queue  The Store/Print Queue screen shows the operator the status 

of the images that are selected for archive.  The screen can be 
configured (by the administrator) to automatically appear 
when selecting Archive or by using Tools > Store/Print 
Queue.  You will learn more about how to store and print 
various media and data later in this user manual; see page 
107. 

• Protocol Manager Where new protocols are created, updated, deleted, and 
uploaded to the scanner by the administrator.  You (the 
administrator) will learn more about how to use Protocol 
Manager (which gives you tools to create, update, delete and 
upload protocols) later in this user manual; see page 162. 

• Quality Assurance The tool (a wizard) that is provided with the system to ensure 
the system is performing as expected.  You will learn more 
about how to test the system to ensure the system is at its 
optimum performance; see page 190. 

Brief overview of the Customize menu 

This menu provides you with tools to set up system and define user profiles. 

 
Figure 71: Customize dropdown menu 

 Click Customize and click one of the following sub commands from the drop-down list: 

• System Lets the administrator customize site-related settings; see “Chapter 5    
System and User Configuration and Setup” on page 107. 
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No te  You  mus t  h ave  admin i s t r a t i v e  a c ce s s  p r i v i l eg e s  
t o  a cce s s  sy s t em cu s t omiza t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  
pe r f o rm th i s  p ro cedu re .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  
may  make  t h e  sy s t em inope ra t i v e .  

• User Lets the user customize layouts in the system as well as set the 
password.  See “User configuration” on page 155. 

Getting Help from the Help menu 

NeuroLogica Help includes an online user manual and information about the system.  It also provides 
remote support from NeuroLogica technical support for file transfer, remote upgrades, or system review 
and support.  When you enter a six-digit number (on the screen), technical support will take control of 
the system to retrieve files or review the issue in question. 

 
Figure 72: Help dropdown menu 

Getting an online user manual 

To open a .pdf version of this user manual perform this procedure. 

 Click Help from the main menu. 

 Click User Manual from the dropdown list. 

The version of this user manual opens (in .pdf format) for an online user manual version. 

Getting remote support 

 Click Help from the main menu. 

 Contact NeuroLogica Technical Support. 

See “Contact information” on page 26. 

 Click Remote Support from the dropdown list. 

The Support Connection window appears. 
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Figure 73: Support Connection browser window 

When connected to Remote Support, a NeuroLogica Technical Support representative will supply a 
six-digit code to start a remote support session, which allows the support representative to review 
your (the user’s) system and troubleshoot the issue. 

Getting information about the product and NeuroLogica 

To get additional information about the product and NeuroLogica, perform these steps. 

 Click Help from the main menu. 

 Click About from the dropdown list. 

The About Us popup appears. 

 

 
Figure 74: About Us popup 

The following information is found: 
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Version(s) Identifies the current software versions for the system. 

Licensed To Identifies the information about to whom the product is licensed. 

Station AE Title Identifies the title for your workstation (for PACS purposes). 

Licensed Packages Identifies Helical, Scout, Noise Reduction, CT Perfusion, and CT 
Angiography. 

Getting to know the status bar 

The status bar appears in the top-right portion of the screen.  The status bar gives you a quick view of 
what state the system is.  The following identifies the status bar: 

 
Figure 75: Scanner and workstation status bar 

 

Table 18: Status bar identification 

S t a t u s  ba r  i con  S t a t u s  ba r  i con  name  S t a tu s  de s c r i p t i on  

 
X-ray status 

Identifies x-ray as on or off. 

The icon changes from a gray/black icon (when 
x-ray is off) to an animated (rotating) 
yellow/black icon when x-ray is on. 

 
System state 

Identifies the current system’s state. 

The orb changes color depending on the state 
the system is in. 

See Table 19, for what different orb colors mean 
and what different system states they identify. 

 
System position 

Identifies the current system’s position relative 
to its zero reference; the position is displayed in 
the icon.  If you hover the mouse over the icon, 
additional, position detail appears. 

 System centipede status 

Identifies whether the scanner centipede status is 
engaged or disengaged for transport: 

Green  centipedes are engaged. 

Red  centipedes are disengaged. 

 System E-STOP status 
Identifies (by E-STOP icon brightens) when E-STOP 
is engaged.  The icon will flash when E-STOP is 
pressed. 
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S t a t u s  ba r  i con  S t a t u s  ba r  i con  name  S t a tu s  de s c r i p t i on  

 

System tube capacity 
status 

Identifies the system capacity; each color in the tube 
represents the particular capacity percentage: 

Blue  100% - 51% 

Yellow  50% - 15% 

Red  14% - 0% 

 
Workstation battery 
capacity status 

Identifies the battery capacity of the workstation; 
each color represents the particular capacity 
percentage: 

Green  100% - 21% 

Yellow  20% - 11% 

You will be prompted to plug the workstation into 
an outlet to charge if the battery capacity is low; a 
scan cannot complete with low battery levels at the 
red capacity: 

Red  10% - 0% 

When the workstation reaches the red capacity 
range, the system will shut down.  A message 
appears to inform the limited and restricted operator 
that the system will shut down due to low battery 
capacity. 

The lightning bolt (icon that appears on the battery) 
signifies that the system is currently charging and 
goes away when unplugged. 

 
System air freshness 
status 

Identifies the air freshness status; each colored bar 
represents the freshness percentage: 

Green  100% - 51% (new) 

Yellow  50% - 25% (fresh) 

Orange  24% - 0%  (old) 

After calibration it returns to 100%. 

 
System battery capacity 
status 

Identifies the system’s battery capacity; each color 
represents the capacity percentage: 

Green  100% - 51% 

Yellow  49% - 25% 

Red  24% - 0% 

The charge icon appears at the top left corner when 
the system is plugged into an outlet.  The lightning 
bolt appears when the battery is being charged. 
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S t a t u s  ba r  i con  S t a t u s  ba r  i con  name  S t a tu s  de s c r i p t i on  

 
Workstation free disk  
space status 

Identifies the available (free) disk space left; each 
color represents the free disk-space percentage: 

Green  100% - 51% free space 

Yellow  50% - 20% free space 

Red  19% - 0% free space 

 
Wireless signal indicator Identifies the wireless signal strength for the scanner 

to the workstation. 

The system performs numerous actions and while doing so, is in various states.  The following table 
indicates what state the system is in and the colored orb that correlates to that state. 

Table 19: System state orbs 

Orb  Co lo r  S t a t e  

 Dark gray 
The system is in an unknown state: not 
connected to the scanner; no communication is 
present. 

 
Light gray The system is powering up or down. 

 
Dark purple The system is busy. 

 
Purple The system is completing air calibration. 

 
Light purple The system is archiving. 

 
Blue The system is idle. 

 
Green The system is ready. 

 
Light yellow The system is planning. 

 
Dark yellow The system is preparing. 

 
Light orange The system is in reconstruction. 
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Orb  Co lo r  S t a t e  

 
Dark orange The system is scanning. 

 
Pink The system is not ready. 

 
Red The system is in fault. 

The Workstation tabs 

To perform a patient examination, you will use the following five workstation tabs: 

 
Figure 76: Workstation tabs to perform a patient examination 

These five tabs include active (blue) tabs and inactive (gray) tabs, initially.  The active tabs are Patient 
Registration, Post Reconstruction, and Patient Browser.  The Acquisition tab is inactive.  You may see 
that the Viewing tab is also dim.  Steps must be performed to activate tabs, for example, you must 
register the patient (or query and identify a patient), scan the patient, and so on before you can acquire 
or view scans (images). 

Each tab represents the following kinds of actions: 

• Patient Registration Allows you to register a patient from hospital’s database sites, for example 
HIS/RIS. 

• Acquisition  Allows you to perform the examination.  This tab is inactive until the 
patient is registered. 

• Post Reconstruction  Allows you to manipulate the raw data in different parameters and settings 
after you scanned. 

• Patient Browser Allows you to view, manipulate, and archive scans already performed. 

• Viewing Allows you to view the patient scan.  This tab is inactive until a study is 
loaded into Viewer. 

In the following chapters, you will learn how to perform necessary steps to conduct a patient examination 
and learn how to manipulate and store the data you acquire. 
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Chapter 5     System and User Configuration and 
Setup 

You (the administrator) sets up the CereTom Elite system configurations for other users (limited and 
restricted operators).  System configuration, overall, is how the CereTom Elite scanner is set up to meet 
site-specific needs.  Most windows contain self-explanatory instructions and refer to elements that are 
known to you (the administrator) with radiological education and training.  Additional, brief instructions 
are provided to you to aid in completing those sections with more detail. 

Configuration includes setting up user permissions (or access privileges) to manage users, as well as 
servers, what appears (what is available) through settings, presets, and so on for the use of the system at a 
site.  Many system configurations are permissible to the administrator, only.  While other configurations 
are permissible to operators (users) without administrator access (or administrator permission). 

No t e   You  mus t  h ave  admin i s t r a t i v e  a c ce s s  p r i v i l eg e s  and  b e  l ogged  in  a s  an  
admin i s t r a t o r  t o  s e t  con f i gu ra t i ons  f o r  t h e  s i t e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

The following table shows all the System Configuration tabs that appear when you (the administrator) 
click Customize (from the main menu), and then click System.  The table below defines these tabs briefly 
for an overall understanding of what settings are available on each tab. 

Table 20: System Configuration tabs 

Tab  nam e  Desc r i p t i on  

General Settings 
Allows the administrator to set system configurations such as hospital name, 
wireless settings, and dose report settings.  General Settings is the initial tab 
that is a constant tab. 

User Accounts Allows the administrator to create and edit user accounts and permissions. 

DICOM Servers Allows the administrator to set up DICOM servers for archiving, such as 
PACS or HIS/RIS. 

DICOM Setting Allows the administrator to view and configure DICOM tags for HIS/RIS, 
MPPS, and Patient, Study, Series, and Image modules. 

Dose 
Configuration 

Allows the administrator to set up dose notifications, dose alerts, and 
configure dose limits for specific scans. 

Windowing Presets  Allows the administrator to view and modify kernel, and window and level 
presets. 

Audit Trail Viewer Allows the administrator to view and log all changes as well as actions in the 
system, which include logins, patient registrations, and series updates. 

Image Orientation Allows the administrator to view and modify how images are oriented in the 
system. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 108 of 374 Setting user accounts 

Setting user accounts 

The administrator, only, can update another user’s account, add a new user, delete a user, and lock or 
unlock a user’s access. 

 Click Customize > System from the main menu. 

This means, click Customize from the main menu and then click System from the dropdown list. 

The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 
Figure 77: User Accounts tab 

 For the User ID field, enter the user ID name. 

 For the User Level field, enter one of the following user levels: 

• Administrator 
Full access permission (rights) to the system and its configuration.  
Can create protocols, user names and passwords, and all functions of 
the system. 

• Limited operator 
Modified access permission (rights); can modify protocols during 
system use but cannot create and save protocols; has no access to 
system configuration. 

• Restricted operator No access to creating or deleting protocols; has no access to system 
configuration. 

 For the Last Name field, enter the user’s last name. 

 For the Enter First Name field, enter the user’s first name. 

 For the Password field, enter the user’s password. 
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No te  The  pa s sword  mu s t  con t a in  8  t o  12  cha ra c t e r s ,  and  mu s t  i n c l ude  one  
number ,  one  symbo l  and  one  l e t t e r .  

 For the Verify Password field, re-enter the user’s password to confirm the password. 

 
Figure 78: User account fields filled in 

 Click the Save button. 

The user is added to the list. 

 Click the Close button to exit. 

Setting or updating the user’s information 

 Click Customize > System, from the main menu. 

The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select a user from the list of users. 
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Figure 79: List of users 

 Modify the user’s information; for example, password, or user’s first and last name. 

The password must be 8-12 characters and include at least a letter, number, and symbol. 

The user’s changes take effect after clicking the Update or Save button.  It is recommended that you 
log off and log back on and check that the password is working. 

 Click the Save button to keep the change(s). 

The Save Aborted popup appears if your password does not meet the rule for passwords that the 
password include a letter, number, and symbol.  If this is the case, return to the step above, and 
fulfill the password rule. 

 

 

 
Figure 80: Save Aborted popup message – Password requirements 

 Click the Close button to exit. 
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Unlocking the user 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user to unlock from the list of users in the panel. 

 
Figure 81: List of users not selected 

 Click the Unlock button. 

The user’s changes take effect after clicking the Update or Save button.  It is recommended that you 
log off and log back on and check that the password is working. 

Deleting the user 

Note  The  admin i s t r a t o r  u se r  c anno t  be  de l e t ed .  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user to delete from the list of users. 
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Figure 82: List of all available users 

 Click the Delete button. 

A confirmation popup appears, declaring that the action was successful. 

 Click the Ok button in the Action Succeeded popup. 

 Click the Close button to exit. 

Modifying the order of the user in the accounts list  

 Click Customize > System. 

The System Configuration dialog box appears. 

 Click the User Accounts tab. 

 Select the user order to modify from the list of users in the panel. 

 Click the Down (arrow) button to move the user down the list. 
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Figure 83: Down (arrow) button 

 Click the Up (arrow) button to move the user up the list. 

 
Figure 84: Up (arrow) button 

The Up (arrow) button will not activate until you move down the list of users from the top-of-the-
list. 

 Click the Save button to keep the new user-list order. 
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Figure 85: Save button for list order 

 Click the Save button next to the Update button to keep other changes. 

 Click the Close button to exit. 

Assigning general settings 

Perform the following to set how the hospital, application, scanner, and remote support are configured. 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the General Settings tab. 
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Figure 86: General Settings tab 

The following tabs are available to the administrator, only: 
• Hospital Setup  Sets up hospital information specific to the hospital site. 

• Application Setup Sets up the application information the user will experience, such as 
default protocols to pediatric. 

• Scanner Setup Sets up scanner information that incudes IP address specific to the 
site. 

• Remote Support Setup  Sets up information like static IP setup and servers specific to the 
site. 

 Go to the sub sections, below, in this user manual, to learn about what options exist on the General 
Settings tabs. 

Assigning the hospital setup 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Hospital Settings sub tab. 
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Figure 87: General Settings > Hospital Setup tab 

 Enter the institution name in the Institution Name field. 

No t e  The  name  appea r s  on  a l l  imag es .  

 Enter the department name in the Department Name field. 

 Enter the institution address in the Institution Address field. 

 Click the following options that are applicable: 

• Click the Auto Store option that stores the PACS list to multiple servers; make sure PACS 
server is the default server (see System Configuration >DICOM Servers > Servers, and 
Default Server option). 

If Auto Store is selected, when you finalize an exam (scan), the system will automatically 
send the images to the previously defined PACS server(s) on the DICOM Servers tab.  In the 
bottom right of the screen in Patient Browser, the status of your export appears. 

• Click the Use Device AE in Server Setting option to apply the CereTom Elite AE title tag to 
DICOM when the operator archives the image data to PACS. 

If enabled when sending images to PACS, this option will include the CereTom Elite AE 
setting as a DICOM tag. 

 Enter the system name (for example CereTom Elite) in the Station AE Title field. 

 Click the Save button to keep your changes. 

The Save Successful popup appears. 

 Click the Ok button in the Save Successful popup. 
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 Click the Close button to exit. 

Assigning the application setup 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Applications Setup sub tab. 

 
Figure 88: General Settings > Application Setup tab 

 Click and/or enter information for the following options that apply: 
• Auto Lock Sets an auto lock, after the specified number of minutes of 

idle time set; when the idle time is reached, the 
workstation screen enters a locked state;  the administrator 
sets the number of idle minutes in the Idle Time 
(minutes) text box. 

• Automatically Show Store/Print 
Queue 

After selecting a series for archive, displays the Store/Print 
Status pop-up. 

• Show Dose Report Displays the dose report on the screen when the Finalize 
button is clicked (or pressed). 

A dose report for a scan or series of scans will not be 
generated until the scan is complete and the operator 
clicks the Finalize button on the Acquisition tab. 

• Automatically Generate Dose 
SR 

Generates a Dose SR (Structured Report) along with the 
dose report when the Finalize button is clicked (or 
pressed). 
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• Show Stored Query Results Displays the Stored Results at the bottom of Patient 
Registration. 

• Prompt for Auto 
Reconstruction 

Allows the operator (user) to select whether to run the 
attached reconstructions or not after the exam is 
completed. 

• Default Pediatric Patient Type If selected, the Protocol Manager will default to the 
pediatric protocols instead of adult. 

• Automatically adjust date for 
worklist query 

Sets the query date to the current date, by default. 

• Change Password Interval 
(Days) 

Sets the number of days to pass before a password change 
is required. 

 Click the Save button to keep your changes. 

 Click the Close button to exit. 

Assigning the scanner setup 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Scanner Setup sub tab. 

 
Figure 89: General Settings > Scanner Setup tab 

 Click and/or enter information for the following options that apply: 
• Scanner IP address Sets the scanner’s IP address in the field(s). 
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• Point to Point Wireless Sets up wireless information regarding the connection from 
the workstation to the scanner. 

 • For Scanner Network Adapter, enter the adaptor, for 
example, Wireless to Scanner. 

 • For Scanner Wireles Profile, enter the wireless identifier 
in the field. 

 
Figure 90: General Settings > Scanner Wireless Profile dropdown 

 Click the Save button to keep your changes. 

 Click the Close button to exit. 

Assigning the remote support setup 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Remote Support Setup sub tab. 

 
Figure 91: General Settings > Remote Support Setup tab 
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 Click the Remote Support Network Connection dropdown to select one of the following network 
connections: 
• Wireless to Scanner  
• Wired to Network  

 Enter the Static IP Setup data for the following: 
• System IP Address  
• System Subnet  
• System Gateway  
• Use Static IP  
• Static IP Setup  
• DHCP Setup  

 Enter the DHCP Setup to enter IPs for the following: 
• DNS Server (Preferred)  
• DNS Server (Alternate)  

 Click the Save button to keep your changes. 

 Click the Close button to exit. 

Managing DICOM servers 

Digital Imaging Communication in Medicine (DICOM) is the definition of the acronym DICOM.  
DICOM servers are used, in this case, to let you (the administrator) exchange (import and export) data.  
The System Configuration tab information lets the administrator access all connected server data created 
in the system. 

See DICOM standards on the NEMA.org website for a full description of settings (and actions) that are 
available. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

DICOM servers are set up by the field service engineer and the appropriate IT person at the hospital  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 
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 Click the General Settings tab. 

 Click the DICOM Servers tab. 

 
Figure 92: DICOM Servers tab 

The three following tabs appear: 

• Servers 
Lists existing servers based on type: Store or Worklist.  Also displays server 
details and options, with controls for saving, updating, deleting, and 
echoing servers. 

 
• Store   Identifies a storage server. 
• Worklist   Identifies servers in a database you can query from. 

• PACS List Displays a list of PACS by server name, type, and In List – to send to by 
default (for archiving purposes). 

• Options Displays controls for PACS Options and HIS/RIS Options. 
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Figure 93: DICOM Servers tabs 

 Go to the following sections to assign specific actions to the DICOM server. 

Assigning a server as a store or worklist server 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

The Servers tab is active. 

 
Figure 94: DICOM Servers > Servers tabs 

 Click one of the following options: 

• Store 
A storage server, typically a PACS server that archives images and patient 
information for storage purposes.  It is partly a backup and partly a waypoint 
for transferring data from the system the scans were acquired on to another 
system for viewing. 

• Worklist 

A database of patient information that is able to be queried to generate a list of 
patients based on name, modality, procedure date, and other variables.  These 
patients are usually hosted on a server within the facility and the information 
can be pulled from the server when trying to acquire all of a patient’s 
information before a procedure is run.  This eliminates the need to manually 
enter patient information at the time of the procedure. 

 Under Details, enter the server name in the Server Name text box. 

 For the HIS/RIS and PACS Network Connection, click the dropdown to identify the following: 
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• Wireless to Scanner  
• Wired to Network  

 Click the Point to Point Wireless check box, if it applies. 

 Click the Wireless Profile dropdown to select the appropriate profile. 

 In the Server AE Title text box, enter the server AE title. 

 In the Device AE Title text box, enter the CereTom Elite AE title. 

 In the Server IP Address text boxes, enter the server IP address. 

 In the Port text box, enter the port identifier. 

 In the Connection Timeout (secs) text box, enter the number of seconds before the connection 
timeout is activated. 

 Click the Use Static IP option to identify the following: 
• System IP Address  
• System Subnet  
• System Gateway  

 To set the server as a default server, click the Default Server check box. 

 To set the server as the default surgical navigation server, click the Default Navigation check box. 

 To enable the storage commitment, click the Enable Storage Commit check box to send a message 
back to system that confirms the storage was successful; it is an extra confirmation from PACS that 
the images were received. 

 To gather responses, click the Listen for Responses check box. 

For every image that is sent, the system will wait for acknowledgement before sending the next 
image. 

 To gather 12-bit images, click the 12-bit Images check box. 

 Click the Save button, to keep your work. 
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Figure 95: Action Succeeded popup message – Server saved 

The new server should appear in list box to the left. 

 Click the Ok button. 

 Click the Close button to exit. 

Modifying a server 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click server type: Store or Worklist. 

 Select a server from the list. 

 Modify the parameters. 

See “Assigning a server as a store or worklist server” on page 122. 

 When all your changes are made, click the Update button. 

A message appears that explains the update was successful and includes the update(s). 

 
Figure 96: Action Succeeded popup message – Server updated 

 Click the Ok button. 
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 Click the Close button to exit. 

Echoing a server 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click a server type: Store or Worklist. 

 Select the server to echo from the list. 

 Click the Echo button. 

The status of the server (popup message) appears. 

  
Figure 97: Echo Successful and Echo Failed popup messages 

 Click the Ok button. 

If the echo was unsuccessful, determine why and repeat step 5 until you are successful. 

 Click the Close button to exit. 

Deleting a server 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click a server type: Store or Worklist. 

 When the server you want to remove is available, click the server from this list. 

 Click the Delete button. 

The server is removed from the list; the Action Succeeded popup appears. 

 Click the Ok button. 
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 Click the Close button to exit. 

Moving a server up and down the server l ist 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click a server type: Store or Worklist. 

 Select the server to move up or down the list. 

 Click the Up (arrow) button to move the server up the list; click the Down (arrow) button to move 
the server down the list. 

 
Figure 98: Up and Down (arrow) buttons to move up and down server list 

 Click the Save button to save the server order. 
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Figure 99: Save button 

The Action Succeeded popup appears. 

 Click the Ok button. 

 Click the Close button to exit. 

Saving DICOM servers to a PACS list  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Servers tab. 

 Click the PACS List tab to view available servers. 
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Figure 100: DICOM Servers > PACS List tab 

 Double-click the light-gray checkmark under In List. 

Each checkmark adds the server to the PACS listing.  The checkmark turns green when active. 

 Click the Save button. 

The PACS List Saved popup appears. 

 
Figure 101: PACS List Saved popup message – PACS saved 

 Click the Ok button. 

 Click the Close button to exit. 

Selecting PACS options 

PACS is Picture Archiving and Communication System. 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 
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 Click the DICOM Servers tab. 

 Click the Options tab. 

 
Figure 102: DICOM Servers > Options tab 

 Under PACS Options, click the Enable Storage Commit to verify that patient information and data 
archived to the PACS server was received. 

• If Enable Storage Commit is not selected, it is assumed and accepted that the data was 
received.  No check is made; skip to step 6. 

• If Enable Storage Commit is selected, the workstation sends a request to the PACS server to 
verify that the data was received. 

 If the Enable Storage Commit check box is selected, perform the following: 

• Enter the appropriate title in the System Called AE Title text box. 

• Enter the port identifier in the Port text box. 

• Enter the number of seconds before a connection timeout in the Connection Timeout (secs) 
text box. 

Enter 30 seconds or 60 seconds. 

 Under Purge Options, make selections based on the understanding that any studies archived to the 
PACS server are deleted from the workstation on a regular basis, depending on the selected interval; 
identify the following: 

• Purge Interval Selects one of the following from the dropdown: Everyday, Weekly, or 
Monthly. 

 
When you select the first Purge Interval dropdown and select Weekly or 
Monthly, the inactive dropdown is active to let you select the day of the 
week or the first of the month. 
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• Time Changes the hour, minute, and second interval; Use the buttons to 
increase those time elements. 

 
 

Figure 103: Time (increase and decrease time) arrows 

 Under the HIS/RIS Options, enter the maximum number of results sent back from a query worklist 
in the Query Max text box. 

There is no maximum limit. 

 Click the Send MPPS check box to apply a service that allows a modality to better coordinate with 
image storage servers by giving the server a list of objects to send before or while actually sending 
such objects. 

 Under Import Options, click the Use C-GET check box to pull information from a PACS server 
when importing from the server (as opposed to archiving to it). 

The administrator sets this to pull from PACS from anywhere, so the machine does not have to be 
set up as a reliable destination on the PACS machine.  (PACS, typically needs to equate a 
computer’s IP address with an AE Title; however, C-GET accepts that the calling IP is a legitimate 
device.) 

The NeuroLogica CereTom Elite scanner automatically uses C-Move (DICOM operation) when 
importing from PACS.  If the operator wants to use C-GET instead, the user can select C-Get 
(DICOM operation). 

 Click the Save button. 

The PACS List Saved popup appears. 

 
Figure 104: PACS List Saved popup 

 Click the Ok button. 

 Click the Close button to exit. 
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Assigning DICOM settings 

DICOM settings include many different kinds of settings.  The administrator can add or remove optional 
information to be displayed using actions described in this section. 

See DICOM standards on the NEMA.org website for a full list and description of DICOM tags. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the DICOM Settings tab. 

 
Figure 105: DICOM Settings tabs (six) 

 Click the HIS/RIS Query tab to apply what tabs (and kinds of HIS/RIS query information) the 
operator (user) will see. 

See “Selecting PACS options” and go to step 6, for more information. 

No t e  Even  numbe red  D ICOM t ag s  a r e  pub l i c  D ICOM t ag s  a s  pe r  t h e  DIC OM 
s t anda rd .   Odd  numbe red  D ICOM t ag s  a r e  v endor  s pec i f i c .  

 Green  che ckmark s  a r e  ‘ o p t i on a l ’  D ICOM t ag s  and  o range  checkmark s  a r e  
‘ r e qu i r ed ’  pe r  t h e  DICOM s t anda rd ,  and  canno t  be  mod i f i e d .  
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Figure 106: DICOM Settings > HIS/RIS Query 

 Click the MPPS tab to apply what tabs (and kinds of Modality Performed Procedure Step (MPPS) 
information) the operator (user) will see. 

 
Figure 107: DICOM Settings > MPPS 

 Click the Patient Module tab to apply what tabs (and kinds of patient-module information) the 
operator (user) will see. 
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Figure 108: DICOM Settings > Patient Module 

 Click the Study Module tab to apply what tabs (and kinds of study-module information) the 
operator (user) will see. 

 
Figure 109: DICOM Settings > Study Module 

 Click the Series Module tab to apply what tabs (and kinds of series-module information) the 
operator (user) will see. 
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Figure 110: DICOM Settings > Series Module 

 Click the Image Module tab to apply what tabs (and kinds of image-module information) the 
operator (user) will see. 

 
Figure 111: DICOM Settings > Image Module 

 Click the Close button to exit. 

Assigning dose report 

The dose report is created at the end of the scan and can be customized to include DICOM specific tags. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

 Click Customize > System from the main menu. 
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The System Configuration dialog box appears. 

 Click the General Settings tab. 

 Click the Dose Report tab. 

The Dose Report tab is active. 

 
Figure 112: Dose Report tab 

 Click those DICOM tags you want to see in the dose report after a scan. 

A dose report is generated after the image is created; the black area includes dose report information 
similar to the following after the operator acquires a scan. 

 
Figure 113: Generated dose report 

 Click the Save button. 

 Click the Close button to exit. 
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Applying dose configuration 

Note  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

  You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

Dose configuration is visible only when the Dose Check feature is enabled. 

Setting Dose Check 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Click the Dose Check tab. 

 
Figure 114: Dose Configuration > Dose Check 

 Click one of the following Dose Check Type options: 

• Dose Notification 
Notifies the operator that the programed dose for each 
acquisition, exceeds the limit set by the administrator for a 
particular exposure. 

• Dose Alert 
Sets alerts if the dose amount exceeds the set limit by total 
accumulation.  Dose Alert applies to the entire scan (series and 
scouts).  Warns the operator that they will exceed the total 
dose for a series or exam set by the administrator. 
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No t e  When  you  ( t h e  admin i s t r a t o r )  enab l e  t h e  
Do se  A l e r t ,  t h e  sy s t em w i l l  p r even t  t h e  
pa t i en t  f rom r e ce i v i ng  any  po ss i b l e  
de t e rm in i s t i c  e f f e c t s  due  t o  e xce s s  do se  
bec aus e  t h e  de f au l t  l im i t  o f  1  Gy  CTDI  i s  
s e t .  

 Click one from the following Scan Type options. 
• All Identifies all scan types. 
• Axial Identifies Axial (step and shoot) scan types, only. 
• Helical Identifies Helical scan types, only. 
• Dynamic Identifies Dynamic scan types, only. 

 Define the Dose Limit by entering the following: 

• Enter the CTDIvol (mGy) value in the text box. 

• Enter the DLP (mGy.cm) value in the text box. 

 Click the Save button. 

The Save Successful popup appears. 

 Click the Ok button. 

 Click the Close button to exit. 

Assigning dose configuration to a patient protocol 

   
Figure 115: Dose Configuration > Dose Configuration for Adult and Pediatric 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 
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Figure 116: Dose Configuration > Dose Configuration for Adult and Pediatric 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

 Hover the mouse pointer over the colored orb on the Adult or Pediatric body to identify the body 
part. 

A description above the Adult or Pediatric options shows the body part at the foot of the patient 
body. 

 Click the body region (colored orb) that marks the anatomical region to apply the dose to. 
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Figure 117: Anatomical orbs; orb definition below the body and related-to-orb protocols in list 

 Click a scan type from the following list:  
• All Identifies all scan types. 
• Axial Identifies Axial (step and shoot) scan types, only. 
• Helical Identifies Helical scan types, only. 
• Dynamic Identifies Dynamic scan types, only. 

 Enter a description of this dosage configuration in the Description text box. 

 For Pediatric (only), enter the Weight (kg) and Length (cm) information for the Minimum and 
Maximum (amounts not to exceed) in the text boxes. 

 Click the kV dropdown box to select the amount not to exceed, under Max Power. 

 Click the mA dropdown box to select the amount not to exceed. 

 Click the Save button to save your work. 

If the level overlaps an existing level, you are prompted to make adjustments. 
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Figure 118: Invalid Parameter popup message – Dose setting kV already exists 

If the save is successful the Save Successful popup appears. 

 
Figure 119: Save Successful popup message – Maximum dose saved 

 Click the Ok button. 

 Under the Saved Doses list box, check that your dose configuration appears; if so go to the next 
step. 

 Click the Close button to exit. 

Updating saved dose 

This section presumes you (the administrator) made changes that are not yet saved.  See page 136 and/or 
137 to set or assign dose configuration to the patient. 

  Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 Select a saved dose by clicking one under Saved Doses, in the list. 

 Make your changes to the fields that are relevant. 

The Update button is active. 

 Click the Update button. 
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Figure 120: Save Successful popup message – Maximum dose saved 

 Click the Ok button. 

 Click the Save button to save your work. 

No te  I f  t h e  l e v e l  ove r l ap s  an  e x i s t i ng  l ev e l ,  you  a r e  p rom pt ed  t o  make  
ad ju s tmen t s .  

 Click the Close button to exit. 

Deleting a saved dose limit 

This section presumes you (the administrator) made changes to delete.  See page 136 and/or 137 to set or 
assign dose configuration to the patient. 

  Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Dose Configuration tab. 

 
Figure 121: Dose Configuration > Dose Check tab 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 142 of 374 Setting windowing presets 

 Click an already-saved dose, under the Saved Doses list. 

 Perform one of the following: 

• To delete a saved dose from the Saved Doses list and clear the restriction, select the dose and 
click the Delete button. 

• To delete all the saved doses in the Saved Doses list and clear all restrictions saved, click the 
Delete All button, which returns all settings for that particular selection to the maximum 
scanner default. 

No t e  I f  t h e r e  a r e  no  saved  do s e s  o r  l im i t s ,  t h e  ope ra t o r  w i l l  be  a b l e  t o  s can  a t  
f u l l  power  (140kV and  7mA) f o r  t h e  CereTom E l i t e .  

 The  l im i t s  a r e  u sed  t o  p r ev en t  ope ra t o r s  f rom us ing  a  max  t e chn iqu e  on  
ped i a t r i c s ,  f o r  exampl e .  

 Click the Save button. 

The save success message appears and, because the CTDIvol (mGy) and DLP (mGy.cm) are empty, 
there is no longer a limit applied. 

The Save Successful popup appears. 

 
Figure 122: Save popup message – Maximum dose saved 

 Click the Ok button. 

 Click the Close button to exit. 

Setting windowing presets 

A preset lets you (the administrator) set window width and window center. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  
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The administrator can find or delete existing windowing presets, update an existing windowing preset, or 
create and save a new windowing preset. 

Editing kernel presets 

Note  Kerne l  p r e s e t s  a r e  p r e - in s t a l l ed  in  t h e  sy s t em ;  k e rn e l  p r e s e t s  c an  b e  s e t  and  
mod i f i ed  by  you .  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 
Figure 123: Windowing Preset tab 

 Click the Kernel Presets tab. 
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Figure 124: Windowing Presets > Kernel Presets tab 

 Click the Scan Type dropdown to select one of the following scan types: 
• Scout  
• Axial  
• Helical  
• ENT  

 Click the Sharpness dropdown to select a sharpness from the list. 

Sharpness is a reconstruction algorithm. 

 
Figure 125: Sharpness dropdown 

 Enter the window width in the Width text box. 
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Window width describes the range of Hounsfield units displayed across the image.  The maximum 
width possible is usually ~2000, but human eyes are not capable of seeing this many shades.  
Humans can only distinguish about 16 shades of gray.  The window width is divided by 16; each 
group of Hounsfield values is converted to one of the 16 shades of gray.  The lowest Hounsfield 
numbers in the window range are shown in black and the highest in white. 

 Enter the window center in the Center text box. 

Window center describes the Hounsfield number in the center of the window width. 

 Click the Save button to save your work. 

The Action Succeeded popup appears. 

 
Figure 126: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 

Setting window presets 

Window presets allow the operator to define window level and window center presets for specific 
anatomical sites, such as bone, brain, lung, and soft tissue. 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 Click the Window Presets tab. 
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 Figure 127: Window Presets tab 

 Enter the name of the window preset in the Name text box. 

 
Figure 128: Window Presets > Name 

 Enter the width of the window preset in the Width text box. 
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Figure 129: Window Presets > Width 

 Enter the center of the window preset in the Center text box. 

 
Figure 130: Window Presets > Center 

 Click the Save button to save your work. 

The Action Succeeded popup appears. 
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Figure 131: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 

Editing a window preset 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 Click the Window Presets tab. 

 Click a preset that exists in the Window Presets listing. 

 
Figure 132: Listing update 

 To edit the preset, make your changes in the Name, Width, and/or Center text boxes. 

 To delete a preset, click the Delete button. 
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 Click the Save button to save your changes. 

The Action Succeeded popup appears. 

 
Figure 133: Action Succeeded popup message – Preset saved 

 Click the Ok button. 

 Click the Close button to exit. 

Saving a preset 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Windowing Preset tab. 

The Window Width and Window Center appears. 

 Enter the preset name in text field. 

 Enter the width and center values. 

 Click the Save button. 

The Action Succeeded popup appears. 

 
Figure 134: Action Succeeded popup message – Preset saved 

 Click the Ok button. 
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 Click the Save button to exit. 

Deleting a preset 

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 

 Click the Windowing Presets tab. 

 Select the preset. 

 Click the Delete button. 

The Action Succeeded popup appears. 

 
Figure 135: Action Succeeded popup message – Preset deleted 

 Click the Ok button. 

 Click the Save button to exit. 

Setting up the Audit Trail Viewer 

The administrator sets up the Audit Trail Viewer to build an audit trail, which monitors and/or reports 
changes that are made – from all users who logged in, changed presets, and so on.  These users include 
operator, administrator, or service-related users that make changes to the system. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 
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 Click the Audit Trail Viewer tab. 

 
Figure 136: Audit Trail Viewer tab 

 From the Audit Trail Viewer tab, select a date or date range with the calendar to show when 
changes were made. 

• To select a single date, position the mouse pointer in the top box and click the date on the 
calendar to find audits for that date.  See the calendar in the next figures. 

• To select a span of time, position the mouse pointer in the top box and click the start date 
(on the calendar) and then move the mouse pointer to the From box and click the end date 
on the calendar.  This approach lets you select a range of audits done in a specified span of 
time.  See the text boxes to the right of the calendar; the top text box is where the start date 
will show when you select a start date on the calendar; the bottom text box is where the end 
date will show when you select an end date on the calendar. 

  
Figure 137: Adding a date or a date span 

 Click the Audit Type dropdown to select the kind of audit you are searching. 
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Figure 138: Audit Trail Viewer > Audit Type dropdown 

 From the User ID dropdown, click the type of user to track. 

 
Figure 139: Audit Trail Viewer > User ID dropdown 

 Click the View button to see the result of audits that met your criteria. 

The results appear. 
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Figure 140: Audit results 

 Perform one of the following: 

• Click the Clear button to remove the audit results. 

• Click the Export button to export the audit result that you selected to the audit backup file 
on the system. 

• Click the Export All button to export all the audit trails that appear to the audit backup file 
on the system.  Files will export to the audit backup file on the system. 

 Click the Close button to exit. 

Setting image orientation 

NeuroLogica takes the view when describing patient orientation as if the viewer were standing at the foot 
of the patient’s bed – for the anatomical position.  In other words, if the patient is lying face up (on the 
patient’s back) with the patient’s head in the gantry, the view of the patient shows the patient’s right side 
to the viewer’s left.  If the patient’s feet are going into the gantry first and the viewer is standing at the 
back of the gantry, the viewer sees the patient’s right side to the viewer’s left side. 

No te  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

 Click Customize > System from the main menu. 

The System Configuration dialog box appears. 
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 Click the Image Orientation tab. 

 
Figure 141: Image Orientation tab 

The top half of the Image Orientation screen shows all the possible subject patient orientations.  
The black square represents the viewing area and shows, by an abbreviated letter, four different 
orientation locators: A = anterior, L = left, P = posterior and R = right.  If you do not see these 
letters in the black (image orientation) box, select an image orientation from the list. 

 Select the appropriate orientation from the list. 

For example, select, Head First Supine.  In the example in the figure below, the highlighted 
selection shows the current orientation in the Current Flip Orientation field (which is not 
changeable); however, the New Flip Orientation (the location where you can change the 
orientation) lets you change the orientation. 

 Click the New Flip Orientation dropdown to select one of the following new-flip orientations: 
• NONE  
• LEFT_AND_RIGHT  
• TOP_AND_BOTTOM  
• BOTH  
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Figure 142: Image Orientation > New Flip Orientation dropdown 

 Click the Save button to save changes. 

The Settings Saved popup appears saying the “Image orientation settings have been saved.” 

 
Figure 143: Settings Saved popup message – Image orientation settings saved 

 Click the Ok button. 

 Click the Close button to exit. 

User configuration 

User configuration allows all users (administrator, limited operator, and restricted operator) to change 
their password for their own account. 

Updating your user account 

 Click Customize > User from the main menu. 
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The User Configuration dialog box appears. 

No te  You  ( t h e  l im i t ed  op e ra t o r )  c a nno t  a l t e r  Use r  ID  and  Use r  Le ve l ;  you  
mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  make  t h e se  cu s t omiz a t i ons .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

The Update Accounts tab is the default selection. 

 Modify the following fields associated with your user account by entering relevant information: 

• Last Name 

• First Name 

• Password (and re-enter the new password in Verify Password to validate). 

 
Figure 144: Last Name, First Name, Password, and Verify Password fields 

 Click the Update button. 

The Update Succeeded popup appears. 

 
Figure 145: Update Succeeded popup message – Account updated 
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 Click the Ok button. 

 Click the Close button to exit. 

Applying column settings to HIS/RIS Query 

Allows the user to customize what columns of information will appear when viewing the HIS/RIS 
(Hospital Information System (HIS) and/or Radiology Information Systems (RIS)) information that is 
queried. 

All users (administrators, limited operators, and restricted operators) can access user configuration and 
make changes to the column settings; however limited and restricted operators cannot make their 
changes to the column headings the default.  Only the administrator can make column settings a default 
(with the Make Default option).  When the administrator logs in and makes column settings a default, 
the change is the default for the administrator’s log in, only. 

No t e  Admin i s t r a t o r s  and  l im i t ed  ope ra t o r s  c an  make  t h e se  changes ;  r e s t r i c t e d  
ope ra t o r s  c anno t  app l y  co l um n se t t i ng s  a s  a  de f au l t .  

 Click Customize > User from the main menu. 

The User Configuration dialog box appears. 

 Click the Column Settings tab. 

There may be no entries that appear, initially. 

No t e  When  an  op t i on  i s  s e l e c t ed  ( f o r  exampl e  HIS /RIS  Query  or  Pa t ien t  
Browse r ) ,  a  t ab l e  i s  c r ea t ed  t h a t  l i s t s  t h e  co l umns ,  a l ong  w i th  a  check  box  
t o  ind i ca t e  whe the r  i t  w i l l  be  d i s p l ay ed  w i th in  t h e  t ab l e .   R equ i r ed  
co l umns  c anno t  be  unchecked  and  a r e  co l o r ed  o rang e  in s t e ad  o f  t h e  
de f au l t  g r een .  

 Click the HIS/RIS Query option. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 158 of 374 User configuration 

 
Figure 146: Column Settings dialog box with HIS/RIS Query option 

 Click a row to select a column settings. 

 
Figure 147: Column Settings with a selected query in HIS/RIS 

 Notice that the Up and Dwn buttons are active when you make a selection. 

 Click the Up button to move HIS/RIS Query option up the list; click the Dwn button to move 
HIS/RIS Query option down the list. 
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Figure 148: Column Settings with HIS/RIS Query option using Up and Dwn buttons 

 If you have administrative privileges, click the Make Default option to make the selected column 
display the default for all user accounts that do not override the default with a unique setting. 

 
Figure 149: Make Default option 

 Click the Save button to keep changes. 

 Click the Close button to exit. 
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Applying column settings to Patient Browser 

Note  Admin i s t r a t o r s  and  l im i t ed  ope ra t o r s  c an  make  t h e se  changes ;  r e s t r i c t e d  
ope ra t o r s  c anno t  app l y  co l um n se t t i ng s  a s  a  de f au l t .  

 Click Customize > User from the main menu. 

The User Configuration dialog box appears. 

 Click the Column Settings tab. 

Column settings allows the all users to display what appears in the HIS/RIS Query, Patient 
Browser, Patient/Study, and Series. 

 Click the Patient Browser option. 

 
Figure 150: Column Settings with Patient Browser option 

Patient Browser lets you configure the columns of information (such as, Name, Date, DOB, Referring 
Physician) – columns seen in the Patient Browser. 

 Click one of the following options: 

• Patient/Study Information that appears on the top portion of the Patient Browser (tab) that 
defines patient specific information. 

• Series Information that appears on the lower portion of the Patient Browser (tab) that 
defines the scan (or series) specific information. 

 Click a row to select a column setting. 

 Notice that the Up and Dwn buttons are active when you make a selection. 

 Click the Up button to move Patient Browser option up the list; click the Dwn button to move 
Patient Browser option down the list. 
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Figure 151: Column Settings with HIS/RIS Query option – using Up and Dwn buttons 

 If you have administrative privileges, click the Make Default option to make the selected column 
settings (display) the default for all users. 

 
Figure 152: Make Default option 

 Click the Save button to save the list. 

 Click the Close button to exit. 
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Chapter 6     Protocol Manager 

Note  You  mus t  h ave  admin i s t r a t i v e  p r i v i l eg e s  t o  a c ce s s  t h i s  a r ea  in  t h e  app l i c a t i on .  

 You  mus t  b e  l ogged  in  a s  an  admin i s t r a t o r  t o  p e r f o rm th i s  p roc edur e .  

 Inco r r e c t  change s  t o  t h e  sy s t em con f i gu ra t i on  may  make  t h e  sy s t em 
inope ra t i v e .  

Protocol Manager lets you (the administrator, only) set how the limited and restricted operator uses 
protocols.  Protocol Manager also provides three patient options: Adult, Pediatric, or  (Trauma) 
patient. 

Creating a new protocol 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog appears. 

   
Figure 153: Protocol Manager for Adult and Pediatric 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 
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No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

  Th i s  s canner  comes  w i th  p r e s e t  p ro t oco l s  f o r  ped i a t r i c  pa t i en t s  t h a t  v a ry  
a cco r d ing  t o  ag e  o r  we i gh t .  These  p ro t oco l s  a r e  mean t  t o  b e  a  gu ide  f o r  
rou t ine  s cann i ng .   An  ind i v i dua l  pa t i en t  may  r equ i r e  h i ghe r  o r  l ower  
do se s  t h an  in  t h e  rou t ine  p r e s e t  t o  a ch i eve  t h e  d i agno s t i c  g oa l s  f o r  t h e  
ped i a t r i c  pa t i en t ’ s  med i ca l  cond i t i on .  The se  p r e se t  ped i a t r i c  p ro t o co l s  
were  e s t ab l i sh ed  a s  a  r edu c t i on  f rom the  adu l t  p ro t oco l s  t o  a ch i eve  t h e  
same  image  s i gna l  t o  no i se .   A t  t h i s  t ime  th e r e  i s  no  ag r eemen t  among  
sc i en t i f i c  and  med i ca l  o rg an i z a t i ons  a s  t o  wha t  t h e  p rope r  p ro t oco l  i s  f o r  
ped i a t r i c  pa t i en t s .   I t  i s  t h e  r e spon s ib i l i t y  o f  t h e  u se r  t o  de c ide  whe the r  
t h e se  p ro t oco l s  a r e  ad equ a t e  f o r  a ch i ev ing  t h e i r  d i agnos t i c  goa l s  on  a  
pa t i en t - by - pa t i en t  ba s i s .  

  The  u s e r  c an  mod i f y  any  o f  t h e  ex i s t i ng  CT s can  pr o t oco l s  on  t h e  mach ine  
and/o r  c r ea t e  n ew  pr o t oco l s  a s  deemed  needed .   To  c r ea t e  t h e se  p ro t oco l s ,  
Admin i s t r a t o r  p r i v i l eg e s  a r e  r equ i r ed .  

 
WARNING  

 

Any modification to an existing protocol, or any new protocol created should be reviewed and approved 
by a radiology administrator and residing medical physicist.  Failing to do so could cause a pediatric 
patient to receive excessive and/or unnecessary dose of ionizing radiation. 

Resources for radiation protection of pediatric patients appear below and are referring physicians with a 
focus on radiation exposure: 

• American Academy of Pediatrics (AAP), https://www.aap.org: search for radiation risk to children 
from Computed Tomography 

• Federal Drug Administration (FDA), https://www.fda.gov: search for guidelines for pediatricians 
regarding medical radiation safety 

• American College of Radiology (ACR), https://acsearch.acr.org/list: Appropriateness Criteria® 
guidelines  

• Image Gently® and CT scans 

• Image Gently/FDA Digital Radiography Safety Checklist: 
https://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf 

 

  

http://www.fda.gov/radiationsafety
http://www.imagegently.org/Procedures/Computed-Tomography
http://www.imagegently.org/Procedures/Digital-Radiography/Quality-Improvement
http://www.imagegently.org/Portals/6/Procedures/Attachment%20D.CR.DR%20%20checklist.pdf
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Figure 154: Protocol Manager for Adult and Pediatric 

 Click the colored orb corresponding to the appropriate body part. 

 
Figure 155: Adult and Pediatric anatomical orbs, in this case the head orb 

The New button and others (depending on what was done previously) are active after you click a 
colored orb corresponding to the body part and then click the protocol that shows in the Protocol 
list.  Existing protocols appear in the Protocol list box, as shown, in the figures below. 

  
Figure 156: Adult and Pediatric protocol lists 

 Click the New button to create a new protocol. 

The New Protocol dialog box appears. 
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Figure 157: New Protocol dialog box 

The Protocol Information and Protocol’s Series areas are empty.  The Patient Position settings are 
identical whether it is for an adult, pediatric, or emergency patient. 

 For Protocol Information, enter your information in the following text boxes: 

• Protocol Description  What name of the protocol you assign (as it will be 
listed); for example, Axial head or Helical head. 

• Anatomical Reference  References what part of the anatomy will be scanned; 
for example, head or chest. 

• Default Study Description  
What appears as the DICOM image tag; if entered, 
this description will also appear in PACS as a Study 
Description DICOM tag (00081010). 

• For Pediatric, Weight (kg) and 
Length (cm)  

Where you enter the weight and length of the 
pediatric patient. 

 Under Patient Position, select one of the following scanning positions from the dropdown: 

• HFS Head First-Supine 

• HFP Head First-Prone 

• HFDL Head First-Decubitus Left 

• HFDR Head First-Decubitus Right 

• FFS Feet First-Supine 

• FFP Feet First-Prone 

• FFDL Feet First-Decubitus Left 

• FFDR Feet First-Decubitus Right 
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You can also move the rotating positional handles (by hovering the mouse pointer over the handle 
and left-mouse clicking) to select a position.  The arrows at the feet rotate the patient orientation 
from head first to feet first.  The arrow above the patient rotates the patient orientation from Supine 
to Prone to Decubitus. 

 
Figure 158: Patient position handles 

 Under Protocol’s Series, click the New button. 

The New Series dialog box appears. 

 
Figure 159: New Series dialog box 

 For Scan Type, select one of the following: 
• Axial  
• Helical  
• Dynamic  
• Reference  
• Scout  
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 For Scout Type, select one of the following: 
• AP   
• PA  
• Lateral  

Scout Type is not available for Axial, Helical, Dynamic, and Reference scan modes. 

 For kV (scan voltage), select one of the following: 

• 100  To set the range to 100. 

• 120  To set the range to 120. 

• 140  To set the range to 140. 

kV is not available for Dynamic scan mode. 

The highest scan-current obtainable from the x-ray tube can range from 1 to 7 mA based on 
available heat capacity of the x-ray tube.  At a nominal scan voltage of 120 kV, a maximum output 
power of 1 kW is maintained by the x-ray tube for at least 4 seconds if the current heat capacity of 
the tube does not exceed 80%. 

See “Identifying load factors” on page 201. 

 For mA (scan current), select the appropriate selection (1 to 7 mA with an increment of 1) from the 
dropdown. 

The maximum scan voltage can range from 100 to 140 kV based on available x-ray tube heat 
capacity.  X-ray tube power of any scan combination is computed as the product of the scan voltage 
and the scan current. 

The scan time is determined by the x-ray tube’s current heat capacity. 

Scan Power = Scan Voltage (kV) x Scan Current (mA) 

 For Slice Thickness/Spacing, select the appropriate following options: 

• In Axial scan mode, slice thickness is the same as slice spacing. 

• In Helical scan mode, the slice spacing can be different from slice thickness, based on pitch. 

• Slice Thickness/Spacing is not available for Scout scan modes. 

 For Sharpness, select the image reconstruction kernel from the following list of kernels: 
• Low Noise QA  
• Soft Tissue  
• Pos. Fossa/Vessel  
• Sharp  
• Bone  
• Sharp Lung  
• High Res QA  
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Sharpness allows only Soft Tissue for Reference scan mode and only Pos. Fossa/Vessel for Scout 
scan mode.  Pos. is abbreviated for Posterior. 

 For Resolution, select one of the following appropriate scan times: 

• 2 Second(s) 

• 4 Second(s) 

• 6 Seconds(s) 

Resolution is available for Axial and Reference scan mode, only. 

 For Pitch, select one of the following travel times (per scanner rotation): 

• 1; the scanner is moving at 10mm per second. 

• 1.5; the scanner is moving at 15mm per second. 

Pitch describes a scanner’s travel and how fast the scanner is moving per rotation; Pitch is available 
for Helical scan mode, only. 

 For Body Part Examined, select one of the following anatomical parts being scanned: 

HEAD CEREBELLUM EAR MAXILLA PHARYNX 

HEADNECK FACE IAC TMJ THROID 

SCALP EYE CHEEK PAROTID ESOPHAGUS 

SKULL CORNEA NOSE NECK TRACHEA 

ZYGOMA SCLERA MOUTH CAROTID  

BRAIN ORBIT TONGUE SUBMANDIBULAR  

CIRCLEOFWILLIS EYELID JAW LARYNX  

 For Description, enter the defined study description. 

 For Coverage (mm), enter the total scan distance. 

Coverage is not available for Dynamic and Reference scan modes. 

 For Contrast, enter the type of contrast given for example Omnipaque 300; for Contrast Volume, 
enter the amount of the contrast given, for example 80ml. 

Contrast is not available for Reference and Scout scan modes. 

 For Delay, enter the delay time that will occur after clicking the Start Scan button and before the 
scan begins. 

 For Number of images, if applicable, the calculated number appears here, depending on other 
selections. 

The number of images is calculated based on the slice thickness and length of the scan. 

 For Scan Time, if applicable, the calculated number appears here, depending on other selections. 
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The scan time is automatically calculated based on the parameters each operator chose, for example 
resolution, pitch, and so on. 

No t e  Dynamic  s can  t ime  mu s t  be  b e tween  30  and  45  se conds .  

 For Window Width, enter the range of CT numbers (maximum and minimum) that are distributed 
over the viewable gray scale of the display device or film. 

 For Window Center, enter the CT number in the center of the viewable gray scale. 

 For CTDIvol (mGy), if applicable, the calculated number appears here, depending on other 
selections. 

CTDIvol (mGy), applies an unknown to Axial and Dynamic scan modes; it applies 12.6 for Helical 
and 50.4 for Reference. 

CT Dose Index Volume (CTDIvol) represents the dose for a specific scan protocol, which takes into 
account gaps and overlaps between the radiation-dose profiles from consecutive rotations of the x-
ray source.  The CT Dose Index Volume is noted as CTDIvol.  The CTDIvol is calculated differently 
for both the Axial and the Helical modes: 

• For Axial scan mode: CTDIvol = [ (N x T)/I ] x CTDIw 

• For Helical scan mode: CTDIvol = 1/pitch x CTDIw 

 For DLP (mGy.com), enter the DLP (mGy.com) to apply an unknown to Axial and Dynamic scan 
modes; it applies 12.6 for Helical and 50.4 for Reference. 

The Dose Length Product (DLP) is the measure of ionizing radiation exposure during the entire 
acquisition of images.  Therefore, DLP (mGy.cm) = CTDIvol (mGy) x irradiated length (cm). 

 Select the following options, if applicable: 

• Step & Shoot 
Allows you to manually start the Axial scan acquisition from 
the workstation when scanning a patient who is unable to 
remain still – moves erratically; available for Axial, only. 

• Bolus Tracking A CT angiography technique that allows you to monitor the 
administration of contrast to initiate scan at peak performance. 

 Select the Enable AEC option, if applicable. 

• Enable AEC 
Allows you to automatically adapt the tube current or tube 
potential according to the patient's body habitus in order to 
achieve the specified image quality at the lowest possible dose. 

AEC (Automatic Exposure Control) is a scanner feature that automatically initiates a prescribed 
noise level in the image(s) taken, by adjusting the delivered mA to the patient based on density. 

When centering the patient in the gantry, it is vital to accurately use AEC.  AEC aims to deliver the 
specified image quality across a range of patient sizes.  The use of AEC may change the planned 
CTDIvol and DLP values.  It tends to increase CTDIvol for large patients and decrease CTDIvol for 
small patients – relative to a reference patient size. 
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No te  Ensure  pa t i en t  i s  a c cu ra t e l y  c en t e r ed  i n  g an t ry .  

 Do  no t  u se  AEC when  any  t ype  o f  me t a l  i s  go ing  t o  b e  s canned .  

 Do  no t  u se  AEC w i th  a  sma l l  FOV ,  t h a t  i s ,  t i ny  neona t a l  p ed i a t r i c s .  

 On l y  1  Ax i a l  o r  He l i c a l  s e r i e s  i s  a l l owed  w i th in  an  AEC pro t oco l .  

 An  au toma t i c  ad ju s tmen t  o f  t h e  t ube  cu r r en t  c anno t  o c cu r  when  th e  t ube  
po t en t i a l  i s  ch anged .  

 

No te  AEC  i s  an  op t i on  f o r  l ow  r e so l u t i on  sha rpn es s  k e r ne l s  (He l i c a l  ( so f t  
t i s su e  k e rn e l s )  o r  Ax i a l  ( l ow  no i s e  QA ,  s o f t  t i s s ue ,  Po s  Fo s sa /Ve ss e l ,  
sh a rp  k e rne l s ) .  

 Under AEC, click the Minimum mA dropdown to set the minimum allowed mA value used for 
scanning. 

 Under AEC, click the Maximum mA dropdown to set the maximum allowed mA value for 
scanning. 

The minimum mA on the CereTom Elite is 1 and the maximum mA is 7.  When using AEC, the 
limited and restricted operator defines the minimum and maximum mA for that particular scan, for 
example, 2 to 6. 

 Under AEC, click the Noise Level- to set the standard deviation of noise value for the completed 
scan. 

The noise range is 1-200. 

 To add a secondary reconstruction for the protocol, click the Add button in the Recons section. 

This is applicable for Axial (Step & Shoot) and Helical scans. 

The New Reconstruction popup appears. 
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Figure 160: New Reconstruction popup 

 Complete following in the New Reconstruction popup: 

• Enter a description in the Description text box to identify the new reconstruction. 

• Click the Slice Thickness/Spacing to select a slice thickness and spacing. 

• Click the Sharpness dropdown to select a sharpness from the list. 

• Enter the window width in the Window Width text box. 

• Enter the window center in the Window Center text box. 

• Click the Streak Removal check box to eliminate streaks. 

• Click the Noise Reduction check box to reduce noise. 

• Click the Level dropdown to select Low or High. 

 Perform one of the following: 

• Click the Add button to add the reconstruction protocol to the list. 

• Click the Reset button to reset the fields to their original (or former) data. 

• Click the Cancel button to remove your changes and return to the previous dialog box. 

The dialog box closes; your changes are added to the Recons area. 

 Click the Update button in the Edit Series dialog box. 
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Figure 161: Edit Series dialog box 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Close button to exit. 

Building from or editing an existing protocol 

Using the Build From button is used in Protocol Manager when the operator wants to create a protocol 
from an already existing protocol.  Using the Edit button is used in Protocol Manager as well as during a 
scan acquisition to edit a protocol. 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog appears. 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  
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 Click the colored orb corresponding to the appropriate body part. 

 
Figure 162: Anatomical orbs, in this case the head orb 

 Click the protocol you will build from or edit in the Protocol list. 

All the buttons, along the bottom of the dialog box, become active after you click a colored orb; 
each colored orb corresponds to a body part in the Protocol list.  The colored orb’s anatomical 
description (body location) appears under the Adult or Pediatric figure after it is selected, for 
example, hover over the colored orb at the knee and see EXTREMITY appear. 

 Perform one of the following: 

• To build from an already existing protocol, click the Build From button. 

 
Figure 163: Build From button 

The New Protocol dialog box appears. 
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Figure 164: New Protocol dialog box 

• To modify an existing protocol, click the Edit button. 

 
Figure 165: Edit button 

The Edit Protocol dialog box appears. 
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Figure 166: Edit Protocol dialog box 

 Make your changes. 

See “Creating a new protocol” on page 162 to learn how the fields and options perform to make 
informed choices on what to change. 

No t e  Be  su r e  t o  a s s i gn  t h e  Bu i l d  From  pro t oco l  a  new  name  (P r o t o co l  
De sc r i p t i on )  be fo r e  you  make  your  add i t i ona l  change s .  

 Perform one of the following: 

• If you clicked the Build From button and see the New Protocol dialog box, click the Save 
button to save your changes. 

The Successfully Saved popup appears. 

• Click the Ok button in the Successful Saved popup to return to the Protocol Manager 
dialog box. 

• If you clicked the Edit button and see the Edit Protocol dialog box, click the Update button to 
save your changes to the existing protocol and click the Update button, again, to the Protocol 
Manager. 

• Click the Reset button to remove any changes and return the previously filled in fields and 
selections. 

• Click the Cancel button to return to the previous dialog box. 

 Click the Close button to exit. 
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Copying and pasting protocols 

To copy and paste protocols into the Trauma orb (quickly) or any other protocol section, copy and paste 
already created protocols from Adult and Pediatric to paste for Trauma protocols. 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog appears. 

 Click one of the following: 
• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical area, 
here. 

• Trauma 

To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma protocols 
previously copied, pasted, and saved for a quick access to commonly used 
emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of saved 
protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

  
Figure 167: Protocol Manager for Adult and Pediatric 

 Click the colored orb corresponding to the appropriate body part. 
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Figure 168: Anatomical orbs, in this case the head orb 

 Review those protocols you will copy. 

 Highlight the protocol, right-click to see the dropdown, and click Copy. 

  
Figure 169: Copy and Paste right-click menus 

 Go to the trauma protocol listing. 

 Click  (Trauma) or the orb you selected to copy the protocol to. 

This lets you create trauma-specific protocols. 

 Right-click to see the dropdown and click Paste. 

 Click the Edit button to change the name of the protocol. 

 Change the name of the protocol to reflect it is a trauma protocol for either an adult or pediatric 
listing; for example change the protocol name AXIAL Head Stroke to TRAUMA 
AXIAL Head Stroke to identify it as a trauma protocol. 

 Click the Update button. 

 
Figure 170: Created, trauma-specific protocol 

 Click Close button to exit. 
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Deleting a protocol 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog box appears. 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

 Click the colored orb corresponding to the appropriate body part. 

Select the protocol from list to be deleted. 

 
Figure 171: Protocol Manager with a protocol selected 

 Click the Delete button. 

The Delete Confirmation popup appears. 
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 Perform one of the following in the Delete Confirmation popup: 

• Click the Yes button to delete the selected protocol. 

• Click the No button to return to the Protocol Manager dialog box. 

 
Figure 172: Delete Confirmation popup message – Yes or no to delete selection 

The Delete Confirmation dialog box disappears and the Protocol Manager dialog box appears. 

 Click the Close button to exit. 
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Uploading a protocol to the scanner 

Note  I f  Do se  Check  i s  enab l ed  on  t h e  work s t a t i on ,  you  canno t  up l oad  pro t o co l s  t o  
t h e  s cann er ;  t h e  u se r  w i l l  no t  s e e  t h e  Up l oad  bu t t on .  

Uploading protocols to the scanner is necessary to scan patients from the touch screen. 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog box appears. 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 

To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

 Click the colored orb corresponding to the appropriate body part. 

 Click the Upload button. 

 
Figure 173: Upload button 

The Upload Protocols to Scanner dialog box appears. 
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 Select an exam from the Exams list. 

The newly selected protocol(s) appears in the Protocols list. 

Scouts, protocols with bolus tracking or AEC, and duplicate protocols cannot be uploaded to the 
scanner. 

If you select them, the following Error popup appears; click the Ok button to create alternative 
protocols. 

 
Figure 174: Error popup message – Scouts, protocols with bolus tracking or AEC, and duplicate protocols 
not uploaded 

 Select the protocol(s) from the Protocols list to upload. 

 Click the Add button. 

 
Figure 175: Selected Protocols to add 

The protocols selected appear in Upload list. 

 Select the new, uploaded protocol(s). 
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Figure 176: New protocols in Upload list 

 Click the Upload button. 

 
Figure 177: Upload protocols to scanner 

The Protocols Updated popup appears to inform you that the protocols are successfully uploaded. 

 
Figure 178: Protocols Updated popup message – Custom protocols uploaded 

 Click the Ok button to close the Protocols Updated popup. 

 Click the Close button to exit. 
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No t e  You  c anno t  up l oad  pro t oco l s  f r om any  o th e r  v endor ’ s  s canner .  

Importing protocols from various media 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog box appears. 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

 Click the colored orb corresponding to the appropriate body part. 

 
Figure 179: Protocol Manager with Adult protocols showing 

 Click the Import button. 

The Select File popup appears. 
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Figure 180: Select File popup 

Not e  You  can  im por t  images  o r  s t ud i e s  f r om USB o r  CD fo r  compar i son  t o  
P a t i en t  Br owse r .  

 Click the path from where you want the import files to go. 

 Click the file(s) to import. 

 
Figure 181: Import button active in Select File when file(s) selected 

 In Select File popup, click the Import button. 

The Protocols Imported popup appears. 
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Figure 182: Protocols Imported popup message – Protocols imported 

 Click the Ok button. 

 Check that the imported files are imported. 

 Click the Close button to exit. 

Exporting protocols to various media 

 Click Tools >Protocol Manager from the main menu. 

The Protocol Manager dialog box appears. 

 Click one of the following: 

• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  

 Click the colored orb corresponding to the appropriate body part. 
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Figure 183: Protocol Manager with Adult protocols showing 

 Click the Export button. 

The Select Directory dialog box appears. 

 
Figure 184: Export button enabled 

 Select the file(s) to export. 

 Click the path, to where you want to export files. 

When you select a path, the Select button is active. 

 Click the Select button in Select Directory popup. 
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Figure 185: Select Directory popup 

 Click the Select button to confirm the files to export. 

The Protocols Exported popup appears. 

 
Figure 186: Protocols Exported popup message – Protocols exported 

 Click the Ok button. 

 Check that the exported files are exported. 

 Click the Close button to exit. 

Changing the order of protocols in the list 

 Click Tools > Protocol Manager from the main menu. 

The Protocol Manager dialog box appears. 

 Click one of the following: 
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• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, 
here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical 
area, here. 

• Trauma 

To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma 
protocols previously copied, pasted, and saved for a quick access to 
commonly used emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of 
saved protocols becomes available. 

 Click the colored orb corresponding to the appropriate body part. 

The New button and others (depending on what was done previously) are active after you click the 
colored orb corresponding to the body part you will scan.  You can then click the protocol that 
shows in the Protocol list.  Existing protocols appear in the Protocol list box, as shown, below. 

 Click the protocol to move up or down the list. 

 Click the Up (arrow) button to move the protocol up the list; click the Down arrow to move the 
protocol down the list. 

 
Figure 187: Changing protocol order with Up and Down (arrow) buttons 

 When you are finished ordering your protocols, click the Save button to save the new ordered list. 
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Figure 188: Protocol Save button 

 Click the Close button to exit. 
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Chapter 7     Daily Calibration and Quality Assurance 
You will learn how to perform a daily air calibration and use the Quality Assurance (QA) tool (a wizard) 
that verifies the system is at its optimum performance – in this chapter. 

Keep in mind that before using the CereTom Elite system, you must conduct a Quality Assurance (QA) 
test to verify the system is at its optimum performance. 

Performing a daily (air) calibration from the LCD 
touch screen 

Note  NeuroLog i ca  r e commends  t h a t  an  a i r  c a l i b r a t i on  i s  pe r f o rmed  eve ry  6 - 8  hour s .   
I f  t h e  a i r  f r e shne s s  f a l l s  b e l ow  50%,  o r  t h e  s canne r  i s  mov ed  t o  an  a r ea  w i th  a  
d r ama t i c  change  in  humid i t y  o r  t empera tu r e ,  pe r f o rm ano t he r  a i r  c a l i b r a t i on  
t o  en su r e  op t imum image  qua l i t y  du r ing  pa t i en t  s cann ing .  

 I f  r oom- t empera tu r e  f l u c tua t i ons  h ave  o ccu r r ed ,  you  may  n eed  t o  pe r f o rm 
more  t h an  one  a i r  c a l i b r a t i on s .   In  add i t i on ,  s canner s  c an  d r i f t  ou t  o f  
a l i gnment ;  make  su r e  you  pe r f o rm a  Qua l i t y  Te s t  w i th  t h e  t e s t  phan tom be fo r e  
s cann ing  a  pa t i en t .  

  I t  i s  r e c ommended  th a t  t h e  s c anner  i s  on  f o r  a t  l e a s t  6 0 - 90  m inu t e s  p r i o r  t o  
pe r f o rm ing  th e  a i r  c a l i b r a t i on .  

Be sure that nothing is in the bore before the daily (air) calibration takes place. 

 Make sure the shielding curtains (if fitted) are fully closed before beginning. 

 On the touch screen, press the Select Cal button on the Main tab. 

The screen will then display a list of protocols from which to choose (on the left). 

 
Figure 189: Select Cal button on the Main tab 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 7    Daily Calibration and Quality Assurance  Page 191 of 374 

 Press the Daily Cal button. 

 
Figure 190: Daily Cal button 

 Press the Accept Protocol button to continue. 

 Press Start Daily Cal to begin daily calibration. 

The Daily Cal has a built-in delay of ~10 seconds.  The calibration takes ~ 4.5 minutes.  The 
progress of the daily calibration appear on the workstation. 

 

 
Figure 191: Daily Calibration Progress popup 

To stop the scan, press the Cancel button. 

The Daily Cal icon will change to green when it reaches a 100% air freshness. 

 
Figure 192: Air freshness icon changes as the air quality drops from green to yellow to red 

The QA phantom overview 

The QA phantom is a device that measures parameters that completely characterize image quality; these 
parameters are as follows: 

• Uniformity 
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• Noise 
• High-contrast resolution 
• Slice width  
• Low-contrast resolution  
• Sensitometry (contrast scale) 

 
Figure 193: QA phantom 

The QA phantom is a 20cm diameter disk consisting of a substrate made of poly methyl methacrylate 
(PMMA), and containing specific inserts.  The uniform area of the disk is used to measure uniformity 
and noise.  Four other parameters are measured by the inserts in the substrate. 

The disk is encapsulated in a foam casing that enables it to be correctly positioned in the scanner.  In this 
user manual, when the phantom is referenced, the foam casing is also implicitly referenced. 

The Axial resolution wire, also called the Modulation Transfer Function (MTF) wire, is intended for 
measuring resolution in the Axial plane.  Resolution is defined as the ability to distinguish small objects.  
It is expressed in line pairs per millimeter. 

The slice width wires are the two inclined wires.  They are intended to determine scanner resolution 
along the Z axis, that is, in the direction that is perpendicular to the Axial plane.  Resolution along the Z 
axis is expressed in terms of slice width in millimeters.  Although one wire is sufficient to measure the Z 
axis resolution if its position is accurately known, a second wire is included to confirm the alignment.  If 
the alignment was incorrect, the results of the slice width test would not be accurate. 

The low-contrast insert is a compound insert.  It is made of two half cylinders of different materials with 
a known contrast difference between them.  The low-contrast insert is intended to measure the contrast 
resolution of the scanner.  The contrast resolution is the ability to measure small differences in x-ray 
attenuation. 

The sensitometry inserts are an air bore and cylinder made of different materials.  They are intended to 
measure the contrast scaling of the scanner. 

The QA scan protocols appear in the following table. 
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Table 21: Scan protocols used by the QA 

 CereTom E l i t e  

Scan voltage  140 kV 

Scan current  7 mA 

Scan time   6 seconds 

Kernel  PostFossa 

Slice thickness  10mm 

Starting Quality Assurance from the touch screen 

To ensure the system is at its optimum, factory-specifications level, the workstation provides QA tools to 
verify the system’s state and to perform image-quality verification. 

Before you begin this section, be sure to run a fresh Daily Calibration on the system using the touch 
screen.  See “Performing a daily (air) calibration from the LCD touch screen” on page 190. 

The QA protocol is shipped with the system and appears when you click Quality Assurance from the 
main menu (on the workstation) or if the QA protocol is selected on the touch screen.  You (the 
operator) cannot customize or modify the QA protocol. 

No t e  The  QA t e s t  shou ld  be  condu c t ed  pe r  t h e  l o ca l  (ho sp i t a l )  r equ i r emen t s ;  
s c ann ing  t h e  QA phan tom i s  done  da i l y ,  w eek l y ,  o r  month l y ,  t yp i ca l l y .  

Before beginning the QA protocol, make sure a QA phantom is available and ready to install in the bore. 

 Place the phantom in the bore. 

The phantom label should face the front of the scanner and be positioned at the bottom – as shown 
in the figure below.  The red insert should be on the operator’s right when facing the scanner.  The 
position of the phantom will greatly affect the QA results. 

  
Figure 194: Phantom and phantom in bore 
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 On the touch screen, press the Laser On button. 

 
Figure 195: Laser On button 

 Align the phantom by lining the QA phantom’s etching (line(s)) with the laser light. 

 
Figure 196: Phantom’s etchings appear on top and sides 

 Make sure the shielding curtains are fully closed before starting the QA. 

     
Figure 197: Shielding curtains, opened and closed 

 Align the center of the phantom with the laser light. 

The laser will automatically shut off 30 seconds after pressing the Laser On button. 

See the laser precautions in “Laser safety” on page 52. 

 Press the Select Cal button on the touch screen. 
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 Press the QA button. 

 Press the Accept Protocol button. 

Wait for the Scan button to be activated. 

 Press the Scan button to initiate the scan. 

To cancel the scan, press the Cancel button to return to the Main tab and abort the QA. 

 Press the Start button. 

 Wait for the QA to appear. 

 
Figure 198: QA results 

No t e  I t ems  in  r ed  a r e  f a i l ed  r e su l t s ;  r e po s i t i on  your  phan tom t o  pe r f o rm 
ano the r  s can .   Of t en  po s i t i on a l  i s su e s  cau se  t h e  f a i l u r e .   I f  you  t r y  
mu l t i p l e  t imes  and  f a i l u r e s  p e r s i s t ,  c a l l  your  s e r v i c e  r e pr e sen t a t i v e .  

 Review the results. 

 Click the Close button on the QA Results popup when finished reviewing. 

The image of the phantom appears. 

 
Figure 199: Phantom image 

 Click the Finalize button on the workstation to exit the protocol. 

The QA appears in the Patient Browser; however, it is locked. 
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Figure 200: Locked QA results in Patient Browser 

No t e  The  r e su l t s  a ppea r  in  P a t i en t  B row se r  and  a r e  l o cked  (and  canno t  b e  
de l e t ed ) .   P l ea s e  s e e  your  se r v i c e  r epr e s en t a t i v e  t o  r emov e  t h e  r e su l t s .  

Starting Quality Assurance from the workstation 

 Perform steps 1 through 5 in the procedure “Starting Quality Assurance from the touch screen” on 
page 193. 

 Click Tools > Quality Assurance from the workstation main menu. 

The Quality Assurance (QA) appears. 

 
Figure 201: QA phantom orientation 

 Click the Prepare button to begin the Quality Assurance test to run. 

Alternatively, click the Close button to return to the previous screen. 

 Wait for the Quality Assurance test to run. 

The system state orb will change color from (preparing the protocol to the system) to 
(ready to scan).  The System Ready to Scan popup appears. 
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Figure 202: System Ready to Scan popup message – System is ready to begin 

 From the workstation, perform one of the following: 

• To cancel the scan, perform the following: 

• Click the Cancel Scan button on the workstation screen. 

• Click the Ok button on the Exam Canceled popup. 

• The scan will end and the remaining steps are not required to perform. 

• To continue to scan, go to the next step. 

 Go to the touch screen (on the scanner) and press the Start button. 

You cannot start the scan from the workstation.  The system will scan the phantom.  Results for the 
QA image appear. 

 
Figure 203: QA results of QA image 

No t e  I t ems  in  r ed  a r e  f a i l ed  r e su l t s ;  r e po s i t i on  your  phan tom t o  r e s can  aga in .   
Of t en  po s i t i ona l  i s sue s  cau se  t h e  f a i l u r e .   I f  you  t r y  mu l t i p l e  t imes  and  
f a i l u r e s  pe r s i s t ,  c a l l  your  s e r v i c e  r e pr e s en t a t i v e .  

 Review the results. 

 Click the Close button on the results popup when finished reviewing. 

 Click the Finalize button on the workstation to exit the protocol. 

The QA appears in the Patient Browser; however, it is locked. 
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Figure 204: Locked QA results shown in Patient Browser 

No t e  The  r e su l t s  a ppea r  in  P a t i en t  B row se r  and  a r e  l o cked  (and  canno t  b e  de l e t ed ) .   
P l ea s e  s e e  your  se r v i c e  r ep r e s en t a t i v e  t o  r emove  t h e  r e su l t s .  

Ensuring good image quality 

In order to produce consistent image quality over the system's lifetime, you should (and it is strongly 
advised) establish and maintain a regular Quality Assurance (QA) program.  QA results are stored in the 
Patient Browser (workstation).  Please contact your local service representative to delete QA results. 

 Scan a known material (usually a phantom) under a prescribed set of conditions. 
 

  
Figure 205: Phantom and phantom in bore 

 Compare the results to previous or optimum values and repeat these tests on a regular basis to 
detect changes in image quality values before any problem becomes visible. 

No t e  I f  you  no t i c e  deg ra da t i on  in  image  qua l i t y  o r  a  change  in  QA va l ue s ,  
s ch edu l e  a  s i t e  v i s i t  and  l e t  s e r v i c e  pe r s on  o r  imag ing  phy s i c i s t  run  more  
de t a i l ed  t e s t s .  

 E a r l y  i n t e r v en t i on  cou l d  pr ev en t  a  ma jo r  br eakdown .  

QA begins with baseline performance data that is acquired during system installation or after the 
repair or replacement of an x-ray generator-assembly, collimator, detector, Data Acquisition System 
(DAS) or main power circuitry. 

 Compare subsequent QA results against the baseline. 
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Baseline images can be saved for a visual comparison with QA checks, but measurement values 
provide a more objective way to monitor quality. 

There is a single fixed collimator tested as part of the MonoBlock assembly for proper alignment. 

 
Figure 206: Results of QA image after the QA test 

Using Axial plane to determine image resolution 

The method to determine resolution in the Axial plane is to measure the modulation-transfer function of 
the scanner.  A planar section of the MTF wire provides a point, called an impulse.  The impulse is 
blurred by the imaging system, and the measurement of the blur quantifies the resolution.  The blur is 
quantified by the MTF amplitude, which provides a measure of gain for a given object size in line pairs 
per centimeter (lp/cm). 

The MTF is measured in two directions, called radial and tangential directions.  The radial direction is 
along the line that joins the wire to the scanner isocenter.  The tangential direction is perpendicular to 
the radial direction.  The MTF along each direction produces a curve.  The points at which each curve’s 
amplitude is 50% and 10% of its amplitude at zero lp/cm are reported. 

The expected results are given below. 

Table 22: Modulation Transfer Function direction 

D i r e c t i on  50% 10% 

Radial 4.7 7.2 

Tangential 4.7 7.2 
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Using slice width 

The method for determining the slice width for the Axial mode QA is to take an image of the inclined 
wire.  The scanned section of the inclined wire is a line segment.  The scanner blurs a scanned object in 
the Axial plane as well as in the direction perpendicular to it.  The image of the inclined wire includes 
both the Axial plane blurring (MTF) of the scanner as well as the blurring in the z-direction.  The slice 
width is determined by removing the component of in-plane blurring, by measuring the length of the 
wire segment and by using the known angle of wire inclination. 

Table 23: Slice width 

 CereTom E l i t e  

Slice width 10.0 ±1mm 

Measuring noise 

Noise is measured as the standard deviation of pixel values in a 1cm Region of Interest (ROI) at the 
center of the phantom.  The ROI selection is automatic.  The CTDI100 center dose in a standard CTDI 
head phantom is 145 mGy for this scanning technique.  The CereTom Elite noise is measured in a 10mm 
slice. 

Table 24: Noise 

 CereTom E l i t e  

Noise 2.3 ±0.4 

Measuring low contrast 

Low-contrast resolution is measured as the difference between the mean CT values in each half of the 
low-contrast insert.  An ROI is automatically selected around the low-contrast phantom and is 
automatically segmented into halves.  Within each ROI, the mean pixel value is computed.  The two 
mean values are subtracted. 

The expected difference in the mean values is given in the electronic report.  The low contrast should be: 
5.0 ±1.0 HU. 

Finding uniformity 

A ROI is automatically selected in each of five locations in the phantom.  One ROI is at the center.  Four 
outer ROIs are 60 to 70mm from the center of the phantom and spaced 90 degrees apart.  A mean value 
is calculated in each ROI.  The maximum difference between the means is calculated.  The maximum 
allowable difference between the means is 3 HU. 
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Separate, independent measurements of the CT numbers of Air, Teflon, and Acrylic (see “Identifying CT 
contrast scale” on page 201 below) ensure that the overall CT number-scaling of the system is in order.  
If the uniformity portion of the QA protocol passes (maximum difference less than or equal to 3 HU), 
but the mean values of the five ROIs are all uniformly high or low in CT number, it is expected that the 
tests for air, Teflon, and/or acrylic will fail. 

Identifying CT contrast scale 

Contrast scale represents the attenuation scaling of the scanner.  The mean CT numbers of each of the 
sensitometry objects is calculated and reported. 

Table 25: Values of the CT numbers 

 Typ i ca l  Range  

Air -1000 -1010 to -970 

Teflon 974 944 to 984 

Acrylic 111 80 to 120 

Using performance phantoms 

The phantoms (in the following sections) were used for measurement of dose and imaging performance. 

Measuring dose 

The dose is measured using the standard CTDI head phantom. 

Identifying load factors 

Table 26: Load factors 

kV Cur r en t  
(mA)  

T ime  
( s e c s )  mAs  

Dose  
exposu re  
(Rad )  

Dose  
exposu re  
(mGy)  

Numbe r  o f  
s can s  t o  
a ch i eve  1Gy  

 Ax i a l  

100 

3 

1 

3 0.55 5.45 183.49 

4 4 0.75 7.3 136.99 

5 5 0.9 9.1 109.89 

6 6 1.1 10.95 91.32 

7 7 1.3 12.75 78.43 

3 
2 

6 1.1 10.9 91.74 

4 8 1.5 14.6 68.49 
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kV Cur r en t  
(mA)  

T ime  
( s e c s )  mAs  

Dose  
exposu re  
(Rad )  

Dose  
exposu re  
(mGy)  

Numbe r  o f  
s can s  t o  
a ch i eve  1Gy  

5 10 1.8 18.2 54.95 

6 12 2.2 21.9 45.66 

7 14 2.6 25.5 39.22 

3 

4 

12 2.9 21.9 45.66 

4 16 2.9 29.2 34.25 

5 20 3.6 36.4 27.47 

6 24 4.4 43.7 22.88 

7 28 5.1 51 19.61 

3 

6 

18 3.3 32.8 30.49 

4 24 4.4 43.7 22.88 

5 30 5.5 54.7 18.28 

6 36 6.6 65.6 15.24 

7 42 7.7 76.5 13.07 

120 

1 

1 

1 0.9 2.95 338.98 

2 2 0.6 5.85 170.94 

3 3 0.9 8.8 113.64 

4 4 1.15 11.7 85.47 

5 5 1.45 14.65 68.26 

6 6 1.75 17.6 56.82 

7 7 2.05 20.5 48.78 

1 

2 

2 0.6 5.9 169.49 

2 4 1.2 11.7 85.47 

3 6 1.8 17.6 56.82 

4 8 2.3 23.4 42.74 

5 10 2.9 29.3 34.13 

6 12 3.5 35.2 28.41 

7 14 4.1 41 24.39 

1 

4 

4 1.2 11.7 85.47 

2 8 2.3 23.4 42.74 

3 12 3.5 35.2 28.41 
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kV Cur r en t  
(mA)  

T ime  
( s e c s )  mAs  

Dose  
exposu re  
(Rad )  

Dose  
exposu re  
(mGy)  

Numbe r  o f  
s can s  t o  
a ch i eve  1Gy  

4 16 4.7 46.9 21.32 

5 20 5.9 58.6 17.06 

6 24 7 70.3 14.22 

7 28 8.2 82 12.20 

1 

6 

6 1.8 17.6 56.82 

2 12 3.5 35.2 28.41 

3 18 5.3 52.7 18.98 

4 24 7 7.03 142.25 

5 30 8.8 87.9 11.38 

6 36 10.5 105.5 9.48 

7 42 12.3 123.1 8.12 

140 

1 

1 

1 0.4 4.15 240.96 

2 2 0.85 8.35 119.76 

3 3 1.25 12.5 80.00 

4 4 1.65 16.7 59.88 

5 5 2.1 20.85 47.96 

6 6 2.5 25 40.00 

7 7 2.9 29.2 34.25 

1 

2 

2 0.8 8.3 120.48 

2 4 1.7 16.7 59.88 

3 6 2.5 25 40.00 

4 8 3.3 33.4 29.94 

5 10 4.2 41.7 23.98 

6 12 5 50 20.00 

7 14 5.8 58.4 17.12 

1 

4 

4 1.7 16.7 59.88 

2 8 3.3 33.4 29.94 

3 12 5 50 20.00 

4 16 6.7 66.7 14.99 

5 20 803 83.4 11.99 
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kV Cur r en t  
(mA)  

T ime  
( s e c s )  mAs  

Dose  
exposu re  
(Rad )  

Dose  
exposu re  
(mGy)  

Numbe r  o f  
s can s  t o  
a ch i eve  1Gy  

6 24 10 100.1 9.99 

7 28 11.7 116.8 8.56 

1 

6 

6 2.5 25 40.00 

2 12 5 50 20.00 

3 18 7.5 75.1 13.32 

4 24 10 100.1 9.99 

5 30 12.5 125.1 7.99 

6 36 15 150.1 6.66 

7 42 17.5 175.1 5.71 

 He l i c a l  

100 

1 

1 

1 0.2 1.8 555.56 

2 2 0.4 3.6 277.78 

3 3 0.5 5.5 181.82 

4 4 0.7 7.3 136.99 

5 5 0.3 9.1 109.89 

6 6 1.1 10.9 91.74 

7 7 1.3 12.7 78.74 

120 

1 2 0.9 2.9 344.83 

2 4 0.6 5.9 169.49 

3 6 0.9 8.8 113.64 

4 8 1.2 11.7 85.47 

5 10 1.5 14.7 68.03 

6 12 1.8 17.6 56.82 

7 14 2.1 20.5 48.78 

140 

1 4 0.4 4.2 238.10 

2 8 0.8 8.3 120.48 

3 12 1.3 12.5 80.00 

4 16 1.7 16.7 59.88 

5 20 2.1 20.9 47.85 

6 24 2.5 25.0 40.00 
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kV Cur r en t  
(mA)  

T ime  
( s e c s )  mAs  

Dose  
exposu re  
(Rad )  

Dose  
exposu re  
(mGy)  

Numbe r  o f  
s can s  t o  
a ch i eve  1Gy  

7 28 2.9 29.2 34.25 

 CT pe r fu s i on  

100 

1 

 

 

30 

30 5.5 54.6 18.32 

2 60 10.9 109.2 9.16 

3 90 16.4 163.8 6.11 

4 120 21.8 218.4 4.58 

5 150 27.3 273.0 3.66 

6 180 32.8 327.6 3.05 

 Dynamic  (Xenon  p e r fu s i on )  

100 

1 

16 

16 2.9 29.1 34.36 

2 32 5.8 58.2 17.18 

3 48 8.7 87.4 11.44 

4 64 11.6 116.5 8.58 

5 80 14.6 145.6 6.87 

6 96 17.5 174.7 5.72 

7 112 20.4 203.8 4.91 

 
CAUTION  

 

When conducting multiple or repeat scans, ensure that the total exposure does not exceed 
1Gy CTDI. 

No te s  The  Number  o f  s c ans  co l umn in  Tab le  26  deno t e s  t h e  ex ac t  quan t i t y  o f  s can s  
t h a t  r e su l t  i n  r ea ch ing  1Gy .   Be  su r e  t o  round  th e  v a l ue  down t o  i t s  who l e  
number  i f  t h i s  co l umn i s  r e f e r enc ed  f o r  any  r e spe c t i v e  r ea s on .  

 The  h i ghe s t  x - r ay  t u be  vo l t ag e  i s  1 40kV and  th e  h i ghe s t  x - r ay  t ube  cu r r en t  
s e l e c t i on  a t  t h i s  vo l t ag e  i s  7m A.  

 The  h i ghe s t  x - r ay  t u be  cu r r en t  i s  7mA and  th e  h i ghe s t  x - r a y  t ube  vo l t ag e  
se l e c t i on  a t  t h i s  cu r r en t  i s  1 40kV.  

 The  nomina l  x - r ay  ou t pu t  power  i s  0 . 8 4kW when  ope ra t in g  a t  an  x - r ay  t ube  
vo l t ag e  o f  1 20kV and  x - r ay  cu r r en t  o f  7mA fo r  4  s e cond s .  

 The  x - r ay  t ube  vo l t ag e / cu r r en t  t o l e r ance  i s  ± 10%.  

  The  nomina l  x - r ay  t ube  vo l t a g e  i s  1 40kV w i th  100 c fm min imum coo l ing  f l ow .  
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The CereTom Elite dose information (21 CFR 
1020.33 c) 

For a technique of 7.0 mA, 1 second and 120 kV the expected CTDI100 center dose is 16.6 mGy.  The 
CTDI100 surface dose is 21.8 mGy.  The weighted CTDI100 dose is 20.1 mGy.  For other scanning 
voltages, these CTDI100 values are multiplied by the factors given in the following table. 

Table 27: CereTom Elite CTDI100 values 

CTDI 1 0 0  Cen t e r  (C )  CTDI 1 0 0  Su r f a ce  (S )  CTDIw (W)  

16.6 21.8 20.1 

 

Table 28: Scan voltage weighting factors for dose calculations 

kV CTDI 1 0 0  Cen t e r  (C )  CTDI 1 0 0  Su r f a ce  (S )  CTDIw  (W)  

140 1.45 1.40 1.41 

120 1.0 1.0 1.0 

100 0.63 0.66 0.65 

80 0.33 0.38 0.37 

 

For allowed scanning techniques NeuroLogica uses the following formula. 

 

Where W is the kV relative dose ratio m 
m

 is the x-ray tube current in mA, and 
S

 S is the 

scanning time in seconds.  For Helical scans we report, consider the following: 

 

The dose-length product (DLP) is defined as the product of the CTDIvol multiplied by the scan length. 

DLP = CTDIvol x Scan Coverage 

The CTDIvol is measured in mGy and the DLP is measured in mGy.cm. 
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The CereTom Elite dose in air 

The dose in air for typical head scan of 120 kV, 6 mA, 4 seconds is 101 mGy.  For a maximum technique 
of 7.0 mA, 4 seconds dose in air values are given by the following table. 

Table 29: kV vs. dose in air 

kV Dose  in  a i r  (mGy)  

140 160.78 

120 117.06 

100 79.95 

80 49.63 

Not e  A l l  mea su remen t s  a r e  a v e r ag e s  f rom t en  t r i a l s  and  a l l  mea su rement s  w ere  
w i th in  ±10% o f  t h e  mean .  

Dose linearity with tube voltage and current 

The dose or radiation output of the tube is linear with the tube current.  The exposures are measured at 
two different scan at isocenter with and without a CTDI phantom.  The following table shows the 
exposure in the CTDI head phantom. 

Table 30: Exposure at two different mAs 

120  kV ,  20  se c s ,  h ead  CTDI  Expo sure  a t  i so  (mR)  

4 mA 2.22 

7 mA 3.87 
 

Table 31: Exposure at two different mAs 

120  kV ,  4  s e c s ,  i n  a i r  Expo sure  a t  i so  

6 mA 1.154 

7 mA 1.346 
 

Two linearity factors are computed.  The first is the ratio of the exposure at different scan currents; F= 
Exposure (I1)/Exposure (I2).  The linearity factor is then compared to the current ratio.  The F linearity 
factor should be within 10% of the scan current ration. 

 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 208 of 374 QA measurements 

Table 32: Linearity calculations (mGy) 

 CTDI  head  phan tom Ai r  

E1/E2 1.743 1.1663 

I1/I2 1.75 1.1667 

L1 0.007 0.0004 

Linearity Test (< 0.1) 0.0004 0.00034 

The second linearity factor is computed as described in the IEC 60601-2-44 standard. 

 
Table 33: Linearity calculations in accordance with IEC (mGy) 

 CTDI  head  phan tom Ai r  

E1/I1 0.555 0.1923 

E2/I2 0.553 0.1922 

(E1/I1+E2/I2)/2 0.554 0.19225 

L2 0.002 0.001 

Linearity test (< 0.2) 0.0036 0.0052 

The radiation output is not linear with respect to the scan voltage; however, it is approximately linear 

with respect to scan voltage to the power of 2.3, that is E ∝ kV2.3. 

No t e  Ac tua l  r e su l t s  on  in s t a l l ed  un i t s  c an  va ry  +20% due  t o  mach ine  and  t e s t  
t o l e r ance s .  

QA measurements 

The QA phantom is typically used to monitor the scanner on site; however, the following phantoms can 
be used for measuring the imaging performance of the scanner. 

Identifying high-contrast resolution 

The high-contrast-resolution phantom is a wire placed at the center of a uniform disk.  The wire provides 
an impulse function in the Axial plane when it is placed parallel to the scanner-gantry axis-of-rotation.  
The high-contrast resolution is measured from the Modulation Transfer Function (MTF).  Typical MTF 
curves are shown in the following figures.  Variations of 10% may occur in measurements due to 
phantom placement error and measurement inaccuracies. 
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Figure 207: MTF at isocenter, shown for high resolution 

 

 
Figure 208: MTF at standard kernel 

Noise, uniformity, and mean CT number of water 

One of two phantoms may be used in these tests.  These are Catphan® 412 or a cylindrical 20cm 
diameter water cylinder. 

The CereTom Elite noise 

Noise is measured as the standard deviation at isocenter.  The value is 2.1 ±.2 HU when the imaging 
protocol is 140 kV, 42 mAs and standard kernel.  This protocol gives a CTDI100 center dose of 160 mGy. 

Uniformity and mean CT number 

The mean CT number of air is -1000 HU and that of water is 0 HU.  The tolerance of the mean CT 
number will be ±3 HU.  For mean CT numbers measured at different points of the water phantom, the 
maximum difference in the means will be less than 4 HU. 
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Low-contrast resolution 

The phantom used for low-contrast-resolution measurement is Catphan 412. 

The CereTom Elite low-contrast resolution 

The low-contrast resolution is 3mm at 0.3% contrast when the center CTDI100 dose is 160 mGy.  The 
imaging protocol is 140 kV, 42 mAs, 10mm slice thickness, and the standard reconstruction kernel. 

 

Figure 209: Catphan 515 using 120kV, 7mA, 6 secs, and 5mm slice 

 
Figure 210: Catphan 515 scanned using 140kV, 7mA, 6 secs and 5mm slice 

Geometric efficiency in the Z axis direction 

This is the ratio of the integral of the dose profile integrated over the detector width in Z divided by the 
total CTDI100.  The geometric efficiency is 70%. 
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Figure 211: CereTom Elite dose profile 

Half-value layer 

The half-value layer is the same for both the CereTom Elite. 

 

Table 34: Half-value layer 

S can  vo l t ag e  100 120 140 

Ha l f  v a l ue  4.9 6.0 6.8 

Allowable variations 

The following are allowable variations: 

• Dose A ±5% variation in dose may occur due to variations between systems 
and measurement differences.  The maximum variation is ±10%. 

• High Contrast 
Resolution 

The variation in values on the MTF curve may be ±10%.  These will 
occur mainly due to phantom placement errors, measurement 
inaccuracies and system variations. 

• Noise The variation in standard deviation may be ±10% due to variations 
between systems. 

• Uniformity The maximum difference between ROI means in an image is 4 HU.  
The maximum error in the CT number of water is ±3 HU. 
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Scatter radiation 

 
WARNING  

 

Exposure to secondary radiation can be harmful, and CereTom Elite usage should only be 
done under the direct supervision of the facility’s qualified Radiation Safety Officer (RSO) 
in compliance with site, local, mode, provincial, and national regulations.  Only this RSO 
can perform the calculations necessary to determine what additional safety precautions are 
necessary, such as shielding, personal protections, and so on. 

No t e  The  CereTom E l i t e  s c anner s  a r e  compa t i b l e  w i th  IRR1999  and  EU D i r ec t i v e  
96 /29 /EURATOM.  

US charts – curtains opened 

 
Figure 212: US charts – opened or no curtains chart 

Chart measurements represent the horizontal and vertical plane, with open or no curtains. 

No t e  In  compl i an ce  w i th  IEC  60601 - 2 - 44 :2009 ,  s e c t i on  203 .11 ,  t h e  p r ev i ous  f i gu r e  
shows  th e  s ca t t e r  r a d i a t i on  mea su red  a t  t h e  edge  o f  t h e  g an t ry  in  t h e  
t omograph i c  p l an e  i s  ≅20% o f  t h e  s ca t t e r  r ad i a t i on  mea su r e  a t  t h e  same  
d i s t anc e  a l ong  t h e  ax i s  o f  ro t a t i on  in  t h e  ho r i zon t a l  p l ane .  
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Figure 213: US charts – opened or no curtains data 

Chart measurements represent the horizontal and vertical plane with open or no curtains. 
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US charts – curtains closed 

 
Figure 214: US charts – closed curtains chart and data 

Chart measurements represent the horizontal and vertical plane with completely closed curtains. 
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Figure 215: US charts – closed curtains chart and data 

Chart measurements represent the horizontal and vertical plane with completely closed curtains. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 216 of 374 QA measurements 

European charts – curtains open 

 
Figure 216: European charts – opened or no curtains chart 

Chart measurements represent the horizontal and vertical plane with open or no curtains. 

No t e  In  compl i an ce  w i th  IEC  60601 - 2 - 44 :2009 ,  s e c t i on  203 .11 ,  t h e  p r ev i ous  f i gu r e  
shows  th e  s ca t t e r  r a d i a t i on  mea su red  a t  t h e  edge  o f  t h e  g an t ry  in  t h e  
t omograph i c  p l an e  i s  ≅20% o f  t h e  s ca t t e r  r ad i a t i on  mea su r e  a t  t h e  same  
d i s t anc e  a l ong  t h e  ax i s  o f  ro t a t i on  in  t h e  ho r i zon t a l  p l ane .  
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Figure 217: European charts – opened or no curtains chart and data 

Chart measurements represent the horizontal and vertical plane with open or no curtains. 
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European charts – curtains closed 

 
Figure 218: European charts – closed curtains chart 

Chart measurements represent the horizontal and vertical plane with completely closed curtains. 
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Figure 219: European charts – closed curtains chart and data 

Chart measurements represent the horizontal and vertical plane with completely closed curtains. 

mAs vs. traditional fixed CT scanners 

The CereTom Elite scanners are small-bore scanners designed primarily to scan small anatomy, such as 
the head and neck.  There are significant x-ray geometry and filtration differences that result in a lower x-
ray tube current (milliampere-second, mAs) for equivalent patient dose.  Because the x-ray tube is closer 
to the patient than in the large bore scanners, there is a factor of approximately 6x to 7.5x on mAs.  The 
system x-ray filtration is optimized for smaller anatomy and thus there is a 2x factor.  Combining the 
above factors there is approximately a 12x to 15x factor on mAs for equivalent mAs. 

CTDI measurements 

This section contains a detailed measurement of the CTDI100.  The dose is measured using a typical scan 
of 4 seconds at 7mA.  The following table lists the center and the surface dose for all scan voltages. 
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Table 35: The CTDI100 for different scan voltages 

S can  vo l t ag e  CTDI 1 0 0  c en t e r  CTDI 1 0 0  su r f a ce  CTDI 1 0 0  we i gh t ed  

140 104.62 131.44613 122.5 

120 73.037 94.72125 87.49 

100 45.414 61.61775 56.22 

80 24.303 36.311625 32.31 

The center CTDI100 is measured at the center of the CTDI head phantom.  The surface dose is the 
average of surface doses measured at the four different surface locations of the CTDI head phantom.  The 
following table lists the various measurements of the CTDI100 surface dose. 

Table 36: Surface CTDI100 measurements 

S can  
vo l t ag e  Top  (0 ° )  R igh t  (90 ° )  Bo t t om 

(180 ° )  Le f t  (2 70 ° )  CTDI 1 0 0  
su r f a ce  

140 130.71 134.02 129.93 131.10 131.44 

120 96.87 95.52 92.56 96.92 94.72 

100 61.73 61.59 61.46 61.68 61.61 

80 36.19 36.06 36.80 36.19 36.31 

Additional scatter measurements 

Additional scatter measurement along the perpendicular plan were also taken using the CTDI head 
phantom with the back curtain closed and the front curtains partially closed to simulate a real scan; 
however, it should be noted that the scatter measured with the CTDI phantom only is typically higher 
than the actual scatter radiation from a real patient.  Due to the scanner height, the measurements were 
done at the positions noted in the next figure, which shows how to set up the system for scatter 
measurements. 

The scatter measurements were done using the RadCal survey meter and the 1800cc probe. 

 
Figure 220: System setup for scatter measurements 

The scatter was measured using the following scan protocol: 140 kV, 7 mA, 10 seconds.  The following 
table lists the measured scatter per seconds in the back of the scanner. 
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Table 37: Scatter in vertical parallel to axis of rotation (µRem/s) 

 
D i s t ance  f r om i so .  ( cm)  

75cm 125cm 175cm 

50cm below iso 16.8519 7.1688 4.06725 

At iso 19.20525 8.61735 4.52835 

50cm above iso 10.94025 6.6729 3.9759 

75cm above iso 2.36205 4.6719 3.64095 

 

Table 38: Scatter in vertical plane on patient side (mRem/s) 

 
D i s t ance  f r om i so .  ( cm)  

75 cm 125 cm 175 cm 

At iso 0.428 0.155 0.075 

50cm above iso 0.375 0.149 0.069 

75cm above iso 0.274 0.140 0.070 

Not e  By  de s i gn ,  t h i s  s canner ’ s  f r ame  (a bou t  t h e  bo r e )  p rov id e s  t h e  p r imary  
sh i e l d ing  in  t h e  v e r t i c a l  p l ane  pe r pend i cu l a r  t o  t h e  ax i s  o f  ro t a t i on ,  t h e r e f o r e  
s ca t t e r  r ad i a t i on  i s  neg l i g i b l e  i n  t h i s  p l ane .  
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Chapter 8     Patient Registration 
Patient Registration is the first step in the patient scan process. 

You can register a patient in the following ways: 

• Manually register a (new) patient for examination from the Patient Registration tab. 
• Perform a query to acquire already-entered patient data from the hospital (Hospital Information  

System (HIS)) or radiology system (Radiology Information System (RIS)). 
• Register an emergency patient using the touch screen. 

It is assumed that the workstation is connected to the site’s information system, HIS/RIS.  If you are not 
connected, you can always manually register the patient. 

 
Figure 221: Active Patient Registration tab 

Navigating the Patient Registration screen 

Make sure the Patient Registration tab is selected; click it if necessary. 

Notice the buttons at the bottom-of the Patient Registration dialog box.  Many of these buttons are active 
only if you are already connected to the site’s HIS/RIS or if you clicked the Query button (to query for 
patients and the list of patients populated in the Query Results list).  When a patient is selected, the 
buttons are active. 

Table 39: Patient Registration buttons 

Pa t i en t  Reg i s t r a t i on  
bu t t on  Ac t i on  

 

Searches the HIS/RIS server for scheduled patients.  The population of 
patients could take several minutes to appear, depending on the number 
of patient entries the query populated (after you clicked the Query 
button). 

 
Cancels the current query.  Entries retrieved prior to cancellation appear 
in the Query Results list and (if the user moves them) to Stored Results. 

 
Registers the selected patient and then takes you to the Acquisition tab 
to acquire the data for an examination (scan). 
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Pa t i en t  Reg i s t r a t i on  
bu t t on  Ac t i on  

 
Shows selected patient details. 

 
Searches queried patient entries for specific information. 

 

Selects patient(s) from query results and moves them into Stored Results 
list. 

 
Deletes patient(s) (and accompanying data) from the Stored Results list. 

 
Manually enters a new patient and, when completed, takes you to the 
Acquisition tab to acquire the data for an examination (scan). 

Registering the patient 

The following procedures show you how to enter patient information into the system before scanning the 
patient. 

Querying patient information 

 If necessary, click the Patient Registration tab on the main screen. 

 
Figure 222: Patient Registration tab 

 Click the Query button at the bottom of the screen. 

The Query Information dialog box appears. 
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Figure 223: Query Information dialog box 

 Click the HIS/RIS Server dropdown and select the worksite to pull data from. 

The default worksite appears at the top.  If there is no list, see your site administrator to set it up. 

 Double-click any of the named Query Fields you would like to use to query for patients by entering 
the value in the Value column to query. 

A popup associated with the Query Field you are setting a value for appears.  For example, if you 
double-click the Scheduled Start Date value row, the Edit Value popup appears.  Enter the (new) 
date for the start.  Another example would be to click the Patient Name value row.  Again the Edit 
Value popup appears; however, this time Patient Name text boxes are provided to help you narrow 
down a search for patient data using a first and/or last names, and so on.  Click any of the Value 
rows to fill in data to help query the patient you are searching.  You can enter as much or as little 
information as needed.  If no information is available, leave the value blank. 

 
Figure 224: Edit Value popup for Name 

 Perform one of the following: 

• Click the Update button to query based on the newly entered data to help narrow down your 
search. 
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• Click the Close button to remove any changes and return to the previous Query Information 
popup. 

 When you are finished filling in query selections, perform one of the following: 

• Click the Query button to populate your new query criteria. 

• Click the Save Query button to save the query values you will use in your query request. 

• Click the Reset button to change the query back to the former query. 

• Click the Cancel button to remove the changes you made. 

A list of patients matching your selected criteria variables populates in the Query Results list on the 
Patient Registration tab. 

 
Figure 225: Patient Registration Query Results table 

 Select a patient and click the Register button to register the patient for the exam. 

The system enables and opens the Acquisition tab.  To perform the acquisition steps, see “Scanning 
from the workstation” on page 237. 

Storing patients in the Stored Results l ist 

This list is helpful when multiple patients need to be scanned and connection to a worksite like HIS/RIS 
is unavailable at the exam location. 

 If necessary go to the Patient Registration tab to query the patients(s). 

 Perform steps 2 through 5 in “Querying patient information” on page 223. 

 Quick the Query button. 

Let the criteria you selected populate into the Query Results list area. 

 Highlight (select) one or more patient entries from the Query Results list. 

Select patients in the following ways: 

• To select one patient, click anywhere in the patient’s row. 
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• To select more than one patient at a time, press and hold the Ctrl key (on the workstation 
keypad) and click any patients until finished and then release the Ctrl key. 

• To click all the patients, press and hold the Shift key (on the workstation keypad) and click 
the first patient in the list and then click the last patient to highlight all patients between the 
first patient selected and the last. 

 Click the Store button. 

The patients and subsequent patient information you selected appear in the Stored Results list at the 
bottom of Patient Registration. 

 
Figure 226: Patient Registration Stored Results table 

 Click the patient(s) you want to select from the Stored Results table. 

 Click the Register button to register the stored procedure in order to perform an examination. 

The system enables and opens the Acquisition tab.  To perform the acquisition steps, see “Scanning from 
the workstation” on page 237. 

Manually registering a patient 

You manually register a patient for examination when the HIS/RIS server is unavailable, the patient 
cannot be found, and/or was never entered into the system. 

 If necessary go to the Patient Registration tab. 
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Figure 227: Patient Registration tab 

 Click the Manual button at the bottom of Patient Registration. 

The Exam Information dialog box appears with the Patient tab open. 

 
Figure 228: Exam Information dialog box 

 For Patient Name, double-click the Patient Name value. 

The Edit Value dialog box appears with patient name fields. 

 Enter patient name information in the fields provided and click one of the following buttons: 

• Click the Update button to save your entries and close the Edit Value dialog box. 

• Click the Close button to close the Edit Value dialog box without saving your work. 

Notice that the value appears with the last name first, separated by ^, the first name next, 
separated by ^, the middle name (if you supplied that information), and any other 
information you entered. 

No t e  The  P a t i en t  ID  i s  au t oma t i c a l l y  g ene ra t ed  by  t h e  sy s t em ;  you  can  
r ep l a c e  t h i s  au t oma t ed  i d en t i f i e r  w i t h  your  pa t i en t ’ s  ho sp i t a l  ID  
number .  
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Figure 229: Patient ID field 

 For the Patient Date of Birth, perform the following: 

• Double-click the Patient Date of Birth field. 

• Enter the patient’s birth date in the Patient date of birth field. 

Be sure to move the cursor to the far left to make sure two digits are included for the month 
and the day; four digits are required for the year. 

• Perform one of the following: 

• Click the Update button to save your work and close the Edit Value dialog box. 
• Click the Close button to close the Edit Value dialog box without saving your work. 

 For the Patient’s Sex, perform the following: 

• Double-click the Patient’s Sex field. 

• Enter the patient sex in the field by entering the appropriate letter to apply for one of the 
following: 

• F  for Female 
• M  for Male 

• O Other 

• Perform one of the following: 

• Click the Update button to save your work and close the Edit Value dialog box. 

• Click the Close button to close the Edit Value dialog box without saving your work. 

 Perform one of the following: 

• Click the Register button to register your patient data. 

• Click the Cancel button to exit without entering your data. 

When you click the Register button, the system enables and opens the Acquisition tab.  To perform 
the acquisition steps. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 8    Patient Registration  Page 229 of 374  

 

 
Figure 230: Patient data filled in 

 After your patient is registered, view the Patient Exam Details to ensure your data is correct. 

If it is not correct, go to the next step to make the necessary changes. 

 Click the Expand link. 

 
Figure 231: Expand link in context and close up 

The Exam Information popup appears. 

 Make your changes in the Exam Information popup. 

 Click the Update button to save changes. 

Registering an emergency patient from the touch screen 

This allows you (the operator) to register an emergency patient (quickly) if that patient is not already in 
the system. 

No t e  I f  Do se  Check  i s  enab l ed  on  t h e  work s t a t i on  you  w i l l  no t  b e  ab l e  t o  r eg i s t e r  
an  emergen cy  pa t i en t  a t  t h e  t ouch  s c r e en .  

 Go to the touch screen on the scanner. 

 Click the Options tab. 

 Click the Emergency Patient button. 

 Review the Patient Information section on the touch screen. 

 
Figure 232: Show emergency patient and ID in section on touch screen 

The Acquisition tab will automatically appear (on the workstation). 
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You can add additional information or changes to the patient information by clicking the Expand 
link (on the workstation). 

 
Figure 233: Expand link location 

 Click the Expand link. 

 
Figure 234: Expand link next to Patient Exam Details 

The Exam Information popup appears. 

 Make your changes in the Exam Information popup. 

 Click the Update button to save the changes. 

Viewing patient information 

This procedure lets you view (but not change) the patient information. 

 If necessary, click the Patient Registration tab on the main screen. 

 
Figure 235: Patient Registration tab 

 Select a patient from the Query Results list or the Stored Results list. 
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 Click the View button. 

 Review the patient’s information. 

This popup presents static information that you cannot change. 

 Click the Close button to exit the View Entry Information popup. 

Storing queried patients to the Stored Results l ist 

 If necessary, click the Patient Registration tab on the main screen. 

 
Figure 236: Patient Registration tab 

 Perform a query to find patients. 

See “Querying patient information” on page 223 to learn how. 

 Select the patient(s) that you want to store from the Query Results list. 

Select patients in the following ways: 

• To select one patient, click anywhere in the patient’s row. 

• To select more than one patient at a time, press and hold the Ctrl key (on the workstation 
keypad) and click any patients until finished and then release the Ctrl key. 

• To click all the patients, press and hold the Shift key (on the workstation keypad) and click 
the first patient in the list and then click the last patient to highlight all patients between the 
first patient selected and the last.  The Store button will be activated. 
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Figure 237: Store button active 

 Click the Store button. 

The patients you selected in step 2 appear in the Stored Results list and remain there unless you 
delete the patient(s). 

No t e  I f  you  have  a l r eady  s t o r ed  a  p a t i en t  and  you  c l i ck  on  th e  same  pa t i en t  i n  
t h e  Query  Resu l t s  l i s t ,  t h a t  pa t i en t  appea r s  i n  t h e  S t o r ed  Re su l t s  l i s t  
tw i ce .  

Deleting patient(s) from a Stored Result list 

You cannot delete patients from the Query Results list; you can only delete patients from the Stored 
Results list. 

 If necessary go to the Patient Registration tab. 

 
Figure 238: Patient Registration tab 

 Click (highlight) one or more patients from the Stored Results list to delete. 

Select patients in the following ways: 

• To select one patient, click anywhere in the patient’s row. 
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• To select more than one patient at a time, press and hold the Ctrl key (on the workstation 
keypad) and click any patients until finished and then release the Ctrl key. 

• To click all the patients, press and hold the Shift key (on the workstation keypad) and click 
the first patient in the list and then click the last patient to highlight all patients between the 
first patient selected and the last. 

 Click the Delete button. 

The patients you selected are removed from Stored Results list.
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Chapter 9     Patient Scanning 
After you register the patient, the Acquisition tab is enabled and automatically opens.  The Acquisition 
tab lets you check that the selected patient information is accurate before you perform the examination 
(scan).  The Acquisition tab is also where you can set protocols for the scan before you scan the patient.  
A protocol lets you assess how you will capture the image you scan during the patient examination. 

 
Figure 239: Active Acquisition tab 

No t e  NeuroLog i ca  r e commends  t h a t  an  a i r  c a l i b r a t i on  i s  pe r f o rmed  eve ry  6 - 8  hour s .   
I f  t h e  a i r  f r e shne s s  f a l l s  b e l ow  50% or  t h e  s canner  i s  moved  t o  an  a r ea  w i th  a  
d r ama t i c  change  in  humid i t y  o r  t empera tu r e ,  pe r f o rm ano t he r  a i r  c a l i b r a t i on  
t o  en su r e  op t imum image  qua l i t y  du r ing  pa t i en t  s cann ing .   S ee  “Pe r fo rming a  
da i l y  ( a i r )  c a l ib ra t ion  f rom the  LCD touch  s c reen”  on  p age  190  t o  l e a rn  
more .  

 I f  r oom- t empera tu r e  f l u c tua t i ons  h ave  o ccu r r ed ,  you  may  n eed  t o  pe r f o rm 
more  t h an  one  a i r  c a l i b r a t i on s .   In  add i t i on ,  s canner s  c an  d r i f t  ou t  o f  
a l i gnment ;  make  su r e  you  pe r f o rm a  Qua l i t y  Te s t  w i th  t h e  t e s t  phan tom be fo r e  
s cann ing  a  pa t i en t .  

After the protocol is selected, you can scan the patient.  You can scan the patient in two ways: initiate the 
scan using the workstation or scan directly from the touch screen.  See the benefits of each in “Scanning 
from the workstation” on page 237 and “Scanning from the touch screen” on page 245. 

The following figure and table that follow give you introductory information on what the Acquisition tab 
presents:  the buttons and what they are used for.  Later you will learn how to set protocols to determine 
more specificity for the scan. 

 
CAUTION When conducting multiple or repeat scans, make sure the total exposure does not exceed 

maximum limit of 1Gy. 

Table 40: Acquisition buttons 

Acqu i s i t i on  bu t t on  Ac t i on  

 
Selects an existing protocol for the current study. 

 
Authorizes the scanner to move to the next step (if applicable). 
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Acqu i s i t i on  bu t t on  Ac t i on  

 

Begins any post-reconstructions that were defined during the protocol 
setup. 

 

Appears during Bolus Tracking protocol, only to identify bolus tracking 
settings. 

 
Repeats the last scan that was performed. 

 
Cancels the current scan within a protocol. 

 
Cancels the entire protocol exam. 

 
Completes the examination. 

Identifying protocol types 

Protocol types identify how to capture an image during a scan.  The following are protocol types you can 
select from. 

Axial 

This protocol type lets you scan in Transverse plane.  Data is acquired as the x-ray tube rotates around 
the patient.  It is also referred to as step and shoot. 

Helical 

This protocol lets you acquire data continuously as the x-ray tube rotates around the patient; the scanner 
translates over the patient in the Z axis. 

Helical scan coverage 

Helical scan coverage is typically truncated by 1.25cm to cover a half rotation at each end.  Figure 240 
shows the exposure using a radiographic film.  The film shows exposure of the Helical scan-type coverage 
of 60mm.  X-ray was on for 60mm.  It took the scanner one extra second to completely stop after x-rays 
turned off (see Figure 240); also shows exposure length to be 60mm. 
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Figure 240: Radiographic film of the ~60mm scan coverage 

The number of 1.25mm slices generated is 49, which covers about ~60mm.  The scanner parallel images 
start at the laser location and ends where the scan ends.  Figure 241 shows the scan markers as described 
above.  For a typical Helical scan with 23cm coverage, excess dose is 5.4% of scan dose. 

 
Figure 241: Scan coverage and imaged region for a true coverage of 60mm 

Dynamic 

This protocol lets you acquire image data at multiple time points over the same anatomic location while 
the scanner remains stationary; x-ray exposure can be continuous or intermittent. 

Reference 

This protocol lets you acquire a single 10mm slice to review anatomical position or place the Region of 
Interest (ROI) for Bolus Tracking scans.  Reference scanning can only be used in conjunction with 
Helical / Dynamic scanning during a CTA protocol or perfusion. 

CT Perfusion 

This protocol gives you a quantitative collection of dynamic Axial data during an arterial and venous 
phase injection. 

Scout 

This protocol lets you acquire data continuously as the x-ray tube remains stationary at a designated 
angle; the scanner translates over the patient in the Z axis.  The resulting 2D projection is used during 
examination planning. 
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Scanning from the workstation 

It is assumed you have registered the patient to scan.  You cannot complete this procedure without a 
registered patient.  It is also assumed the Acquisition tab is active and the scanner is connected. 

No t e  I f  t h e  s can  ne ed s  t o  be  s t opped  pe r f o rm th e  f o l l ow ing :  

 For  an  immed ia te  o r  h ard  s top ,  p r e s s  t h e  E -STOP bu t t on .   Th i s  s t op s  x - r ay ,  
c en t i p ede  mov ement ,  and  g an t ry  ro t a t i on  immed i a t e l y .  

 For  a  con tro l l ed  s top ,  pre s s  t h e  Canc e l  S can  bu t t on .  

 From the workstation, go to the Patient Registration tab to assign the patient to the scan in one of 
the following ways: 

• Query an already existing patient from the HIS/RIS. 

• Manually register the patient. 

See “Chapter 8    Patient Registration” on page 222. 

The Acquisition tab will be activated when the patient is registered. 

 From the Acquisition tab, click the Protocol button to open the Exam Planner dialog box. 

 Click the appropriate option: 
• Adult To scan adult patients.  Set adult protocols are stored by anatomical area, here. 

• Pediatric To scan pediatric patients.  Set pediatric protocols are stored by anatomical area, 
here. 

• Trauma 
To scan emergency patients (adult or pediatric).  Set trauma (emergency) 
protocols are stored to .  The Trauma orb (  ) lists those trauma protocols 
previously copied, pasted, and saved for a quick access to commonly used 
emergency or trauma protocols. 

 
By selecting either an Adult or Pediatric patient, the corresponding list of saved 
protocols becomes available. 

No t e  Adu l t  and  ped i a t r i c  p ro t oco l  pa r amet e r s  a r e  cu s t omized  t o  mee t  your  
r equ i r emen t s  i n  con junc t i on  w i th  l o ca l  and  na t i ona l l y  r e co gn i zed  
pub l i sh ed  gu id e l i ne s .   Thes e  p ro t oco l s  m us t  be  approved  by  your  f a c i l i t y  
phy s i c i s t  b e f o r e  th e  sy s t em ’ s  a c cep t anc e .  
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Figure 242: Exam Planner for Adult and Pediatric 

 Click the colored orb corresponding to the appropriate body part you will scan. 

  
Figure 243: Anatomical orbs, in this case the head orb for Adult and Pediatric 

 Click the appropriate protocol from the list. 

 Click the Edit button to review the selected protocol. 

 
Figure 244: Protocol selected and Edit button active 

The Edit Protocol dialog box appears. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 9    Patient Scanning  Page 239 of 374  

 

 

Figure 245: Edit Protocol dialog box 

The Protocol Information and Protocol’s Series areas show those protocols already created.  The 
Patient Position appears identical whether it is for an adult, pediatric, or trauma patient. 

No t e  You  can  mod i f y  a  p ro t oco l ;  howeve r ,  ch ange s  you  make  f rom Acqu i s i t i on  
w i l l  no t  be  sav ed  pe rmanen t l y .   Pe rmanen t  change s  t o  p ro t oco l s  c an  on l y  
be  made  by  t h e  admin i s t r a t o r  i n  Pro t oco l  Manage r .  

 You  can  mod i f y  p ro t oco l  p a r amet e r s  such  a s ,  kV ,  mA ,  and  scan  l e ng th  a t  
t h e  t ime  o f  t h e  s can ,  bu t  t h e  mod i f i c a t i on s  w i l l  no t  be  s aved .  

 To edit an existing protocol, perform the following: 

• In the Edit Protocol dialog box, go to the Protocol’s Series list box and select a protocol 
series. 

• To edit an existing protocol, click the Edit button. 

The Edit Series dialog box appears. 
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Figure 246: Edit Series dialog box 

• Click the Add button in the Recons section of the Edit Series dialog box. 

The New Reconstruction dialog box appears. 

• Enter a description and any other appropriate changes for your protocol. 

• Click the Add button. 

• Click the Update button in the Edit Series dialog box. 

• Alternatively, click the Reset button to remove any changes. 

• Alternatively, click the Cancel button to return to the previous dialog box. 

 Click the Update button on the Edit Protocol dialog box. 

 
Figure 247: Update button 

 Set up the patient and scanner. 
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See “Positioning the patient” on page 85. 

 Make sure the scanner is in Scan mode. 

 
Figure 248: Scan mode 

 On the touch screen, press  (Laser On button) to turn on the laser. 

 Move scanner and align patient as needed. 

See “Positioning the scanner before a scan” on page 82. 

 Press  (Zero Ref button) on the touch screen to zero the scanner. 

 Click the Begin button (on the workstation) from the Exam Planner dialog box. 

The system state orb will change color from (preparing the protocol to the system) to 
(ready to scan).  The System Ready to Scan popup appears. 

 
Figure 249: System Ready to Scan popup 

 Press Start Scan from the touch screen to acquire your scout(s) and/or scan. 

The Start Scan screen appears. 
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Figure 250: Starting Scan 

Not e  I f  a  s e cond  s cou t  i s  d e f ined  i n  your  p ro t o co l ,  p r e s s  t h e  ( s t a r t )  S can  bu t t on  
when  r eady .  

 If applicable, set your parameters and Field Of View (FOV) on your scouts. 

No t e  FOV can  on l y  be  ad ju s t ed  wh en  two  scou t s  a r e  a c qu i r e d .  

 
Figure 251: Scouts and FOV button 

Scout parameters can be modified by selecting the drag boxes and adjusting the lines, and can be 
centered by clicking on the small green circle and dragging it. 

No t e   Dur ing  t h e  s can ,  ob se rve  t h e  f o l l ow ing :  

 A  y e l l ow  l i gh t  on  t op  o f  t h e  s canne r ,  i nd i ca t e s  x - r ay s  a r e  em i t t ed ;  an  
aud ib l e  beep  i den t i f i e s  t h a t  r ad i a t i on  i s  be ing  em i t t ed .  

 The  s cann er  move s  s l ow l y  away  f rom the  pa t i en t .  

 The  pa t i e n t ’ s  s can  r e su l t s  a ppea r ;  ~  one  image  pe r  s e cond .  
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 Click the Continue button (on the workstation) to acquire the scan. 

The Pending Scanning Movement popup appears. 

 
Figure 252: Pending Scanner Movement popup message 

 Click the Continue button to scan. 

• Click the Cancel button to cancel the scan. 

• If you clicked the Continue button, the Positioning Scanner popup appears. 

 
Figure 253: Positioning Scanner popup message – Wait for scanner to move to position 

The System Ready to Scan popup appears. 

 
Figure 254: System Ready to Scan popup message – System is ready to begin scan 

 Go to the scanner and press the Scan button to initiate the scan. 

The Perform Reconstructions popup appears. 
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Figure 255: Perform Reconstructions popup message – To perform post reconstructions 

 Perform one of the following: 

• Click the Yes button to perform post reconstructions now. 

• Click the No button to manually perform a post reconstruction at a later time. 

• If you click the No button, the Perform Reconstructions popup appears. 

 
Figure 256: Perform Reconstructions popup message – To perform post reconstructions 

• If you have reconstructions attached to your protocol, click the Start Recons button. 

 Use the Viewing tools to review the scan. 

See “Examining the scanned image with tools” on page 264. 

 Click the Finalize button when finished. 

The dose report (if enabled in System Configuration) appears. 
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Figure 257: Dose report 

 Make sure that the patient information that was in the Patient Information fields, is removed. 

When the scanned exam is completed, Exam Details will be saved. 

Scanning from the touch screen 

Keep the following in mind before performing a scan, using the touch screen: 

• Scouts or AEC protocols cannot be uploaded to the scanner. 
• Protocols must be uploaded to the touch screen to scan from the touch screen. 
• Scanning from the touch screen is not possible if Dose Check is enabled. 

See “Setting Dose Check” on page 136 to learn how the administrator enables Dose Check. 

No t e  I f  t h e  s can  ne ed s  t o  be  s t opped  pe r f o rm th e  f o l l ow ing :  

 For  an  immed ia te  o r  h ard  s top ,  p r e s s  t h e  E -STOP bu t t on .   Th i s  s t op s  x - r ay ,  
c en t i p ede  mov ement ,  and  g an t ry  ro t a t i on  immed i a t e l y .  

 For  a  con tro l l ed  s top ,  pre s s  t h e  Canc e l  S can  bu t t on .  

 From the workstation, go to the Patient Registration tab and perform one of the following methods 
to assign the patient to the scan: 

• Query an already existing patient. 

• Manually register the patient. 

See “Manually registering a patient” on page 226. 
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 Go to the touch screen. 

  
Figure 258: touch screen showing patient’s information 

 Set up patient and scanner. 

See “Positioning the patient” on page 85. 

 Make sure the scanner is in Scan mode. 

 

 
Figure 259: Scan mode 

See “Moving the scanner for manual transport” on page 81. 

 On the touch screen, press  (Laser On button) to turn on the laser. 

 Move scanner and align patient as needed. 

See “Moving the scanner for manual transport” on page 81; “Positioning the scanner before a scan” 
on page 82, and/or “Positioning the patient” on page 85. 

 Press  (Zero Ref button) on the touch screen to zero the scanner. 

 

 
CAUTION Always check patient information on the Main tab in the Patient Information box to 

ensure patient data is accurate with patient. 
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 Press Select Protocol (the Main tab) when ready to set up a scan protocol. 

The Protocol Screen opens.  You can modify this list using the workstation to upload custom 
protocols.  See “System and User Configuration and Setup” on page 107 for further explanation of 
how to perform an upload (if you have administrative access). 

 
Figure 260: Protocol screen 

 Determine the type of scan required and then press the Scan Protocol button. 

 Select the protocol. 

 Press the Accept Protocol button. 

The Patient Orientation screen appears. 

 
Figure 261: Patient Orientation screen 

 Select the patient orientation; verify the selection and then press the Confirm Orientation button to 
proceed. 

The scan settings screen opens. 
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Figure 262: Prepare screen 

The Scan settings displays the information found in the following table. 

Table 41: Prepare screen information 

S can  s e t t i ng s  s c r een  Comment s  

Scan Protocol selected Scan type displays 

kV Kilovolts 

mA Milliamperes 

mAs Milliamperes-seconds 

Slice thickness Tomographic slice thickness 

Coverage Length of scan time 

Orientation Patient’s orientation 

# of images Approximate number of scanned images to be generated in 
Helical scanning 

Time of Scan Length of scan 

CTDIw Dose Weighted Average Computed Tomography Dose Index 

CTDIvol Dose CTDIw averaged along the Z axis 

# of recons Number of reconstructions 

Sharpness Kernel applied to images 

No t e  Pa ramet e r s  c a nno t  be  changed ,  on l y  a cc ep t e d .  

 If parameters are as expected and correct, press the  (Prepare) button. 

The Start Scan screen appears. 
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Figure 263: Start Scan screen 

 Remind the patient to remain still and to keep eyes closed. 

 Press the Scan button to initiate the scan. 

The Timer counts down to zero and then the scan begins. 

No t e  C l i ck  t h e  Can ce l  S can  bu t t on ,  a t  any  t ime ,  t o  end  th e  s can  and  r e t u rn  t o  
t h e  Ma i n  t ab .  

 The  s can  de l ay  i s  s e t  on  th e  Opt ions  t ab .  

 I f  s c an  d e l ay  i s  s e t  t o  z e ro ,  t h e  coun t e r  w i l l  no t  be  d i s p l ay ed  and  th e  s can  
w i l l  beg in  immed i a t e l y .   Th er e  w i l l  be  no  t imer  g r aph i c  d i s p l ay ed .  

 
Figure 264: Scan screen 

The touch screen displays the images while simultaneously transmitting them to the workstation. 

When the scan completes, the Main tab automatically appears on the touch screen. 

 Click the Finalize button on the touch screen. 
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 Make sure the patient’s information is removed from the touch screen. 

Changing the scan delay default setting from touch screen 

The scan-delay default setting is changed or accepted – after the patient and scanner are in position. 

 On the Options tab, press the Scan Delay button. 

 
Figure 265: Scan Delay button 

The Select Scan Delay popup appears. 

 
Figure 266: Select Scan Delay popup 

 Press the appropriate delay time you want to set (0 to 22 seconds). 

 Press Ok to set the delay time. 

Cancelling a scan from the touch screen 

This procedure assumes you have started a scan. 

See “Scanning from the touch screen” on page 245. 

 Press the Cancel Scan button on the touch screen – at any time during the scanning process – to 
cancel a scan. 
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Figure 267: Cancel Scan button on the touch screen 

After the Cancel Scan button is pressed, the system returns to the Main tab.  The Cancel Scan button 
stops the scan; there may be a delay as the scanner goes through its abort process. 

No t e  I f  t h e  s can  i s  c an ce l ed  du r ing  an  a c tua l  exposu re ,  t h e  s canner  w i l l  s t op  a t  t h e  
end  o f  t h a t  expo su r e .   I f  you  c l i ck  t h e  Can ce l  bu t t on  a f t e r  t h e  s cann er  h a s  
compl e t ed  i t s  p r epa ra t i on ,  t h e  s canner  w i l l  make  t h a t  expo su re  a nd  th en  s t o p .  

Using Training mode to simulate a scan for training 
purposes 

The Training Mode On button lets you simulate a scan without emitting radiation. 

 On the touch screen, press  (Training Mode On button). 

The Training Mode On button is a toggle button.  If Training Mode On is showing and you press 
it, the button changes to Training Mode Off.  When active, the text ‘TRAINING MODE’ appears at 
the lower, left corner of the touch screen as shown in Figure 268. 

 Check that the “TRAINING MODE” message appears to indicate the Training mode is active. 

No t e  No  x - r ay s  a r e  em i t t ed  wh i l e  i n  T ra in ing  mode .   Us e  T r a in ing  mode  dur ing  
sho r t  s can s  and  f rom the  t ouch  sc r e en  (LCD) ,  on l y .  

 
Figure 268: TRAINING MODE message to indicate Training mode on 

 To turn off Training mode, press  (Training Mode Off button). 
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The “TRAINING MODE” message disappears and the Training Mode On button appears. 

Scanning with special features 

The following features are available for use in protocols.  Each feature is explained in the following 
sections. 

Using the step-and-shoot option 

The Step & Shoot option in the protocol lets the user control the start of the scan acquisition.  This is 
helpful in the case of an uncooperative or ill patient where motion is an issue. 

 Perform steps 1 through 6 in “Scanning from the workstation” on page 237. 

 If necessary, change the Scan Type to Axial. 

 Click the Step & Shoot option in the Edit Series dialog box. 

 
Figure 269: Step & Shoot option in the Edit Series dialog box 

 Click the Update button in the New Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

See steps 9 through 14 in “Scanning from the workstation” on page 237. 

 Click the Begin button in the Exam Planner dialog box to begin the scan. 

The system state orb will change color from (preparing the protocol to the system) to 
(ready to scan).  The System Ready to Scan popup appears. 
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Figure 270: System Ready to Scan popup 

 To continue the scan, go to the scanner and press the Scan button on the touch screen. 

The first set of images are acquired at this position. 

The Step & Shoot popup appears for you to control the next acquisition. 

 
Figure 271: Step & Shoot popup 

 Click the Shoot button to start the scan. 

To cancel the scan, click the Cancel button. 

 Continue for the length of the scan. 

 Click the Finalize button when finished. 

Performing a scan with Automatic Exposure Control 

Note  Depend i ng  on  sy s t em ’ s  con f i gu ra t i on ,  no t  a l l  f unc t i on s  may  be  ava i l a b l e  t o  
pe r f o rm th i s  p ro cedu re .  

Computed Tomography (CT) is responsible for the largest contribution to the collective effective dose to 
patients in radiology.  The challenge to radiologists and medical physicists is to establish adequate image 
quality with the lowest radiation exposure to the patient. 
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Tube current (mA) is one of the key technical scanning parameters for adjusting radiation dose in CT.  
To optimize radiation dose in CT, users can adjust mA either with manually selected values or with the 
application of Automatic Exposure Control (AEC).  AEC refers to the automatic adaption of mA on the 
basis of user specified image quality and attenuation characteristics of the scanned body region. 

In CereTom Elite, scout scans now provide a graph of mA values based on object density and desired 
noise level.  A single Axial or Helical scan in the protocol can utilize AEC, limiting the mA value of each 
slice to the minimum necessary to achieve the desired image quality.  This ability to modulate the mA 
throughout the scan to achieve the desired noise level can reduce patient dose. 

When centering the patient in the gantry, it is vital to accurately use AEC.  AEC aims to deliver the 
specified image quality across a range of patient sizes.  The use of AEC may change the planned CTDIvol 
and DLP values.  It tends to increase CTDIvol for large patients and decrease it for small patients relative 
to a reference patient size. 

No te  Ensure  pa t i en t  i s  a c cu ra t e l y  c en t e r ed  i n  g an t ry .  

 Do  no t  u se  AEC  when  any  t ype  o f  me t a l  i s  go ing  t o  b e  s canned .  

 Do  no t  u se  AEC  w i th  a  sma l l  FOV ,  t h a t  i s ,  t i ny  neona t a l  p ed i a t r i c s .  

 On l y  1  Ax i a l  o r  He l i c a l  s e r i e s  i s  a l l owed  w i th in  an  AEC pro t oco l .  

 An  au toma t i c  ad ju s tmen t  o f  t h e  t ube ’ s  cu r r en t  c anno t  o ccu r  when  th e  t ube  
po t en t i a l  i s  ch anged .  

 

No te  AEC  i s  an  op t i on  f o r  l ow  r e so l u t i on  sha rpn es s  k e r ne l s  (He l i c a l  ( so f t  t i s sue  
k e rne l s )  o r  Ax i a l  ( l ow  no i se  QA ,  so f t  t i s su e ,  Po s  Fo s sa /Ve ss e l ,  sh a rp  k e rne l s ) ) .  

 Perform steps 1 through 6 in “Scanning from the workstation” on page 237. 

 If necessary, change the Scan Type to Axial or Helical. 

 Under AEC, click the Enable AEC option. 
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Figure 272: Edit Series dialog box with AEC options selected 

 Under AEC, click the Minimum mA dropdown to set the minimum allowed mA value used for 
scanning. 

 Under AEC, click the Maximum mA- to set the maximum allowed mA value for scanning. 

The minimum mA on the CereTom Elite is 1 and the maximum mA is 7.  When using AEC, set 
the minimum and maximum mA for that particular scan, for example, 2 to 6. 

 Under AEC, click the Noise Level- to set the standard deviation of noise value for the completed 
scan. 

The noise range is 1-200. 

 Click the Update button in the New Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Make sure your patient and scanner are positioned. 

 Click the Begin button in the Exam Planner dialog box to begin the scan. 

 To continue the scan, go to the scanner and press the Scan button on the touch screen. 

 After the scouts are acquired and the scan region is set, click the AEC tab. 

 Click the Toggle Graph button to view the graph on the scout. 

 
Figure 273: Toggle Graph button 

The graphs will now appear on the scout(s). 
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Figure 274: Graphs on the scout(s) 

  
Figure 275: AEC modulation graph 

 To return to the scout parameter view, click the Toggle Graph button, again. 

 Modify maximum and minimum mA and noise as needed on the image. 

 When the desired level is achieved according to your department policy, select the Continue button 
to start the scan. 

 Press Start Scan from the touch screen. 

No t e   Wh i l e  r ev i ew ing  t h e  s can  you  w i l l  s e e  mA modu l a t i on  a s  p e r  your  g r aph s .  

 Click the Finalize button. 

Performing a CT angiography scan with bolus tracking 

CT angiography is a technique that uses contrast to visualize arterial and venous vessels throughout the 
body.  This ranges from arteries serving the brain to those bringing blood to the lungs, kidneys, arms, 
and legs. 

 Perform steps 1 through 6 in “Scanning from the workstation” on page 237. 
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 If necessary, change the Scan Type to Helical or Dynamic. 

 Click the Bolus Tracking option. 

 
Figure 276: Bolus Tracking option 

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Begin button to acquire the scout(s). 

 To continue the scan, go to the scanner and press the Scan button on the touch screen. 

 On the scout, set the scout (parameter) lines (blue). 

 
Figure 277: Scout line (blue) 

 Move the reference line (green) to where you will acquire a reference scan. 
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Figure 278: Reference line (green) 

 To move the scout or reference line go to the Viewing tools and select Active Scan Region. 

 
Figure 279: Active Scan Region – Bolus Reference or Helical CTA 

 Click the Continue button to acquire a 10mm reference scan. 

The scanner will move to the reference line noted on the scout. 

 Click the Bolus button to draw ROI on the reference scan. 
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Figure 280: ROI on the reference scan 

 Click the Continue button. 

The Adjust Bolus Settings popup appears. 

 
Figure 281: Adjust Bolus Settings popup 

 Click the Select Contrast Level/Iodine Content dropdown to select your contrast level. 

 Click the Auto Start or Auto Stop options (measured in seconds). 

• Auto Start Begins the scan after the specified bolus scan time if no bolus is 
detected. 

• Auto-Stop Stops the scan after the specified bolus scan time if no contrast is 
detected. 

 Click the Apply button. 

 Press the Scan button on the scanner and initiate contrast. 
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Figure 282: Completed scan with contrast 

No t e  In  t h e  exampl e  a bove ,  t h e  s can  w i l l  s t a r t  i n  16  se cond s  o r  when  i t  s e e s  a  
d i f f e r en ce  o f  1 00  HUs in  t h e  Bo lu s  Tra ck ing  ROI .  

The scan starts based on what you selected above (Auto Start or Auto Stop).  If contrast is detected, 
you can to start your scan manually by selecting the Start Scan button. 

 
Figure 283: Start Scan button 

 Press the Finalize button when complete. 

Performing Test Bolus 

Test Bolus performs a bolus-timing function. 

 Perform steps 1 through 6 in “Scanning from the workstation” on page 237. 

Select a chest or head CTA protocol. 

 If necessary, change the Scan Type to Helical or Dynamic. 

 Click the Bolus Tracking option. 
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Figure 284: Bolus Tracking option 

 Click the Update button in the Edit Series dialog box. 

 Click the Update button in the Edit Protocol dialog box. 

 Click the Begin button to acquire the scout(s). 

 To continue the scan, go to the scanner and press the Scan button on the touch screen. 

 On the scout, set the scout (parameter) lines (blue). 

 
Figure 285: Scout line (blue) 

 Move the reference line (green) to where you will acquire a reference scan. 
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Figure 286: Reference line (green) 

No t e  The  d i s t ance  be twe en  th e  r e f e r enc e  and  bo lu s  t r a ck i ng  s can s  canno t  be  
g r ea t e r  t h an  100mm.  

 To move the scout or reference line go to the Viewing tools and select Active Scan Region. 

 
Figure 287: Active Scan Region – Bolus Reference or Helical CTA 

 Click the Continue button to acquire a 10mm reference scan. 

The scanner will move to the reference line noted on the scout. 

 Click the Bolus button to draw ROI on the reference scan. 



NL3000 CereTom Elite User Manual Revision 35 

 

Chapter 9    Patient Scanning  Page 263 of 374  

 

 
Figure 288: ROI on a reference scan 

 Click the Continue button. 

The Adjust Bolus Settings popup appears. 

 
Figure 289: Adjust Bolus Settings popup 

 Click the Select Contrast Level/Iodine Content dropdown to select your contrast level. 

 Click the Test Bolus option. 

• Test Bolus 

Tests the timing of the contrast injected. 

A small amount of contrast is injected and a timing graph is given after 
the specified bolus scan time.  When the contrast is detected, the system 
stops scanning and a report on the recommended delay time for Helical 
and CTP protocols, appears. 

 Click the Apply button. 

 Press the Scan button on the scanner and initiate contrast. 

Scan will trigger when bolus enters reference point and ROI.  Bolus Timing graph appears and 
shows the calculated, bolus-tracking time. 
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Figure 290: Bolus timing graph 

 Select from one of the following: 
• Use Calculated Uses the bolus timing calculated from the Test Bolus scan. 

• Use Manual Allows the user to select a manual timing of the bolus after the Test 
Bolus calculates a timing. 

• Auto Start Begins the scan after the specified bolus scan time if no bolus is 
detected. 

• Auto Stop Stops the scan after the specified bolus scan time if no contrast is 
detected. 

 Click the Continue button. 

Review completed scan. 

 Press the Finalize button when complete. 

Examining the scanned image with tools 

You cannot work with image tools without a registered patient, the Acquisition tab enabled, and a 
scanned image showing.  You can also use image tools from the Patient Browser tab – after you select a 
patient and open the associated image.  In either case (from the Acquisition or the Patient Browser tab), 
the tools appear.  Look for the Tools section on Acquisition; click 2D, 3D, and MPR dropdowns.  Patient 
Browser provides more image tools. 

From the Acquisition tab, you can zoom, pan, modify window width and level, and change layout; see the 
table below to understand the basics of what each tool looks like and how it performs. 
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Using tools on the Acquisition tab 

It is assumed you have registered the patient.  You cannot use these tools without a registered patient and 
the Acquisition tab enabled. 

The following table describes some of the tools available to you when the Acquisition tab is active.  For a 
comprehensive list, see Table 46. 

Table 42: Image tools 

Image  t oo l  Too l  name  Ac t i on   

 
Clear Active Resets the tool to the default pointer device. 

 
Change the Window 
Width Level 

Click and move pointer over image.  Left-click 
and hold down the mouse button and drag in 
chosen direction to adjust image width and level.  
Width and level values appear in the Width/Level 
status display. 

A pre-defined width level setting can also be 
selected. 

Select preset from dropdown list below the WL 
Preset button. 

Width and level presets can also be saved or 
deleted. 

 
Zoom 

Click and move the pointer over the image.  Left-
click the mouse and hold down the left mouse 
button and move in upward direction to zoom in 
(enlarge) and downward to zoom out (shrink). 

 
Pan 

Click and move pointer over image.  Left-click 
and hold down the mouse button and drag the 
image in the chosen direction.  Release mouse 
button to position image in new location. 

 
Toggle Scouts Removes scouts from Acquisition. 

 
Toggle Layout Changes the layout to 2x2.  Repeat process to 

return to 1x1 (full screen prior to clicking). 

 
Scan Region Re-Draw If scout lines and the scan region is deactivated, 

allows you to reactivate. 
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Chapter 10     Patient Browser  
Patient Browser lets you view patient information and the images (and series) associated with the patient 
information – after the patient’s (scan) examination.  It lets you access all the series stored on the 
workstation and enter additional patient information to patients already registered. 

 
Figure 291: Active Patient Browser tab 

The following table identifies those buttons found on the Patient Browser. 

Table 43: Command buttons 

Bu t t on  Ac t i on  

 
Selects the archive destination for selected information. 

 
Imports the exam information from PACS or Media. 

 
Deletes the selected exam information from the Patient Browser tab. 

 
Reregisters a patient who is already in the system (Patient Browser). 

 
Generates the dose for the particular patient. 

 
Combines two different image sets. 

 
Shows patient, study, series, and image information. 

 
Views images. 
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Overview of Patient Browser 

Patient Browser lets you perform tasks on existing series, for example archiving and printing the series.  
This section will introduce you to Patient Browser and identify the symbols, areas, and buttons you can 
use. 

The Patient Browser can be broken down into the following sections: 

• Exam table 
• Series table 
• Selected protocol table 
• Patient Browser’s (initial) active buttons 
• Preview window 

 
Figure 292: Patient Browser sections 

Identifying symbols on Patient Browser 

Symbols may appear next to series in the exam and/or series tables.  These symbols are more vivid (not 
dim) when active; they are identified below as active symbols. 

• Locked Indicates the series is locked and cannot be deleted:  
• Read/Mark Indicates the series is marked to be read or read by the physician:  
• PACS Indicates the series has been sent to PACS:  

• Stored Indicates the series has been sent to PACS; the archived series appear below 
the initial table:  

• Media Indicates the series has been sent to a media device, for example USB:  
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Figure 293 Patient Browser locked, read, PACS and Stored (archived), and media symbols 

Using the vertical and horizontal scroll bars on Patient 
Browser 

Navigation scroll bars let you move up and down the list of patients and associated examination scans (in 
the exam table); horizontal scroll bars let you see all aspects of the image by moving the bar to view all 
columns of data. 

 
Figure 294 Patient Browser horizontal and vertical scroll bars 

Using the preview window 

 Click a patient in the exam table. 

 Click a series in the series table. 

 In the series protocol table, click the QA Results report. 
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Figure 295: Patient Browser > QA Results report 

The QA results report appears in the preview window. 

 To quickly preview the QA image, click the series and click the Preview button below the series 
table. 

 
Figure 296: The QA image (phantom) appears in the preview window 

Registering a patient from Patient Browser 

If additional scans will be performed on a patient that is already exists in the system, you can register 
within Patient Browser.  A newly acquired series will be added to the existing patient’s series table. 

 Click the Patient Browser tab, if necessary. 

 Select the required patient to register the patient for an examination. 

 Click the Register button. 
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The Create New Study popup appears. 

 
Figure 297: Create New Study popup 

 Perform one of the following: 

• Click the Patient/Study button (to use all exam information selected, including the accession 
number). 

• Click the Patient button (to use only patient information). 

• Click the Cancel button to exit the Create New Study popup. 

Building dose from Patient Browser 

The Patient Browser tab presents, for any completed study, the Build Dose button.  Clicking this button 
lets you build the dose report only or dose report & dose SR reports (together).  Building Dose Reports & 
Dose SR appears in the series table. 

 Click the Patient Browser tab, if necessary. 

 Select the patient to build a dose report or a structured dose report. 

 Click the Build Dose button. 

The Choose Dose Options popup appears. 

 
Figure 298: Chose Dose Option popup 

 Perform one of the following: 

• Click the Dose Report button to build the dose report. 

• Click the Dose Report & Dose SR to build the dose report and dose SR (Structured Dose) 
report. 

The Please Wait popup appears. 
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• Click the Cancel button to exit the Choose Dose Option popup. 

 To view the report, select the report and click the Preview tab. 

No t e  S t ruc tu r ed  do se  r epo r t s  c anno t  be  v i ewed  in  t h e  CereTom E l i t e  sy s t em ;  
Do se  SR  can  be  v i ew ed  in  PACS  w i th  t h e  appropr i a t e  v i ew er .  

Importing data 

Importing data lets you store data (protocols) from devices such as a USB. 

Importing from PACS 

 Click the Patient Browser tab, if necessary. 

 Click the Import button to import data. 

The Import Location popup appears. 

 
Figure 299: Import Location popup 

 Click the PACS button. 

The Import from PACS popup appears. 

 
Figure 300: Import from PACS 

 Click the Query button to perform the following: 

• Select a HIS/RIS server from the dropdown. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 272 of 374 Importing data 

• Set the values to search in your query. 

• Click one of the following buttons: 

• Click the Query button to search for the values you set. 

 
Figure 301: Import from PACS dialog box 

• Click the Save Query button (after your search is complete) to save the search results. 

• Click the Reset button to start over or query again. 

• Click the Cancel button to exit the Import Location popup. 

 With your query results, select a patient and click the Get Series button. 

 
Figure 302: Import PACS dialog box with active Get Series button 

 Click the Import button. 

 Click the Close button to exit the Import from PACS popup. 

Importing from media 

Studies can be imported into the Patient Browser from a USB (inserted into the workstation). 

 Click the Patient Browser tab, if necessary. 
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 Click the Import button on Patient Browser. 

The Import Location popup appears. 

 
Figure 303: Import Location popup 

 Click the Media button. 

The Import from Media popup appears. 

 
Figure 304: Import from Media popup 

 Click the drive and path from where you will import. 

No t e  S e l e c t  t h e  f i l e  o r  f o l de r  f rom where  t o  impor t ;  i f  n ec e s sa ry ,  c l i ck  
Subfo l d e r s  t o  s e e  t h e  en t i r e  p a th .  

 To  s e l e c t  a  s ing l e  DIC OM image  o r  a  DICOMDIR  f i l e ,  c l i ck  t h e  
DICOMDIR f i l e  t o  impor t  a l l  images  r e l a t ed  t o  t h a t  pa r t i c u l a r  
D ICOMDIR . 

The Import button is active. 
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Figure 305: Active Import button 

 Click the Import button. 

The imported images appear in Patient Browser. 

Loading a series into view 

 Click the Patient Browser tab, if necessary. 

 Select the patient. 

 Select the series. 

 Click the View Images button or double-click the selected series. 

The Viewing tab opens and the series appears for viewing and manipulating. 

Using Show Info to view, update, and move a 
series 

 Click the Patient Browser tab, if necessary. 

 Select the patient. 

 Select the series. 

The Show Info button appears and is active. 

 Click the Show Info button. 

The View/Update Information dialog box appears. 
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Figure 306: View/Update Information dialog box 

The following tabs appear: 

• Patient Data about the patient, such as patient name, date of birth, and sex 
of patient. 

• Study Data about the study, such as date, time, and referring physician. 

• Series Data about the series, such as position reference indicator, model, 
pixel padding value, and series date and time. 

• Images Data about the image, such as the instance number (sequential), 
exposure time. 

 Click the tab(s) to review and update the necessary information. 

 Double-click any editable fields and make your change(s). 

 Click one of the following buttons 

• Click the Update button to save your changes. 

• Click the Move button to show the Move Series popup. 

No t e  The  Mov e  Se r i e s  f unc t i on  i s  u sed  when  a  s can  ha s  b een  a cqu i r ed  
under  t h e  wrong  pa t i en t  f i l e  o r  t o  move  a  pa t i en t  t h a t  wa s  r eg i s t e r ed  
manua l l y  t o  t h e  Pa t i en t  Reg i s t r a t i on  t ab .   Mov ing  th e  pa t i e n t  t o  t h e  
P a t i en t  R eg i s t r a t i on  t ab  w i l l  c ap tu r e  a l l  o f  t h e  pa t i en t ' s  i n fo rma t i on .  

• Click the Registration button to move the patient into an existing patient or by 
manually creating a new patient using the Patient Registration process. 

• Click the Cancel button to exit the Move Series popup. 
• Click Browser to go to the Patient Browser tab and move the series. 
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• Click the Move button to confirm moving the series. 

• Click the Cancel button to exit the Patient Browser tab and return to the View/Update 
Information popup. 

 Click the Close button to exit the View/Update Information popup. 

Modifying a series scanned under the wrong 
patient 

If a patient has been scanned under the wrong identification, the series can be corrected. 

 Click the Patient Browser tab, if necessary. 

 Select the series that was scanned with incorrect patient identification to modify the data. 

 Click the Show Info button. 

The View/Update Information dialog box appears. 

 
Figure 307: View/Update Information dialog box 

 Click the Move button. 

The Move Series popup appears, denoting where to retrieve patient information from. 

 
Figure 308: Move Series popup 

The following defines what each button performs: 
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• Registration  
If patient information is stored within hospital’s HIS/RIS server, click the 
Registration button, which will open the Register Patient tab to let you 
choose patient/study information. 

• Browser 
If patient information is stored within system’s browser, click Browser 
button, which show the Patient Browser tab information to let you select a 
series with correct patient information. 

• Cancel Returns you to the previous dialog box. 

 Perform one of the following: 

• If you clicked the Registration button in the previous step, go to the next step. 

• If you clicked the Browser button in the previous step, go to step 11. 

 Click the Manual button. 

The Exam Information dialog box appears. 

 Enter the corrected data in any of the fields. 

See “Registering the patient” on page 223. 

 Click the Update button to save the change(s). 

  Click the Move button  

A prompt appears to review changes made to the patient and/or series information in order for 
changes to take effect. 

 Click the Ok button and then the Update button. 

The corrected patient and moved data will appear in the Patient Browser. 

 If you selected the Browser button, the Patient Browser tab is showing; select the correct patient and 
series. 

 Click the Move button. 

A prompt appears to review changes made to the patient and/or series information in order for 
changes to take effect. 

 Click the Ok button. 

 Review the patient to ensure it is the proper one. 

 Click the Update button. 

 Click the Cancel button to return to the Patient Browser. 
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Merging a series 

The merge function is used to combine two different series for review. 

No t e  On l y  se r i e s  w i t h  same  pa t i en t  name ,  ID ,  and  s l i c e  t h i ckn es s  c an  be  merged .  

 Click the Patient Browser, if necessary. 

 Select the study to merge. 

The study must include several scans. 

 Select two series to merge by pressing and holding the Ctrl key and highlighting the two series. 

  
Figure 309: Two series selected to merge 

The Merge button appears and is active. 

 
Figure 310: Active Merge button 

 Click the Merge button to merge the series. 
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No t e  To  merge ,  t h e  two  se r i e s  mus t  h ave  t h e  same  pro t o co l  s l i c e  t h i cknes s  and  
spa c ing ,  k e rne l ,  and  p i xe l  spa c ing .  

A Please Wait popup appears while the application merges the set of series. 

• When the Merge window appears, one selected series appears (on the left) and the other 
appears (to the right); both in scrollable (use the mouse-wheel) filmstrips. 

• The bottom (to be selected images) filmstrip is empty when the window is first displayed.  
The following four image tools are available to use: 

Table 44: Image tools 

Image  t oo l  Too l  name  Ac t i on   

 
Windowing Width 
and Level Adjusts window width and center of image. 

 
Zoom Magnifies the image. 

 
Pan Adjusts image on X or Y axis. 

 
Clear Active Resets the tool to the default pointer 

device. 

 

 
Figure 311: Image viewer without image(s) selected 

 After viewing images, drag each viewed image to the image viewer or the bottom of the filmstrip. 

A single selected image appears in a green outline.  You can also perform the following: 

• To select a single image, click and drag the image. 
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• To select several images, press the Ctrl key, click the images, and drag the images. 

Alternatively, to select multiple images, right-click and click Select All. 

• To deselect a single image, click the image – one time (image appears in white outline). 

Alternatively, to deselect all, right-click the filmstrip and click Deselect All. 

 
Figure 312: Selecting images to move to image viewer or bottom filmstrip 

 To reorder bottom filmstrip, drag one or more images to the new location. 

 
Figure 313: Finished filmstrip 

 When finished with bottom strip, click the Merge button. 

To stop the merge, click the Close button to return to the browser. 

The application generates a third series with those images.  A Series Saved popup appears, 
informing of merge success or failure.  When user returns to browser, it has already been refreshed 
to show new series.  Series is marked as a merged series in its series description DICOM tag, which 
can be shown in the browser.  Series is also marked as secondary, rather than primary series. 
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Locking a series 

 Click the Patient Browser tab, if necessary. 

 Select the study to lock. 

 Right-click the mouse button. 

 Click Lock on the floating menu that appears. 

 
Figure: 314: Floating menu - Lock 

The (Lock symbol) appears for any selected series. 

 
Figure: 315: Two locked series 

A series cannot be deleted while in a locked mode. 

 To unlock right-click and click Unlock. 

No t e  A l l  QA s e r i e s  a r e  l o cked  t o  p r even t  de l e t i on .   Th e  QA se r i e s  c an  on l y  be  
un l ocked  by  you r  f i e l d  s e r v i c e  r epr e s en t a t i v e .  

Marking a series to read 

 Click the Patient Browser tab, if necessary. 

 Select the study to mark. 

 Right-click the mouse button. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 282 of 374 Deleting a series 

 Click Mark on the floating menu. 

 
Figure: 316: Floating menu - Mark 

The (Mark symbol) appears (brighter) for any selected series. 

 To unmark any series, right-click Unmark. 

Deleting a series 

 If necessary, click the Patient Browser tab, if necessary. 

 Select the study or the series to delete. 

 Click the Delete button. 

Archiving patient series 

You can archive patients and studies (or series) to PACS, media (USB or CD), or using navigation during 
surgery. 

Archiving to PACS 

 If necessary, click the Patient Browser tab. 

 Select the patient study for PACS in the following way: 

• To select one patient and all associated series, click the patient, and click the Archive button. 

• To select specific series for a patient, click the Ctrl key, then select each series, and click the 
Archive button. 

 Click the PACS button. 

The Archive to Server popup appears. 
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Figure 317: Archive To Server popup 

 Click the Select Archive Location dropdown and select a site. 

 Review the Image Range items to make sure all those items you selected in step 2 are captured. 

 Click the Archive button to begin the archive process. 

If enabled (in System Configuration) the Store/Print Queue dialog box will appear to show the 
status of your image transfer.  You can also activate the Store/Print Queue dialog box by clicking 
Tools > Store/Print Queue from the main menu. 

Watch the status of each series: Pending informs you that the series is paused because you clicked 
the Pause button; Connecting informs you that the series is in process of archiving to its targeted 
location.  Each series will move from the top portion of the popup to the bottom portion of the 
Store/Print Queue popup when it has been processed. 

If the series is not successfully stored to its targeted destination, the “Store Failed” message appears 
in the Failure column.  This means the series was not successfully archived.  If the series was 
successfully archived, no message appears in the Failure column. 

The following information is displayed: 

 
Figure 318: Store/Print Queue dialog box 
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While the archiving process is in process, you can perform one of the following from the buttons in 
the Store/Print Queue dialog box.  See the table below for a description of the buttons and their 
actions. 

Table 45: Store/Print Queue buttons 

S t o r e  and  Pr in t  Queu e  
bu t t on  Ac t i on  

 

When you select one or more series, temporarily stops the 
series from being stored.  This is a toggle button with the 
Resume button. 

 

When you select one or more series, continues to store 
previously paused series.  This is a toggle button with the 
Pause button. 

 
When you select one or more series, deletes either a series to 
be stored, or a series that failed to store. 

 
When you select one of more series, tries to archive the 
selections. 

 
When you select one of more series, deletes a (failed) series. 

 
When you select one of more series, displays an explanation of 
why a series failed to store. 

 
Closes the Store/Print Queue popup. 

If the job is sent successfully, the series disappears from the queue. 

 If there are failed archived series; click the Retry button to attempt to archive the series you selected. 

No t e  Any  S t o r ing  F a i l u r e  s t a t u s  appea r s  i n  t h e  bo t t om o f  t h e  popup t o  in fo rm 
you  why  th e  f a i l u r e  o ccu r r ed .   I f  an  a r ch i v e  j ob  f a i l s ,  i t  w i l l  be  s en t  t o  t h e  
Fa i l ed  S to re /Pr in t  Jobs  l i s t .  

 When the archiving is complete, click the Close button to exit the Store/Print Queue. 

You can also click the Close button and the archiving process will continue as you do other tasks. 

Archiving to Media 

1. If necessary, click the Patient Browser tab. 

 Select the patient study you want to send to media in the following way: 
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• To select one patient and all associated series, click the patient and click the Archive button. 

• To select specific series for a patient, click the Ctrl key, select each series, and click the 
Archive button. 

No t e  To  s e l e c t  more  t h an  one  pa t i e n t  a t  a  t ime ,  p r e s s  and  ho l d  t h e  C t r l  k ey  (on  
th e  work s t a t i on  k eypad )  and  c l i ck  any  pa t i en t s  un t i l  f i n i sh ed  and  th en  
r e l e a se  t h e  C t r l  k ey .  

 To  c l i ck  a l l  t h e  pa t i en t s ,  p r e s s  and  ho l d  t h e  Sh i f t  k ey  (on  th e  work s t a t i on  
k eypad )  and  c l i ck  t h e  f i r s t  pa t i en t  i n  t h e  l i s t  and  th en  c l i c k  t h e  l a s t  
pa t i en t  t o  h i gh l i gh t  a l l  pa t i en t s  be twe en  th e  f i r s t  pa t i en t  s e l e c t ed  and  th e  
l a s t .   The  S t o r e  bu t t on  w i l l  be  a c t i v a t ed .  

 Click the Archive button. 

The Archive Destination popup appears. 

 Click the Media button. 

The Archive to Media popup appears. 

 If you are archiving media to a USB, insert the thumb drive into the USB port. 

 
Figure 319: Archive to Media popup 

 Click (to select) the targeted drive and path destination for the archived study. 

The Archive button is active. 

 Click the Tree button to perform the following: 

The Adjust Archive Tree popup appears. 
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Figure 320: Adjust Archive Tree popup 

• Select a specific path to archive the media to by clicking down the tree’s path. 

• Click Apply to select the new path. 

• Click Cancel to exit the Adjust Archive Tree without saving your changes. 

 Click the appropriate check boxes for your archive process: 

• Anonymous Patient  Makes the patient’s information anonymous for HIPAA 
standards. 

• Anonymous Institution  Makes institutional information anonymous for HIPAA 
standards. 

• Include CD Viewer (requires CD 
viewer software installed) 

Includes a CD viewer application to view images from 
the media. 

• Export as JPEGS  Exports image files in .JPG format. 

• Show Demographics  Includes the demographic information in archive, if you 
clicked the Export as JPEGS check box. 

 Perform the following: 

• Click the Archive button to begin the archive process. 

• The Cancel button is active after clicking the Archive button; click the Cancel button to 
stop the archive to USB or a drive. 

• Click the Refresh button to remove any messages that appear in the Message box. 

• Click the Minimize button to continue working in other areas while the archiving process 
runs.  A disk appears at the bottom; click it to maximize the Archive to Media popup. 
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• Click the Close button to exit the Archive to Media popup after the archive process is 
complete. 

Archiving to Navigation 

This procedure is used to archive images to surgical navigation systems during surgery. 

 If necessary, click the Patient Browser tab. 

 Select the patient study (or series). 

 Click the Archive button. 

 Click the Navigation button. 

 Click the Select Archive Location dropdown and select the location. 

 Under Image Range, select the image(s) you want to send to navigation. 

To return to the default selections, click the Reset button. 

 Perform one of the following: 

• Click the Archive button to send the image to Navigation. 

• Click the Cancel button to return to Patient Browser.
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Chapter 11     Viewing Images 
Viewing lets you see already scanned images from previous examinations.  To view images, select the 
patient in Patient Browser and then select the series to view.  To open the image, click the View Images 
button or double-click the series. 

 

Figure 321: Active Viewing tab 

The following table identifies the image tools (from the Viewing tab) that let you manipulate a scanned 
image.  To see the following image tools, the Viewing tab must be enabled and open.  Some image tools 
appear on specific viewing tabs, only.  The view tabs are 2D, MPR, 3D, and (if enabled) CTP. 

Table 46: 2D, MPR, 3D, and CTP image tools 

Image  t oo l s  Too l  name  Ac t i on  

Common t oo l s  

 
Clear Active Resets the tool to the default pointer device. 

 
Windowing Adjusts window width and center of image. 

 
Zoom Magnifies the image. 

 
Pan Adjusts image on X or Y axis. 

 
Invert Inverts black to white and white to black. 

 
Capture Saves a screen capture of selected a viewport. 

 
Capture all Viewports Saves screen captures of all visible viewports. 

 
Reset Reverts all images back to their original mode. 
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Image  t oo l s  Too l  name  Ac t i on  

2D  and  CTP t oo l s  

 
Region of Interest 
(ROI) 

Defines a circular ROI and displays the ROI 
information (5mm diameter by default). 

 
Arrow Draws an arrow on the image, which can be 

repositioned. 

2D ,  CTP ,  and  MPR t oo l s  

 
Measure (Line) Draws a line on the image and displays length 

information. 

 
Angle Draws an angle on the image and displays the 

angle information. 

CTP and  MPR on l y  t oo l s  

 
Undo 

Reverses the most recent action taken (a 
successful copy, cut, delete, undo or paste 
action). 

 
Redo 

Restores the last text editing or resizing and 
positioning of controls – if no other action 
occurred since last time the Undo button was 
clicked. 

2D  on l y  t oo l s  

 
Text (Annotation) Create text box for annotation. 

 
Reverse Image Stack Reverses the order in which images display. 

 
Flip Vertical Flips images up or down. 

 
Flip Horizontal Flips images right or left. 

 
Cine Backward Cine backward through the image. 

 
Cine Forward Cine forward through the image. 
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Image  t oo l s  Too l  name  Ac t i on  

 
Stop Cine Stop the cine forward and backward. 

MPR on l y  t oo l s  

 
Tilt Corrects a rotated image. 

3D  on l y  t oo l  

 
Rotate Rotates the image. 

CTP Per f u s i on  on l y  t oo l s  

 
Perfusion 
Artery/Vein Selection 

Select the artery and vein to be used for 
performing perfusion calculations. 

 
Calculate CBF, CBV, 
MTT Map 

Calculates the Cerebral Blood Flow (CBF), 
Cerebral Blood Volume (CBV) and Mean 
Transit Time (MTT) maps. 

 
Clear Perfusion Map Cancels the calculations and returns to 

Calculation mode. 

 
Show Artery/Vein 
Flow Graph 

Displays the Arterial Venous Flow graph. 

 

 
Peak Image Displays the image that has the most visible 

contrast (based on arterial ROI placement). 

Using keyboard shortcuts 

Keys are a quick way to navigate around.  The tables below provide navigation and quick (workstation) 
keyboard keys you can use to move around the information on the Viewing tab. 

Table 47: Arrow key navigation 

Ar row key s  Ac t i on  

 (Up) and (Down) To scroll through images. 

 (Left) and  (Right) To adjust the window level. 
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Ar row  key s  Ac t i on  

PgUp and PgDown To quickly scroll through images. 

 

Table 48: Function keys 

Func t i on  k ey s  Ac t i on  

F5 To view in Abdomen window. 

F6 To view in Brain window. 

F7 To view in Lung window. 

F8 To view in Mediastinum window. 

F9 To view in Bone window. 

Setting window width and center 

Note  Any  mod i f i c a t i on s  you  make  a r e  no t  sav ed  t o  t h e  image .  

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the 2D, MPR, 3D, or CTP (if enabled) tab to drop down the appropriate mode’s panel. 

 
Figure 322: 2D, MPR, and 3D mode tabs (CTP only shows (by itself) when it is enabled) 

 To adjust the window width and center (contrast) of the image, adjust the following: 

• To adjust with a preset, click the Windowing dropdown and click a preset: Lung, Brain, soft 
Tissue, and Bone. 
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Figure 323: Windowing preset dropdown list 

• To adjust the windowing width and center with the text boxes, enter the width and center 
values in the Width and Center text boxes, and click the Apply button. 

No t e  Ano the r  way  t o  v i ew  common  t oo l s  i s  t o  move  t h e  mous e  o ve r  t h e  
image  and  r i gh t - c l i ck .   2D ,  MPR ,  3D  and  ( i f  enab l ed )  C TP  t oo l s  
appea r .   In  t h i s  c a se ,  t h e  Ac t i v a t e  Window Too l  appea r s  i n  t h e  l i s t .  

 
Figure 324: Windowing Width and Center text boxes, and the Apply button 

 Click the Apply button. 

Viewing images in 2D 

2D lets you view scanned images in a 2-Dimensional (2D) space.  Standard 2D mode is used when only 
one dataset is loaded.  The default layout is a 2 x 2 grid. 

No t e  Any  mod i f i c a t i on s  you  make  a r e  no t  sav ed  t o  t h e  image .  

The 2D viewer opens when you review a dataset from the Patient Browser component. 

The Viewing tab must be open, which means a patient has been selected, a scan was performed, and the 
Viewing tab is enabled to see the following: 
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Figure 325: 2D tools 

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and the 2D tab is open. 

 Use any of the image tools to view the image differently (zoom, pan, invert, flip, and so on) to 
manipulate your image. 

No t e  Ano the r  way  t o  v i ew  2D  t oo l s  i s  t o  move  t h e  mouse  ov e r  t h e  image  and  
r i gh t - c l i ck .   The  f o l l ow ing  r i g h t - c l i ck  menu  op t i on s  appea r :  

 A c t i v a t e  Window Too l ,  Ac t i v a t e  Zoom Too l ,  Ac t i v a t e  Pan  Too l ,  A c t i v a t e  
Ang l e  Too l ,  A c t i v a t e  ROI  Too l ,  Ac t i v a t e  L in e  Too l ,  A c t i v a t e  Ar r ow Too l ,  
A c t i v a t e  Tex t  Too l ,  C l i ck  t o  Inv e r t ,  and  C l ea r  Too l .  

 Click the Reset button to reset images back to the original setting(s). 

You cannot undo this action. 

Comparing two images 

Note  You  can  c ompar e  two  se r i e s  f rom th e  same  pa t i en t  o r  two  s e r i e s  f rom d i f f e r en t  
pa t i en t s .  

 Select the patient in Patient Browser. 

 Select the first series from series window. 

 Right-click and click Mark for Compare from the menu. 
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Figure 326: Mark For Compare on the menu 

 Select the second study (or second study from a different patient) to compare. 

 Right-click and then click Compare With Selected Series from the floating menu. 

 
Figure 327: Compare With Selected Series floating menu 

Both series are loaded into Viewing to compare. 

 
Figure 328: Compared series 
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 Click the Link button to link both images together to view. 

 
Figure 329: Link button 

The Unlink button replaces the Link button. 

 Click the Reset button to reset images back to the original setting(s). 

You cannot undo this action. 

Comparing a scout and a scan 

 Select a patient from Patient Browser. 

 Select a scout from the series window. 

 Press and hold the Ctrl key on the keyboard. 
 

 
Figure 330: Scout and scan selected to compare 

 Select the scan from the series window. 

Both images are highlighted. 

 Click the View Images button. 

The scout and the scan appear side by side.  The localizer (green line) appears on the scout. 

 Compare the scout to the scan. 
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Figure 331: Comparing a scout (1) and a scan (2) 

 To remove the scout, right-click on the scout and click Hide Scout Viewpoint. 

To return the scout to view, right-click in the viewing window and click Show Scout Viewport. 

Using the ROI 

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and the 2D tab is open. 

 Use any of the image tools to view the image differently (zoom, pan, invert, flip, and so on) to 
manipulate your image. 

 Click  (Region Of Interest (ROI). 

 Move the mouse pointer to the image and click where you want the ROI located. 

 Click and hold down the left mouse button as you drag the green circle (the ROI diameter). 

• To change the location of the ROI or the details of the ROI, click the circle (at any point of 
the circle) or anywhere in the description (mean, min, max, std. dev., area, and perimeter); 
the pointer changes to a hand and drag the yellow circle to move (the circle or details) to a 
new location.  Click anywhere (not on the ROI) to make the ROI and details stick in place. 

The standard deviation and mean of HU units within region of interest is showing near the 
circle.  Deviation and mean can be hidden and shown (by you, the operator).  When you 
move the ROI to a different location, the deviation and mean are automatically adjusted 
based on the new location. 
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Figure 332: ROI 

Not e  To  r emov e  t h e  ROI ,  r i gh t - c l i ck  t h e  mouse  t o  s e e  t h e  menu ,  c l i ck  
C l ea r  Too l ;  l e f t - c l i ck  anywhere  on  th e  ROI ,  r i gh t - c l i ck  t o  s e e  t h e  
menu ,  and  c l i ck  D e l e t e  Anno t a t i on ;  a l t e rna t i v e l y ,  c l i ck  on  th e  ROI  
and  when  i t  t u rn s  y e l l ow ,  p r e s s  t h e  D e l e t e  k ey  on  th e  k eyboa rd .  

Using Layout and Rotate in 2D view 

Layout is available for 2D, only.  Layout lets you alter the number of images presented on the Viewing 
tab.  Rotate lets you turn the image with an X plane. 

No t e  Any  mod i f i c a t i on s  you  make  a r e  no t  sav ed  t o  t h e  image .  

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the 2D tab to drop down the panel. 

 To adjust the layout of the image (that is, how many images appear in the viewing area, for example 
1x1 up through 10x10), click the Rows and/or Columns dropdowns to select how many views of the 
image you want to show. 
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Figure 333: Layout (viewing tools) 

No t e  The  number  o f  row s  and  co l umns  de t e rm in e  how many  images  you  w i l l  s e e  
a t  one  t ime .  

 
Figure 334: Windowing adjustment 

 To rotate the image, click the dropdown (under Rotate) to select the angle to rotate the image(s). 

 Click the Rotate button to see the image turn to the new (angle) position selected in the previous 
step. 

 
Figure 335: Rotate (viewing tools) 

Applying a grid to your image(s) in 2D 

 Select a patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 
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The Viewing tab is enabled and the 2D tab is open. 

 Change the size of the grid (in mm) in the Grid (mm) text box. 

 
Figure 336: Grid (mm) 

 Click the Apply button to apply a grid over the image. 

 Perform one of the following to remove the grid: 

• Click the Reset button. 

• Enter 0 in the Grid (mm) text box and click the Apply button. 

Viewing images in MPR 

Multi-Planar Reformation (MPR) displays views of the volume in an Axial, Coronal, and Sagittal plane, 
as shown in Figure 344. 

Viewer layout is 2 x 2 in the figure below. 

 
Figure 337: MPR tools 

 Select a patient from Patient Browser, select the series to view. 
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 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the MPR tab to drop down the panel. 

 Use any of the image tools to view the image differently (zoom, pan, invert, flip, and so on) to 
manipulate your image. 

No t e  Ano the r  way  t o  v i ew  MPR  t oo l s  i s  t o  move  t h e  mous e  ove r  t h e  image  and  
r i gh t - c l i ck .   The  f o l l ow ing  r i g h t - c l i ck  menu  op t i on s  appea r :  

 A c t i v a t e  Window Too l ,  Ac t i v a t e  Zoom Too l ,  Ac t i v a t e  Pan  Too l ,  A c t i v a t e  
Ang l e  Too l ,  Ac t i v a t e  L ine  Too l ,  Ac t i v a t e  A r row Too l ,  Ac t i v a t e  T i l t  Too l ,  
C l i ck  t o  Inv e r t ,  and  C l e a r  Too l .  

 Click the  (Tilt) tool to provide each view with a rotation marker. 

A white circle appears around the image(s). 

 Adjust the image angle by using left-mouse to move the circle clockwise or counter-clockwise. 

 Click the Reset button to reset images back to the original setting(s). 

You cannot undo this action. 

Understanding and using slab 

Multi-Planar Reformation (MPR) allows images to be created from the original Axial plane in the 
Coronal, Sagittal, or Transverse plane.  MPR is used to assess the extent of disease processes in the 
cranio-caudal direction.  MPR is fast, uses all the attenuation values in the dataset, and can easily be 
performed at the workstation.  MPR however, provides only a two-dimensional (2D) display of the image 
data. 

Sliding slabs are an additional technique used to evaluate pulmonary vessels and airways, vertebral 
bodies, and cranial images among other applications.  Through the reformation process, axial images are 
stacked creating a volume that can be dissected in different planes.  The thickness and spacing of each 
dissection or slab can be varied to meet the needs of the viewer.  Rather than collect data from a series of 
individual sections of equivalent thickness, a series of overlapping minimum and maximum intensity 
projections are combined in multiples or slabs to create a thicker image.  The reformations can be 
displayed in a minimum, maximum, or average projection. 

MPRs should be built from the .625mm or 1.25mm slices. 
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Creating the slab 

 Select a patient from Patient Browser. 

 Select the thin data set to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the MPR tab to drop down the panel. 

 Click the Sagittal, Coronal, or Transverse plane to create your slab. 

  
Figure 338: Image formats 

The Secondary Series options are enabled. 

 Click the Enable Slab option to activate the slab controls panel. 

The Enable Slab option is inactive (dim) if no MPR view is selected. 

 
Figure 339: Enable Slab option under Secondary Series 

The following defines the options: 

• Slab Thickness The value that defines the thickness of the slab. 

• Slab Spacing  The value that defines the space between the start of one slab and 
the next. 

• Slab Rendering Options  Where you define what pixel values are displayed in each slab: 
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• Maximum Intensity  The highest pixel values for all slices within the slab is displayed. 
• Minimum Intensity The lowest pixel values for all slices within the slab is displayed. 

• Average  The pixel values of all slices within the slab are added up and the 
average value for each pixel is displayed. 

• Series Description Text field for naming the series of images created after clicking the 
Generate button. 

• Yellow lines 

Define the slab thickness.  The knobs at the end allow you to 
adjust the thickness using the standard mouse pointer. 

Changes made to the slab thickness using the markers are 
reflected in the value defined in the control panel. 

• Cyan lines 
Define the slab FOV and dictate the range of a new series when 
generated.  The cyan lines are adjustable by clicking and dragging 
on the lines themselves; both lines (at one time) are moved by 
clicking and dragging the central circle marker. 

• Red, blue, and green 
lines Define the cross sections of the anatomy being viewed. 

• Generate Generates a new series with the name given in the Series 
Description field, based on the selected MPR view pane. 

 For the Slab Thickness (in mm) in the text box, enter the thickness or drag the yellow boxes on the 
image for a new-defined thickness. 

 Enter the Slab Spacing (in mm) in the text box. 

 Click the Slab Rendering Options dropdown to select the appropriate option. 

 Drag the cyan line(s) (the reference) to set the slab Field of View (FOV) range for the new series or 
drag the small cyan circle to move the FOV. 

 
Figure 340: Use the blue line to set FOV 

 Preview the slab in the bottom-right window. 
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 Enter the slab name and click the Generate button. 

A Saving Series popup appears followed by a Capture Complete popup. 

When the series is complete, the Capture Complete pop-up appears. 

 
Figure 341: Capture Complete popup message – Series saved 

The new MPR image(s) appear in the Patient Browser under the patient with the description 
(identifier) entered in the Series Description field. 

Using Virtual Tilt  

 Select a patient from Patient Browser. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the MPR tab to drop down the panel. 

 Click the  (Tilt) tool and move the mouse pointer over the white circle to modify your tilt. 

 
Figure 342: Tilt white circle 

 In the Series Description text box, enter the series after you set the FOV and slab thickness. 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 304 of 374 Viewing images in 3D 

 
Figure 343: Series Description text box 

Viewing images in 3D 

In 3D viewing, a 3-Dimensional image is created by stacking all the images of a scan on top of one 
another to create a 3-volume.  The initial display shows the 3D volume and a box appears around it.  
MPR planes also appear.  You can use the box to adjust the view how the image appears. 

On the image, when the pointer is double arrowed, you can expand or contract the box.  When the 
pointer includes two circular arrows, you can rotate the image in the box. 

No t e  Any  mod i f i c a t i on s  you  make  a r e  no t  sav ed  t o  t h e  image .  

 
Figure 344: 3D tools 

 Select a patient from Patient Browser and select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and open. 

 Click the 3D tab to drop down the panel. 

 Use any of the image tools to view the image differently (zoom, pan, invert, flip, and so on) to 
manipulate your image. 
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 To rotate the image up to 360o, click  (Rotate) and move the image with the mouse pointer 
to the rotation of choice. 

No t e  Ano the r  way  t o  v i ew  3D  t oo l s  i s  t o  move  t h e  mouse  ov e r  t h e  image  and  
r i gh t - c l i ck .   The  f o l l ow ing  r i g h t - c l i ck  menu  op t i on s  appea r :  

 A c t i v a t e  Window Too l ,  Ac t i v a t e  Zoom Too l ,  Ac t i v a t e  Pan  Too l ,  A c t i v a t e  
Ro t a t e  Too l ,  and  C l ea r  Too l .  

 Select a set of predefined, 3D-color-volume preset, click the Color Preset dropdown list to make a 
selection. 
• CT Angio 1  
• CT Angio 2  
• Circle of Willis  

 To change the rendering mode of 3D volume, click the Render mode dropdown list to make a 
selection. 

• Color  The particular colors given to ranges of HU units of the 3D 
volume. 

• MIP (Maximum Intensity 
Projection) The 3D volume consists of the highest intensity values. 

• Grayscale  The volume is shown in grayscale instead of color. 

 Click the Orientation drop-down box to assign an orientation: Inferior, Superior, Anterior, 
Posterior, Right, or Left, by selecting the plane in the dropdown. 

 Click the Reset button to reset images back to the original setting(s). 

You cannot undo this action. 

Viewing images in CTP 

Computed Tomography Perfusion (CTP) is viewer software.  The CTP viewer functionality is only 
possible if the optional perfusion package is set up and enabled on your system.  The CTP viewer 
package enables your system to view dynamic scans.  A scan must have been performed with perfusion 
protocols. 
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Figure 345: CTP tools 

No t e  Any  mod i f i c a t i on s  you  make  a r e  no t  sav ed  t o  t h e  image .  

Calculating and creating perfusion maps 

 Select a perfusion patient from Patient Browser, select the series to view. 

 To open the image, click the View Images button or double-click the series. 

The Viewing tab is enabled and the CTP tab automatically opens. 

 Use any of the image tools (zoom, pan, invert, flip, and so on) to view the image differently. 

 Click the  (Perfusion ROI) tool. 

The calculations produce three maps and the perfusion image: 

• Perfusion Images Top, left corner 

• Cerebral Blood Flow (CBF) Top, right corner 

• Cerebral Blood Volume (CBV)  Bottom, left corner 

• Mean Transit Time (MTT)  Bottom, right corner 
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Figure 346: Perfusion maps 

 Click the  tool to display peak image. 

The peak image displays the image that has the most visible contrast (based on arterial ROI 
placement). 

 Click the  tool to display Arterial Venous Flow Graph. 

 
Figure 347: Arterial Venous Flow Graph 

The graph displays flow of artery and vein with respect to time. 

 Click the  tool to cancel calculations and return to Calculation mode. 

 Click the Reset button to reset images back to the original setting(s). 

You cannot undo this action. 
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Chapter 12     Post Reconstruction 
The system stores multiple patient series of raw data to allow a post reconstruction – after patient 
examination has ended.  Post Reconstruction lets you reconstruct the acquired data using different 
algorithms, slice thicknesses, or apply image enhancement algorithms, such as noise reduction and 
windmill correction.  Raw data is used for this. 

 

Figure 348: Active Post Reconstruction tab 

The tools available to Post Reconstruction are identified in the table below. 

Table 49: Viewing tool 

Image  t oo l s  Too l  name  Ac t i on  

 
Stop Cancels the current, post-reconstruction request.  All 

images are generated until you click the Stop button. 

 
Field Of View Adjusts the Field Of View (FOV) prior to reconstruction. 

 
Clear Active  Resets tool to default pointer device. 

 
Windowing  Adjusts the width and level of selected image. 

 
Zoom Magnifies the image. 

 
Pan Adjusts the image on X or Y axis. 

 
Reset Resets the display to default viewer settings. 
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Performing Post Reconstruction 

The following figure identifies parts of Post Reconstruction: 

 
Figure 349: Post Reconstruction areas 

 Click a study in the exam table. 

Select a study that appears in the study table.  When you select one, all of the scanned series for that 
study appear in the series table. 

 Click the series in the series table. 

 
Figure 350: Post Reconstruction study and series tables 

The scan or series will load into the viewer.  The series protocol table and Reconstrcution 
Parameters and Options tabs are active. 
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Figure 351: Post Reconstruction series protocol table 

 View the study in .the viewing pane. 

 
Figure 352: Post Reconstruction viewing image area 

 To modify the FOV (if needed), perform the following: 

• Click the  (FOV tool), click the image, and drag the mouse to form a square. 

The size of the square appears in mm.  A circle appears in the middle of the square; this 
circle lets you move the field-of-view. 

• Click within the circle’s boundary and drag to move the FOV. 

• Click one of the two drag boxes on the corners to adjust the size of box. 

The square dimensions are adjusted as the size changes.  The FOV size cannot exceed the 
range of 50 - 250mm square.  The width dimension changes in the Width text box when you 
change the size; however, you can enter a dimension instead. 
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Figure 353: FOV resizing boxes 

No t e  You  can  a l s o  en t e r  a  num ber  i n  t h e  Wid th  (o r  X and  Y  box )  t o  de f ine  
a  sp ec i f i c  FOV .  

 A l te rna t i ve l y ,  c l i c k  the  Use  FOV Max  opt i on to  use  the  max imum 
FOV for  the  CereTom E l i t e .  

 Click the Sharpness dropdown to select a reconstruction algorithm. 

 
Figure 354: Post Reconstruction’s Parameters and Options tabs 

 
Figure 355: Reconstruction Parameters Sharpness dropdown 

The sharpness is modified by using one of the following kernels: 

• Low Noise QA 
• Soft Tissue 
• Pos. Fossa/Vessel 
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• Sharp 
• Bone 
• Sharp Lung 
• High Res QA 

 Click the Slice Thickness/Spacing dropdown to make a selection. 

 
Figure 356: Reconstruction Parameters Slice Thickness/Spacing dropdown 

The slice thickness and spacing are adjusted dependent on if you reconstruct an Axial or Helical 
scan: 

  

Figure 357: Axial (left) and Helical (right) scan slick thickness options 

 The # of Expected Images text box presents the system’s number of images for expected ranges. 

 Click the Options tab. 

 

Figure 358: Post Reconstruction Options tab 

 Click the Customized Bone Removal option. 

The Customized Bone Removal is related to Iterative Bone Correction or Second Pass Beam 
Hardening Correction.  The correction automatically adjusts the bone correction based on the size 
and density of the bone in the corrected image. 

 Click the Noise Reduction and Streak Removal options to correct these elements. 
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Noise Reduction is a semi-iterative reconstruction designed for the purpose of allowing low-dose 
scanning by decreasing the noise level in the reconstructed images.  Noise Reduction is 
recommended for pediatric scanning and for scanning large patients.  Currently, the option is only 
provided for post reconstruction. 

Metal Artifact Reduction (MAR) is an optional feature that can be enabled during post 
reconstruction by the user.   

Streak artifacts and beam hardening are often observed around metal leads, aneurysm clips, epilepsy 
probes or metal screws. Numerous factors contribute to these streaks including under‐sampling, 
photon starvation, beam hardening, and scatter. The streaks can be reduced using metal artifact 
reduction (MAR). MAR removes the metal from the image to reconstruct the soft tissue only, and 
then adds it back, greatly reducing the artifacts.   

The performance of the MAR depends on the interpolation methods used in both the metal 
replacement in the soft tissue images and the interpolation method used for correcting the 
sinogram.   

The MAR correction is only recommended to be used if the streaks due to the metal are deemed to 
be very disruptive of the reconstructed images and if they are interfering with the anatomical feature 
of interest. It is our recommendation that MAR be used only with Filtered Back projection 
algorithm. 

 Click the Level dropdown to select a new noise level to Low or High. 

 Click the Start button to generate a new dataset; click the Refresh button to return to the tables and 
remove any work you have done. 

When you click the Start button, the reconstructed image appears in the viewing pane. 

 
Figure 359: Please wait while the system performs data reconstruction message 

When the reconstruction is complete, the image appears in Patient Browser. 
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Chapter 13     Accessories and Options 
You will learn how to convert a bed, stretcher, or any type of adjustable surface into a scanning platform 
through the use of bed adapters and scan boards, in this chapter. 

To request the following catalog(s) to reference product descriptions/details and part numbers for the 
available accessories/options that are used with the respective scanner, see “Contact information” on page 
26: 

• 1-NL3000-158 U.S. CereTom Elite Product Catalog 
• 1-NL3000-157 (CereTom Elite) International Product Catalog 

When using a fixed scanner, keep in mind the table moves during the scan from one portion of anatomy 
to another while the gantry remains stationary.  With the CereTom Elite, a scanning platform is created 
and remains stationary while the gantry or scanner translates from one point to the other to cover the 
anatomy.  For example; when scanning the brain, the patient’s head is placed in a head holder and the 
gantry travels from the base of the skull to the vertex at prescribed intervals to complete the scan. 

A bed adapter is used as a secure mount to hold the silhouette scan board, which supports the patient’s 
head.  Different beds or scanning platforms require different adapters.  NeuroLogica manufactures many 
different bed adapters to fit a wide variety of hospital beds, stretchers, and Operating Room (OR) tables.  
The majority of the bed and stretcher adapters are designed to hold a silhouette scan board. 

The universal transfer board is used when no bed adapter is available for a particular bed.  It is placed 
under the patient and secured to the bed or stretcher with straps.  The board can be used on a bed, 
stretcher, or in the OR. 

 
WARNING  

 

Some accessories require adjoining posts to be inserted into respective mounting holes to 
be assembled onto the scanner/patient support.  Make sure the posts are inserted as 
straight as possible.  If the posts are inserted at an angle, this may deform and/or wear the 
respective posts prematurely. 

 
WARNING  

 

NeuroLogica Corp. recommends that the weight of the patient being positioned on the 
scan board cannot exceed the bed manufacturer’s safe, recommended, operating patient 
load.  Realizing patient safety is of the utmost importance, it is recommended that safe 
judgment be exercised at all times when it comes to the clinical care of patients.  There are 
a number of varying factors, such as the condition of the bed being used, unique patient 
anatomy, as well as the proper scan board, adapter installations, and positioning of the 
patient, per NeuroLogica Corp.’s clinical training guidelines and product labeling.  If any 
excessive wear or damage is noticed to any adapter or scan board, do not use it for a 
patient scan; contact a qualified service technician to assess, repair, and/or replace the 
device. 
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Using bed adapters 

Bed adapters are manufactured for specific bed models.  Prior to installing the CereTom Elite at a facility, 
a precise survey is conducted to ascertain the type of bed used the most with the CereTom Elite. 

Adapters are classified as follows: 

• Adapters that do not have posts and fit onto the frame of the bed by attaching to existing posts 
(below, left). 

• Adapters that do have posts and fit onto the frame by inserting the posts into an existing hole in 
the frame (below, right). 

• Adapters for OR tables, used in surgical cases. 
• Adapters for a neonatal scan platform for children. 

     
Figure 360: Bed adapter without posts (left) and bed adapter with posts (right) 

Using bed adapter safety straps 

The bed adapter comes with two straps that attach to the rings on the adapter and can be used to secure 
the patient to the silhouette scan board.  

 
Figure 361: Safety straps 

1. Identify the rings on the bed adapter as highlighted on the Hill-Rom and Sytrker In Touch adapters 
below. 
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Figure 362: Hill Rom bed adapter 

 
Figure 363: Stryker In Touch bed adapter 

2. Connect the hooks on the straps to the rings on the bed adapter as seen below. 

 
Figure 364: Straps attached to bed adapter 
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3. Attach the silhouette scan board to the bed adapter.  

 
Figure 365: Silhoutte scan board attached to bed adapter 

4. Position the patient on the Silthoutte scan board, and position the straps across the patients 
shoulders and upper chest to provide support and immobilization.  

 
Figure 366: Patient properly immobilized on scan board 

Attaching bed adapter with or without posts 

 Check the bed adapter label and bed model to make sure the adapter is designed to fit the bed. 

 Remove the head board from the bed. 

 Insert the bed adapter without posts onto the posts on the bed frame. 
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Figure 367: Bed adapter without posts insertion (setscrew showing under arrow) 

 Make sure the adapter is flush against the bed frame. 

 Secure the adapter to the posts by adjusting the setscrew (see Figure 367). 

 
Figure 368: Bed adapter T-square 

 Insert the silhouette scan board into the T-square and tighten. 

 
Figure 369: Bed adapter without posts shown being inserted into scan board 

No t e  Ensure  t h a t  t h e  bed ’ s  IV  po l e  doe s  no t  o bs t r uc t  o r  i n t e r f e r e  w i th  t h e  
S i l houe t t e  s can  boa r d .  

 Ensure  T- s qua re  i s  p rope r l y  t i gh t ened :  l i s t en  f o r  two  c l i ck s .  

 Press down on the silhouette scan board while tightening the T-square. 
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 Add the cushion to the head holder for the patient’s comfort. 

 
Figure 370: Silhouette with cushion shown on head holder 

The head board is now ready to receive the patient. 

 Move the patient up into the head holder, making sure the patient is up and high enough in the 
head holder that the scanner can easily move to the patient’s shoulders. 

 
Figure 371: Phantom shown on head holder 

 While the scanner is in Transport mode, align the patient with the scanner. 

 Lower the scanner (in Scan mode) and position the scanner over the patient. 
 

 

 
Figure 372: Patient position view from behind scanner 

 Make sure the head goes into the bore symmetrically. 
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The patient is now ready to be scanned. 

 
Figure 373: Patient ready to scan 

Transfer boards for adult, pediatric, and neonate 
patients 

Scan boards are customized for adult, pediatric, and neonate patients.  Universal transfer boards and 
silhouette scan boards are used for adults; pediatric and neonate scan boards, and platforms are designed 
for smaller patients. 

Table 50: Scan boards and their weight-bearing restrictions 

S can  boa rd  /  p l a t f o rm Weigh t  

Neonate scan platform 7.5kg / 17lbs 

Pediatric scan board 40.8kg / 90lbs  

Silhouette scan board 
Weight limit of board is equal to the weight limit of the patient 
bed; weight limit on portion supporting patient head is 7.5kg / 
17lbs 

Universal transfer board 
Weight limit of board is equal to the weight limit of the patient 
bed; weight limit on portion supporting patient head is 7.5kg / 
17lbs 

See also “Parts that potentially come into contact with the patient” on page 71. 

 
WARNING The weight limit for the superior portion of all scan boards (head) cannot exceed 7.5kg 

or 17lbs. 
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Using the universal transfer board and pediatric scan 
board 

The universal transfer board is a carbon-fiber, radiolucent board that is designed to work with any ICU 
bed or gurney.  The carbon-fiber board comes with a 0.5in. (thick) head board and 2in.x5ft. straps to 
strap the board to the ICU bed or gurney.  It also comes with 3in., 4in., 6in., and 12in. bed stiffeners. 

You can use the universal transfer board on any bed, table, or stretcher (with the CereTom Elite) when a 
bed adapter and silhouette scan board cannot be used or do not exist for a particular surface occupied by 
the patient.  Because you can attach the universal transfer board to almost any type of surface, it is used 
anywhere throughout the hospital including the ICU, OR, ER, and the pediatric ward.  Instead of 
attaching an adapter to a bed, the universal transfer board is placed on the mattress and secured with a 
strap.  The patient lies on the board with the patient’s head in the head holder.  The CereTom Elite is 
moved into position and the scan is performed. 

Using the universal transfer board and the pediatric scan board on the bed use the same procedure; 
however, you can use the pediatric scan platform (instead of the bed).  See the next section for 
instructions on using the pediatric scan platform. 

No t e  Ado l e scen t s  and  young  adu l t s  t oo  l a rg e  f o r  s cann ing  on  th e  ped i a t r i c  s can  
p l a t f o rm ,  and  no t  i n  a  bed  t h a t  u t i l i z e s  a  b ed  adap t e r  and  s i l houe t t e  s can  
boa rd ,  c an  be  s canned  on  th e  ped i a t r i c  s can  boa rd .  

    

    
Figure 374: Universal transfer board and bed stiffeners (left), and pediatric scan board on a platform (center) 

No t e  T ipp ing  o f  t h e  boa rd  i s  t h e  m a jo r  con ce rn ;  t h e r e f o r e ,  t h e  un i v e r sa l  t r an s f e r  
boa rd  mu s t  be  s e cu re l y  f a s t en ed  t o  t h e  su r f a c e  p r i o r  t o  p l a c ing  t h e  pa t i en t  on  
th e  boa rd .  
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The universal transfer board and/or pediatric scan board are stored on the left side of the CereTom Elite 

for easy transport.  

Figure 375: Universal transfer board storage 

The scan boards require mattress stiffeners.  Stiffeners provide a hard surface at the head of the bed to 
prevent the mattress from sagging when a scan is performed.  There are usually four mattress stiffeners 
stored with the CereTom Elite for easy transport. 

 
Figure 376: Four types of mattress stiffeners 

 Heed all warning labels when using the scan board. 
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Figure 377: Scan board warning labels 

 Select the appropriate mattress stiffener for the mattress size and insert. 

 

 
Figure 378: Mattress stiffener in place 

The pediatric scan board requires mattress stiffeners that provide a hard surface at the head of the 
bed to prevent the mattress from sagging with the weight of the patient when a scan is performed. 

There are four mattress stiffeners that can be stored on the CereTom Elite for easy transport.  See 
Figure 376. 

 Remove the scan board from the side of the scanner. 

 With the proper mattress stiffener inserted, apply the scan board. 

 Place the scan board on the mattress stiffener. 

 Position the board in accordance with the yellow, safety-warning stickers to avoid a tipping hazard. 

 Place the pad on the scan board. 

No t e  The  p ed i a t r i c  s c an  boa rd  i s  u s ed  w i thou t  a  pad .  

 For the pediatric scan board, do not extend the board beyond the mattress for proper placement. 
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Figure 379: Pediatric scan board properly positioned on the bed on a bed stiffener 

 When the board is properly positioned on the bed, secure it by using the safety strap. 

The safety strap must be attached to the board, passed completely under bed, and secured on the 
other side. 

    
Figure 380: Universal transfer board (left) and pediatric scan board (right) with safety strap installed 

 When the universal transfer board is securely fastened to the bed, transfer the patient to the bed, 
and secure the upper strap to the patient and the scan board. 

 When the patient is positioned and securely strapped in, position the patient in the scanner’s bore. 

 
Figure 381: Phantom on universal transfer board, safety strap in place 
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 Initiate the scan. 

Using the pediatric scan platform 

Note  Ped i a t r i c  s can  p l a t f o rm i s  u s ed  f o r  l a rg e r  ch i l d r en  t h a t  c anno t  be  suppor t ed  by  
t h e  in f an t /neona t a l  s c an  p l a t f o rm .  

 

 
Figure 382: Pediatric scan board and platform 

 
WARNING  

 

The pediatric scan platform is not a transportation device and should never be used to 
move a child from one location to another. 

 
CAUTION  

 

Always secure the child to the scan platform with the safety strap as described below to 
prevent motion and falls. 

 
WARNING Never leave the child unattended on the platform! 

 
CAUTION Read and observe all warning labels. 

 
CAUTION Never remove the scan board from the platform in order to use it separately. 
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Figure 383: Pediatric scan platform weight limit label 

No t e  The  p ed i a t r i c  s c an  boa rd  i s  u s ed  t o  s can  heads  on l y  on  ado l e s cen t s  t oo  l a rg e  
t o  be  s cann ed  on  th e  neona t a l  s c an  boa rd ,  bu t  t oo  sma l l  t o  be  s cann ed  on  
th e i r  r egu l a r  ho sp i t a l  bed  (7 . 5kg /17 l bs . ) .  

 Place the child on the scan platform and secure with the safety strap. 

   
Figure 384: Child placed on pediatric platform with safety strap (two views) 

 Position the platform in the scanner and center the patient using the laser light as a guide. 

 
Figure 385: Pediatric platform positioned by the scanner 
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 After the patient is properly positioned in the scanner, lock the platform in place by stepping down 
on plunger on both sides (see Figure 395). 

 When scan is completed, step on the silver tab to release the brake. 

 
Figure 386: Platform brake 

Using the infant and neonate scanning platforms and 
adapters 

Pediatric scanning is accomplished by using specifically designed products to safely cradle, support, and 
immobilize infants and children during a procedure. 

Neonates and infants can receive head and body scans by using the infant/neonatal scan platform: Figure 
387.  It Includes 0.5in. thick foam pad and 1.55in. thick foam pad. 

 

 
Figure 387: Infant and neonatal scan platform and pads (to the right) 

 

 
WARNING  

 

The neonatal scan platform is not a transportation device and should never be used to 
move a child from one location to another. 
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WARNING  

 

Always secure the child to the scan platform with the pediatric strap – as described in the 
following procedure – to prevent the child’s motion and falls. 

 
WARNING  

 

Never leave the child unattended on the platform! 

 
CAUTION  

 

Read and observe all warning labels. 

 
Figure 388: Weight limit for neonatal 

 In addition to the pads, always use the pediatric strap, to secure the patient to the platform. 

 
Figure 389: Pediatric strap 

 Drape the strap over the patient and secure one side around the patient with Velcro, then continue 
with other side, as shown. 

     
Figure 390: Applying pediatric strap onto the platform (three views) 
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WARNING  Never leave the child unattended on the platform! 

 Position the neonate or infant patient can be positioned on the platform head first for head scans, 
and feet first or head first for body scans. 

   
Figure 391: Proper position of neonate/infant for head scans (left) and body scans (right) 

The patient is now ready to be placed in scanner. 

No t e  The  p l a t f o rm r ema in s  s t a t i on a ry  dur ing  t h e  s c an  wh i l e  t h e  s cann er  move s  
du r ing  t h e  s can .  

CereTom Elite is specifically designed for the platform base to fit under the scanner while it is free 
to travel the entire scan length. 

 
Figure 392: Scanner shown to (easily) slide over platform base (two views) 

 When preparing to scan of a neonatal patient’s head, position the head first on the platform (as 
shown below) and slide platform into scanner opening, using laser light to properly position the 
patient. 
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Figure 393: Neonate/infant insertion for head scan (two views) 

No t e  Use  t h e  same  pro ce s s  ( i n  p r e v i ous  s t ep )  when  you  p r epa r e  t o  s can  th e  
neona t a l  pa t i en t ’ s  ch e s t  o r  abdomen .  

 

   
Figure 394: Neonate and infant insertion for body scan (two views) 

 When the patient is properly positioned in the scanner, lock the platform in place by stepping down 
on plunger on both sides. 

 
Figure 395: Neonate platform foot brake locations 

 When the scan is complete, step on the silver tab to release brakes. 

Using the CereTom Elite in the Operating Room 

The three methods used to convert the operating table into a scanning platform are as follows: 
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• An OR table adapter with the silhouette scan 
board 

 

• Universal transfer board   
• Doro® CereTom Elite intra-operative cranial 

stabilization system  
  

Each of the above mentioned devices are covered in the following sections.  It is important to note that all 
of these devices are used pre, post, and intra-operatively. 

Using the Operating Room table adapter 

The Operating Room (OR) table adapter functions in the same way as a bed adapter. 

 Attach the OR table and then the silhouette scan board to the adapter. 

The OR table adapter has two posts that fit into the adapter supplied by either the OR bed 
manufacturer or by Mayfield. 

 
Figure 396: OR table adapter 

 Adjust the OR table adapter to the openings in the mount and attach it to the mount. 

 
Figure 397: OR table adapter attached to mount 

 Attach the silhouette scan board to the OR table adapter. 
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 Add the padding to the head holder and slide the patient onto the board. 

You can perform this step at scan time or before the start of surgery.  If you perform it prior to 
surgery, the surgeon may choose to perform the surgery on the head holder. 

 Roll the scanner into place to start the study. 

Using the universal transfer board in the OR 

The universal transfer board is a carbon-fiber, radiolucent board that is designed to work with any ICU 
bed or gurney.  The carbon-fiber board comes with a 0.5in. (thick) head board and 2in.x5ft. straps to 
strap the board to the ICU bed or gurney.  It also comes with 3in., 4in., 6in., and 12in. bed stiffeners. 

In addition to using the OR adapter and silhouette board in the OR, the universal transfer board is often 
used in the OR.  The universal transfer board is secured to the surgical table by placing the board under 
the table cushions (if used) and securing the safety strap to the table by passing the strap under it and 
securing it on the other side.  The board is secured to the table prior to the patient’s arrival.  The patient 
is then placed on the table with the patient’s head in the head holder.  The surgery is performed with the 
patient on the universal transfer board.  When a scan is needed, the CereTom Elite is wheeled into place 
over the patient’s head and the scan is performed.  A study performed on the universal transfer board in 
the OR include, but is not limited to, tansphenoidals and shunt placements.  The universal transfer board 
is used for almost any non-invasive surgical procedure. 

Using the Doro CereTom Elite Intra-Operative Stabilization system 

The skull clamp set is specifically designed for the CereTom Elite portable CT scanner.  It offers 
exceptional stability with the freedom of fine adjustment for skull positioning.  It also provides a secured 
three-point fixation for optimum patient-placement in the CereTom Elite scanner (gantry). 

 
Figure 398: Doro CereTom Elite skull clamp 

 Remove the head board from the OR table. 

 With the head board removed and the park bench in hand, determine how much adjustment needs 
to be made in order that the bench can slide onto the surgical, table rails. 

 Remove the large Allen wrench from its holder on the side of the park bench to adjust the bench’s 
width. 
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Figure 399: Doro park-bench adjustment using Allen wrench 

 
Figure 400: Doro bench adjustment with Allen wrench 

Not e  Make  ad ju s tmen t s  ev en l y  t o  bo th  s i d e s .  

 After making the adjustments, slide the park bench onto the surgical table. 

 

   
Figure 401: Doro park-bench adjustments and positioning on bed (two views) 

 Tighten the bench securely to both side rails. 

Use caution when tightening the screws to ensure you do not unscrew the setscrew. 

No t e  Turn  c l o ckw i s e  t o  l oo s en  and  coun t e r c l o ckw i se  t o  t i gh t en .  
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Figure 402: Doro securing rails (two views) 

 If not already attached, attach the spindle device. 

No t e  Do  no t  r emove  t h e  sp i nd l e  de v i c e  rou t i ne l y .   Damage  can  o ccu r  t o  t h e  
c l amping  dev i c e  i f  t h e  c l amp i s  s e cu red  and  sp i nd l e  dev i c e  i s  no t  i n  p l a ce .  

 Do  no t  c l o se  t h e  c l amp when  empty .  

   
Figure 403: Doro; attaching spindle device (two views) 

 Assemble the skull clamp by attaching the radiolucent arms with the pin holders attached. 

     
Figure 404: Doro skull clamp assembly (three views) 

 Adjust the arm angles, if necessary, determined by the surgeon. 

With the arms attached, you can place the clamp on patient’s head. 
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Figure 405: Doro skull clamp arm adjustment 

 With the skull clamp assembled and the pins in place, the surgeon aligns the pins and affixes the 
skull clamp to the patient's head. 

 When the clamp is attached to the patient's head, the surgeon tightens the locking-clamp tension-
screw. 

 With the skull clamp secure to the patient's head, the surgeon supports the patient's head while the 
clamp is attached to the spindle of the park bench. 

        
Figure 406: Doro skull-clamp assembly with spindle to receive patient (three views) 

 Ensure the patient is appropriately positioned for a scan. 
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Figure 407: Patient in position for scan (two views) 

No t e  The  Doro  CereTom E l i t e  ho r s e shoe  comfo r t  h ead r e s t  (w i th  g e l  pad s )  c an  
a l so  b e  u s ed  f o r  po s i t i o n ing  and  a t t a ch ing  t o  t h e  Doro  pa rk  bench .  

 
Figure 408: Doro CereTom Elite horseshoe comfort headrest (with gel pads)
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Chapter 14     Scanner Drive System 
The Scanner Drive System (SDS) enables you (a single operator) to easily move the CereTom Elite 
wherever you need it to go.  The SDS is designed with an intuitive, variable,-speed joystick interface and 
a solid-state, electric drive that lets you navigate in and out of elevators, over doorway thresholds, or on 
any type of floor including carpet, with ease.  In addition to providing transport, the SDS serves as a cart 
for the CereTom Elite workstation.  The scanner must be docked to the SDS to move it. 

 
Figure 409: Scanner Drive System 

Be sure to read its warnings carefully and completely before using the NEU-CT-Gen III SDS.  Do not 
attempt to service the SDS.  Only skilled service people are permitted to service the SDS.  See “Hazard 
Information” on page 50. 

 
CAUTION  

 

Failure to heed these warnings may cause injury to the user, to others, or damage to the 
equipment. 

 
CAUTION  

 

When the SDS is unplugged from the wall, there are no lights or charge status indicators.  
There is no level of charge status shown. 

SDS overview 

Be familiar with this section before using the SDS. 

SDS considerations before use 

Before using the SDS, consider the following: 
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• If a problem is detected with the SDS, make sure repairs or adjustments were made to the SDS 
before using it. 

• Make sure the SDS operates easily and freely, and all parts work smoothly. 
• Check for excess noise, vibration, or a change in the ease-of-use. 

Noise, vibration, or change in ease-of-use can be signs of a problem and a need for servicing. 

• During scanner storage or non-use, undock the drive systems before storing the CereTom Elite 
scanner to prevent damage to the drive wheels; failure to detach the drive unit from the scanner 
during extended storage time will result in flat spots on the wheels where they contact the floor. 

• Docking height: the docking mechanism does not automatically adjust to match the scanner and 
must match the scanner docking-adapter height; the height is set during installation by 
NeuroLogica; the mechanism should engage without forcing. 

• If lock is on, all scanner functions are inactive. 

SDS control panel  

 
Figure 410: SDS control panel and description of components 

See the table below to identify the indicators. 

Table 51: Battery charge, LEDs, and SDS On and Off buttons 

Numbe r  Name  Desc r i p t i on  

1 Battery-charge status 
indicator Shows the amount of charge remaining for the SDS. 

2 LED 1 Illuminates when drive system is properly docked (mated). 

3 LED 2 Illuminates when locking lever is engaged and system is 
locked. 

4 LED 3 Illuminates when drive system is docked, locked, and 
pressurized. 

5 LED ! Illuminates when an error condition occurs. 

6 System On button Illuminates (green) when the SDS is on. 

7 System Off button Not illuminated (black) when the SDS is off. 
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SDS features 

 
Figure 411: SDS features 

Joystick features 

 
Figure 412: SDS joystick (REM421) 

Table 52: REM421 joystick features 

Symbo l  Fea tu r e  Ac t i on  

 
Battery gauge 

Identifies the battery usage of the SDS, which 
matches the battery indicator on the SDS 
control panel. 

 On / Off Powers on and off the joystick. 

 Speed up or down Specific drive setting to adjust speed of the 
SDS. 

 
Horn Sounds the horn. 

 For service purposes, only Not for clinical use. 
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Figure 413: SDS joystick (REM35) 

Table 53: REM 35 joystick features  

Symbo l  Fea tu r e  Ac t i on  

 

On / Off Powers on and off the joystick. 

 

Speed up or down Specific drive setting to adjust speed of the 
SDS. 

 

Directional joystick Moves the scanner in the forward, left, reverse, 
or right direction. 

No t e  The  j oy s t i ck  i s  modu l a r  and  u sed  on  o th e r  p roduc t i on  i t em s ;  howeve r ,  f o r  
S canner  Dr i v e  sy s t em (SDS ) ,  on l y  ba s i c  f e a t u r e s  a r e  ne eded  t o  ope ra t e  t h e  
j oy s t i ck  fu l l y .   The re f o r e ,  SD S  i s  no t  be  a f f e c t ed  by  som e  o f  t h e  j oy s t i ck ’ s  
non - c r i t i c a l  f e a t u r e s .  

 Your  j oy s t i ck  may  no t  l ook  exac t l y  a s  t h e  one  shown i n  F i g u re  412 ;  howeve r ,  
t h e  same  ba s i c  f e a t u r e s  de sc r i bed  in  Tab l e  52  app l y .  

 
CAUTION  The joystick must be programmed by trained personnel.  Failure to do so may cause 

severe damage to equipment and personal injury. 

Retractable power cord 

Consider the following: 

• Retractable power-cord reel and plug location (back of SDS). 
• Plug style will vary depending on factory installed elements based on geographic location and 

voltage requirements. 
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•   The warning that this uses hazardous voltage. 

 

 
Figure 414: SDS retractable power cord –retracted (left) and not retracted (right) 

 
CAUTION The system (including the workstation) should be plugged in at all times, when not in 

Transport mode, being transported or in scanning use, to help maintain battery life and 
proper system operation.  Failure to do so could result in permanent battery damage, 
which will require a service technician to repair. 

 
CAUTION If the system is unplugged and battery capacity reports to be 0%, permanent battery 

damage can occur. 

No t e  Be  su r e  t o  k eep  t h e  work s t a t i on  p l ugged  in  when  i t  i s  no t  i n  u se  in  o rde r  t o  
cha rg e  t h e  ba t t e ry .   Charge t ime  whi le  of f   is ~ ( appro x ima t e l y )  2  hours ;  whi le  i n  
use ,  ch a rg e  t ime  i s  ~  8  hours.  

 

Locating the power-failure, pneumatic, emergency-
release safety feature 

The pneumatic emergency release is a power failure safety feature that prevents the wheels from 
retracting if there is a power failure.  This manual (push) button will release the air pressure to the 
system in the event of a power failure. 
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Figure 415: SDS pneumatic emergency release 

 
WARNING  

 

Electric shock may occur when plugging this device into wall outlet.  Use only grounded 
or hospital grade outlets. 

 
CAUTION When not in transport, the SDS should be left plugged in to best prevent its batteries 

from draining. 

Detachable parts and accessories 

Attach the joystick cable to drive system by pushing connector into socket as shown. 
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Figure 416: SDS joystick cable connected to SDS, arrow pointing to release button 

Identifying the collision detection bumper switches 

 
Figure 417: SDS collision detector micro switches 

Collision recovery 

To recover from a bumper collision, press the joystick On and/or Off button to reset the system and 
drive, and/or remove any obstruction at the bumper.  See “Joystick features” on page 339 for information 
on REM421 and REM35 joystick models. 

Docking the SDS to the scanner 

Training for this equipment is provided by NeuroLogica Corp. or through a NeuroLogica authorized 
training program.  Only authorized personnel are permitted to operate this equipment.  See “Contact 
information” on page 26. 

No t e  Neve r  a t t empt  t o  s l i d e  t h e  l o ck ing  l ev e r  t o  t h e  un l ocked  po s i t i on  i f  t h e  SDS  i s  
l o cked  t o  t h e  s canner ,  a l r e ady .  

 Neve r  po s i t i on  your s e l f  be twe en  th e  SDS  and  th e  s canne r  when  th e  SDS  i s  
conne c t ed  t o  t h e  s canne r .  

 Neve r  l ower  t h e  s canne r  ( t o  I nva l i d  o r  S can  mode)  wh i l e  t h e  SDS  i s  conne c t ed  
t o  t h e  s canne r .  
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 Make sure the drive unit is unplugged from wall and the power cord is retracted completely into the 
unit; also be sure not to damage the ethernet cable if one is plugged in. 

 Make sure the locking lever is all the way to left side (in the unlocked) position. 

 
Figure 418: Locking lever in unlocked position 

 Press the Rocker-Switch-Lift UP (green) button to put the scanner in Transport mode (raised) 
position. 

 
Figure 419: Rocker-Switch-Lift Up and Down buttons 

LED 2 turns off. 

 Dock the SDS to the scanner by physically pushing the SDS to the scanner until docking adapter on 
drive is fully engaged in scanner’s docking adapter. 

When the adapter is successfully engaged in scanner’s docking adapter, LED 1 is no longer 
illuminated (turned off) on the SDS panel.  See See the table below to identify the indicators. 

Table 51 on page 338 to identify the location of the LED and a description. 

 Slide the locking lever to right to put the SDS in the locked position (moving left to right). 

If the drive unit is properly locked, LED 2 illuminates. 

 
CAUTION  Never stick any part of the body in the locking mechanism at the front of the SDS.  This 

is a pinching point. 

 Push the ON (green) button on the SDS control panel. 

The tensioning cycle begins for a period no longer than 1 minute, 20 seconds, at which time the 
tension cycle ends and LED 3 illuminates.  When the pressurizing is achieved, LED 3 illuminates. 
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 Plug the joystick into the drive unit while the SDS is pressurizing. 

 
Figure 420: Joystick plugged into SDS 

 Make sure the speed adjust on the joystick is turned to the slowest speed. 

 When the compressor stops, push the ON (green) button on the joystick. 

The On (green) button should remain illuminated (lit). 

No t e  I f  t h e r e  i s  a  ma l func t i on  in  d ock ing ,  l o ck ing ,  o r  t roub l e  w i th  t h e  SDS  
e l e c t ron i ca l l y ,  t h e  r i gh t -mos t  LED !  w i l l  i l l um ina t e .   LED !  i s  t h e  f au l t  
i nd i ca t o r ;  i f  LED !  i l l um ina t es  a t  any  t ime ,  t roub l e shoo t  t h e  s i t ua t i on .  

The SDS is ready to move the scanner. 

 Set the speed adjust to ~ (approximately) half way on the jostick. 

 Use the joystick lever to control scanner motion (speed) and direction. 

Undocking the SDS to the scanner 

 Push the Off (black) button on SDS panel and wait for cycle to end. 

This may take 20 seconds.  You will hear the system depressurizing. 

 Unplug the joystick cable and store on the joystick. 

 
Figure 421: Joystick connector (attached and unattached) 

 When the system is fully depressurized, slide the locking lever to the unlocked position (moving it 
right to left). LED 2 will turn off at this time.  
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 Wheel the SDS away from the scanner.  LED 1 will turn off at this time. 

 
CAUTION  

 

To prevent movement/steering problems caused by wheel flat spots, disconnect the SDS 
from the scanner when done transporting or moving the scanner.  Do not store the 
system and SDS docked together. 

Workstation location on SDS 

 
Figure 422: SDS and workstation (laptop computer) in locked storage tray 

Cleaning the SDS 

NeuroLogica recommends to clean the SDS between uses as described in the sections below. 

 
WARNING  

 

Before cleaning the drive system, be sure to disconnect the SDS from the wall outlet 
(power source).  Failure to do so could result in electrical shock and cause severe injury 
to you and/or damage to electrical components. 

 
CAUTION 

 

Do not allow electrical components to become wet.  For eye and hand protection, it is 
important to wear safety glasses and rubber gloves respectively. 

Cleaning the outside of the SDS 

 Prepare detergent/disinfectant (regulated by EPA as hospital disinfectant) solution according to 
instructions on label for correct usage. 

• Use a basin or spray bottle (with product label). 

• Use a pump (usually on detergent/disinfectant containers) to dispense the concentrate in the 
basin or spray bottle, then fill with correct amount of tap water. 

• If using a spray bottle, empty and rinse out after use. 
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No t e  The  s t a b i l i t y  o f  t h e  so l u t i on  i s  unknown a f t e r  2 4  hour s ;  t h e r e f o r e  a  f r e sh  
pr epa ra t i on  o f  c l e an ing  so l u t i on  mus t  be  p r epa r ed  f o r  e a ch  day  o f  
c l e an ing .  

 Use swabs moistened with cleaning solution, clean and remove any dust, soil, or foreign matter; 
allow all components to air dry. 

 Wipe down and clean the frame of device, and allow to air dry; return to its storage area. 

No t e  Wash  (a t  2 5 °C)  w i th  neu t r a l  d e t e rg en t s ,  on l y ;  s o f t en ing  ag en t s  a r e  no t  
a l l owed .  

The following recommended products are registered by the EPA as hospital disinfectant; these solutions 
are quaternary ammonium compounds and are used in environmental sanitation of non-critical surfaces: 

• TB Quat™ is a cleaning solution manufactured by ABC Compounding Co. 
• Wex-cide™ is a disinfectant manufactured by Wexford Labs, Inc., product number Wexcide128. 

Maintenance of the SDS 

 
WARNING Maintenance checks and all service must be performed by technicians trained by 

NeuroLogica Corp.  See page 26 for NeuroLogica contact information. 

SDS specifications 

Table 54: SDS specifications 

Overa l l  w id th  26-5/8in. (26.6275cm) 

Overa l l  h e i gh t  42in. (106.68cm) 

Overa l l  l eng th  20-1/8in. (51.1175cm) 

He igh t  ove r  h and l e  32 ½in.   (82.55cm) 

Weigh t  EST 400lbs (151.44kg) 

Ba t t e ry  powe r  (2 )  12  VDC (3 3  aH l ead  
a c id )  800Wh 

Max pr og rammed  spe ed  fwd .  1.6MPH 

Max r e cha rg e  t ime  6.2hrs. 

Max  con t inuou s  ope ra t i on  8hrs. 

Lock ing  and  un l o ck ing  cy c l e s  20 

Hrs  t r an spor t  ove r  f l oo r s  2hrs. 

Hr s  sy s t em l o cked  no  ex t e rna l  power  2hrs. 
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Max  s l o pe  ho l d ing  ang l e  w i th  s cann er  7º C (44.6º F) 

Max  doorway  t h r e sho l d  1in. (2.54cm) 

Max  e l eva t o r  t h r e sho l d  ¾in. (1.905cm) 

He igh t  t o  l o ck ing  adap t e r  8.59in. - 8.69in. 

Max/Min  s t o r ag e  t empe ra tu r e  -25º C to 70º C (-13º F to 158º F)  

Max/Min  ope ra t ing  r e l a t i v e  humid i t y  95%/20% 

Max/Min  s t o r ag e  r e l a t i v e  humid i t y  85%/20% 

Max/Min  ambi en t  ope ra t ing  t empera tu r e  40º C/5º C (104º F/41º F) 

Understanding the symbols and product-marking plate 

Table 55: Symbols and product-marking plate 

Symbo l  Desc r i p t i on  

 Indicates alternating current. 

 Indicates protective earth (ground). 

 
Indicates a caution: consult accompanying documents. 

 
Indicates a caution: risk of electrical shock. 

 
Indicates electrostatic sensitive devices. 

 
Indicates a warning: high temperature. 

 

Indicates temperature limits. 

 
Indicates mechanical deactivation device. 

 

Indicates a radiation precaution; may be affected by radiation from 
other sources; may produce interference that affects other equipment. 

 
Crush warning. 
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S ymbo l  Desc r i p t i on  

 
Foot/toe crush warning when lowering machine. 

 
Indicates a coil power cord. 

 
Indicates a chain hazard could cause severe personal injury. 

 
Indicates to keep away from rain for packaging. 

 
Indicates a humidity limit for packaging. 

 
Indicates a warning: battery charging. 

 Indicates fuse usage. 

 

Indicates accompanying operating instructions in the user manual 
must be followed to safely operate equipment. 

 
Legal Manufacturer Symbol 

 
CE Mark or Conformité Européenne 

 

Intertek ETL (Edison Testing Laboratories) Mark 

 European Authorised Representative Symbol 

 
Medical Device Symbol 
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No t e  D i s r ega rd ing  in fo rma t i on  on  sa f e t y  i s  con s ide r ed  a bno rma l  u se .  

Listing of replacement parts for SDS 

To ensure proper compliance requirements of replacement parts, (for example, cables and accessories), 
parts must be purchased through NeuroLogica Corp. 

 
WARNING 

 

Using other manufacturer cables and accessories may affect EMC performance.  
Unauthorized use of these items will void warranty and may cause harm to patient, 
others and/or equipment. 

Table 56: SDS parts and their part number 

I t em name Pa r t  numbe r   I t em name Pa r t  numbe r  

Cord Reel 165-200  I/O Controller PCB 162-300 

Battery WKA12-33C  User Interface PCB 164-100 

DX Unit 165-101  Lever Arm Ball 165-107 

Compressor 165-203  Air Spring 165-205 

Joystick CT 165-202-CT  Micro-switch 165-106 

Joystick SP 165-202-SP  Wheel 3in. 500lbs 165-220 

3-Way In-line 
Valve 165-104  Casters and Wheel 

3in. 500lbs 165-221 

Joystick Cable 
Internal 154-402  Drive Wheel 6in. 165-200 

Joystick Cable 
Receptacle 218-108  R.H. Motor 20014 R 

Joystick Cable 
Detachable 218-107A  L.H. Motor 20015 L 

Power 
Distribution PCB 162-500  Bumper Assembly 241-129 

Electromagnetic Comparability Test Report 
information 

Tested by Intertek Testing Services NA, Inc., 70 Codman Hill Road, Boxborough, MA 01719 

Report Number Intertek 100067600BOX-002a 

Standards IEC 60601-1-2:2004 
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 Glossary 

 

A 
  

algorithm  Mathematical filter applied to raw data during CT 
image reconstruction to remove blurring artifact 
inherent to back-projection.  Also referred to as a 
kernel. 

annotation  User comments or text added to an image. 

anterior Front of the patient’s body 

Application Entity (AE) An end point of a DICOM information exchange, 
including the DICOM network or media interface 
software; that is, the software that sends or receives 
DICOM information objects or messages.  A single 
device can have multiple AEs. 

attenuations The reduction in intensity of a radiation beam as it 
passes through a substance. 

Automatic Exposure Control (AEC) Software used to adjust or modulate the mA throughout 
an acquisition to reduce patient radiation dose to a 
minimum. 

Axial scan mode Data acquisition while the scanner remains stationary.  
The scanner position may be incremented between 
exposures to collect data over a longer Z axis range.  
Also referred to as step and shoot. 

B 
  

beam hardening The phenomenon whereby low energy photons are 
absorbed as the x-ray beam passes through an object, 
resulting in an increase in the average photon energy of 
the beam. 

Bolus tracking Monitors flow of contrast media in vessel and triggers 
scan at optimal timing.  This is a scanner feature to 
automatically initiate a prescribed Axial, Helical or 
Dynamic scan when a threshold level of contrast 
enhancement is reached at a specified region of interest. 
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C 

  

center x, center y  Off-center reconstruction coordinates. 

collimation Restricts x-ray to only the selected anatomy, minimizing 
dose to patient and reducing scatter. 

Computed Tomography Angiography 
(CTA) 

A test that uses x-rays to provide detailed pictures of the 
heart and the blood vessels that go to the heart, lung, 
brain, kidneys, head, neck, legs, and arms.  A CT 
angiogram can show narrowed or blocked areas of a 
blood vessel. 

Computed Tomography Dose Index 
(CTDI) 

An approximate measure of the radiation dose received 
in a single CT section or slice. 

Computed Tomography Dose Index 
Volume (CTDIvol) 

Represents the dose for a specific scan protocol, which 
takes into account gaps and overlaps between the 
radiation-dose profiles from consecutive rotations of the 
x-ray source.  The CT dose index volume is noted as 
CTDIvol.  The CTDIvol is calculated differently for 
both the Axial and the Helical mode: 

• For Axial scan mode:   CTDIvol = [ (N x T)/I ] x 
CTDIw 

• For Helical scan mode: CTDIvol = 1/pitch x CTDIw 

Computed Tomography Dose Index 
(CTDIw) weighted average 

The measure of ionizing radiation exposure per slice of 
data acquisition.  CTDI represents the integrated dose 
along the Z axis from one axial CT scan (one rotation 
of the x-ray tube).  The CT Dose Index is noted as 
CTDIw. 

Computed Tomography (CT) number Relative value assigned to each pixel to quantify the 
attenuation occurring in each voxel in comparison with 
the attenuation of water.  The calculated CT number for 
a given pixel is given in Hounsfeld units (HU). 

Computed Tomography Perfusion (CTP) Evaluates cerebral perfusion or level of blood flow in the 
brain by monitoring the initial passing of iodinated 
contrast media through the vasculature of the brain. 

contrast media Used to improve sensitivity and specificity of clinical 
diagnoses.  Three types are intravenous, oral, and 
intrathecal. 
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contrast resolution The ability of a CT system to detect an object with a 
small difference in linear attenuation coefficient from 
the surrounding tissue.  Also referred to as low-contrast 
detectability or sensitivity. 

D 
  

Digital Imaging Communication in 
Medicine (DICOM) 

Digital Imaging and Communications in Medicine, or 
DICOM, is a standard that helps people doing work in 
the field of radiology.  The DICOM standard is 
designed to promote communication and integration 
between a variety of radiology imaging systems and 
equipment used in filmless radiology. 

digital tilt 
The ability to correct the image post acquisition and 
correct positional inaccuracies prior to sending to 
PACS. 

dose Amount of ionizing radiation absorbed by patient per 
unit mass. 

Dose Length Product (DLP) The measurement of dose for an entire series of CT 
images.  DLP is equal to the calculated dose per section 
multiplied by the length of a CT acquisition along the Z 
axis. 

Dynamic Host Control Protocol (DHCP) A standardized network protocol used on Internet 
Protocol (IP) networks.  The DHCP is controlled by a 
DHCP server that dynamically distributes network 
configuration parameters, such as IP addresses, for 
interfaces and services. 

Dynamic scan mode (multiple detector 
widths) 

Data acquisition at multiple time points over the same 
anatomic location(s). 
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E 
  

Electromagnetic Compatibility (EMC) The branch of electrical sciences that studies the 
unintentional generation, propagation, and reception of 
electromagnetic energy with reference to the unwanted 
effects (Electromagnetic interference (EMI)) that such 
energy may induce. 

Electromagnetic Interference (EMI) A disturbance generated by an external source that 
affects an electrical circuit by electromagnetic induction, 
electrostatic coupling, or conduction.  The disturbance 
may degrade the performance of the circuit or even stop 
it from functioning. 

F 
  

Field of View (FOV) The diameter of the acquired attenuation data displayed 
across the image matrix. 

H 
  

Helical  

 

A CT acquisition whereby an x-ray acquisition whereby 
the x-ray tube and scanner move continuously during 
scanning, yielding a data set in the form of a helix.  Also 
referred to as spiral. 

Hospital Information System/Radiology 
Information Systems  (HIS/RIS) 

A Radiology Information System (RIS) is the core 
system for the electronic management of imaging 
departments.  The major functions of the RIS can 
include patient scheduling, resource management, 
examination performance tracking, examination 
interpretation, results distribution, and procedure 
billing.  RIS complements Hospital information systems 
(HIS) and Picture Archiving and Communication 
System (PACS), and is critical to efficient workflow to 
radiology practices. 

Hounsfield Unit (HU) The unit of the CT number scale assigned to each pixel 
to quantify relative attenuation. 
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I 
  

interscan delay time Minimum amount of time that must transpire between 
end of one scan and initiation of next scan.  Interscan 
delay times include idle time between scans to allow 
tube cooling. 

Iterative Bone Correction (IBC) A feature build into the reconstruction software, which 
performs a correction on every single Axial image the 
scanner produces, including both primary series from a 
scan as well as secondary reconstruction images.  
Current IBC settings were chosen to provide optimal 
correction for standard medical imaging; however, the 
setting can be customized as needed. 

K 
 

 

kernel A mathematical filter applied to raw data during CT 
image reconstruction to remove blurring artifact 
inherent to back-projection.  Also referred to as an 
algorithm. 

L 
  

Liquid Crystal Display (LCD) A form of visual display used in electronic devices in 
which a layer of a liquid crystal is sandwiched between 
two transparent electrodes.  The application of an 
electric current to a small area of the layer alters the 
alignment of its molecules, which affects its reflectivity 
or its transmission of polarized light and makes it 
opaque.  An LCD is used on the scanner and is a touch 
screen. 

M 
  

mAs  Tube current-time product: The product of tube current 
and exposure time per rotation, expressed in units of 
milliampere seconds (mAs). 

 

matrix Two dimensional grid numbers arranged in rows and 
columns. 
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Maximum Intensity Projection (MIP) The multiplanar reformation technique that displays 
only the maximum pixel value along a ray traced 
through the object to the viewers assumed perspective in 
front of the viewing monitor. 

Mean Transit Time (MTT) A common measurement during CT perfusion studies 
of the brain.  Refers to the average transit time, in 
seconds, needed for blood to pass through a given 
region of brain tissue. 

milli amperage (mA) Tube current: the number of electrons accelerated across 
an x-ray tube per unit time, expressed in units of 
milliampere (mA). 

Modality Performed Procedure Step 
(MPPS) 

A mechanism for modalities to pass information about 
the imaging performed back to the HIS/RIS or PACS. 

Modality Worklist Manager Scheduled (but not yet scanned) patient list. 

motion artifact Voluntary and involuntary patient motion during CT 
scan, appearing as a streak artifact on image; ghosting 
or blurring of image. 

Multiplanar Reformatting (MPR) The process of displaying CT images in a different 
orientation from the one used in the original 
reconstruction.  Allows for reconstruction of images in 
planes that would otherwise be difficult or impossible to 
acquire with CT.  Requires only image data.  Raw data 
is not utilized. 

N 
  

noise Random statistical variations in the signal.  Can be 
quantum noise, electronic noise due to lost signal, or 
artifact noise.  Manifests itself as overall graininess of 
the reconstructed image. 

P 
  

partial volume artifact Occurs when an object is only partly positioned within a 
voxel or is much smaller than the overall voxel volume.  
The object’s attenuation is not accurately represented by 
the pixel value.  Overlapping reconstructions further 
reduce partial volume artifacts. 

  



NL3000 CereTom Elite User Manual Revision 35 

 

Appendix A    MCS-140 Data Sheet Page 357 of 374  

 

patient coordinates References are as follows: 

• X    left to right. 

• Y    anterior to posterior. 

• Z    head to feet. 

Patient Browser, local database  Where the already-scanned patient list is stored. 

peak kiloVoltage (kV) The penetrating power of the photons coming from the 
x-ray tube. 

Picture Archive and Communications 
Systems (PACS) 

Stores medical information, including 2D images, and 
3D medical images.  All modern PACS setups will work 
with DICOM. 

pitch In Helical mode, refers to the speed of the scanner 
movement over the table as the scanner rotates. 

pixel A single, picture element of image matrix. 

post reconstruction  Prescribing the reconstruction parameters after scan 
acquisition. 

projection View of anatomical cross-section from a particular 
vantage point. 

prone Patient lying on stomach. 

protocol  Prescribing the reconstruction parameters prior to a 
scan acquisition. 

Q 
  

Quality Assurance (QA) Procedure of performing periodic specified tests or 
measurements to assure that a set quality level, as 
specified by system manufacturer, has not been 
compromised. 

R 

  

Radiation Safety Officer (RSO) The person within an organization responsible for the 
safe use of radiation and radioactive materials as well as 
regulatory compliance. 

Radio Frequency Interference (RFI) Also called Electromagnetic Interference (EMI), is an 
unwanted disturbance that affects an electrical circuit 
due to electromagnetic radiation emitted from an 
external source. 
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raw data A transmission measurements obtained by the detectors 
used to mathematically reconstruct the CT image. 

reconstruction filter Used to ensure accurate anatomy reconstruction.  Also 
allows for either spatial resolution or low-contrast-
resolution enhancement. 

Region Of Interest (ROI)  Provides a quantitative analysis of the Hounsfield values 
of a specific anatomic area.  A graphic outline in the 
shape of a circle is placed over an area on the image.  
Software calculates the average CT number in HU 
withering the ROI. 

resolution  A scan time, per slice, in Axial mode, only.  Resolution 
is meant to signify lower noise level and improved 
features – recognized in the scanned image. 

retrospective reconstruction Reconstruction performed after the initial prospective 
reconstruction.  Multiple retrospective reconstructions 
of raw data are possible, with changes to display FOV, 
algorithm, image center, and so on. 

S 
  

scan delay 

The time between the initiation of contrast agent 
administration and CT data acquisition.  The chosen 
scan delay determines the phase of contrast 
enhancement for a given CT acquisition. 

scan protocol A list of scanner-load parameters used to perform an x-
ray exposure. 

scan types Axial, Helical, Dynamic, Reference, and Scout. 

Scanner Drive System (SDS) The self-contained, rechargeable, battery-powered 
transportation system is designed to facilitate 
transporting the CereTom Elite x-ray CT scanner. 

scout 

 

Digital survey radiograph acquired by the CT system for 
the purpose of prescribing the cross-sectional 
acquisition.  Similar to a conventional radiograph, the 
scout is produced by translating the scanner over the 
patient without tube or detector rotation.  Also referred 
to as topogram or scanogram. 

series A set of images acquired in a scan. 

slice separation  The distance between the center of one CT slice and the 
center of the next slice. 

slice thickness The dimension of a constructed CT slice along the 
longitudinal direction of acquisition (Z axis). 
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spatial resolution The ability of a CT imaging system to display fine 
details, separately.  Given in units of line pairs per 
centimeter (lp/cm). 

supine Lying on back. 

T 
  

temporal resolution  The ability of a CT system to freeze motion and provide 
an image – free of blurring. 

Test Bolus  Scan mode used to measure the contrast transit time 
using a small injection of contrast media. 

threshold The CT number (Hounsfield Unit (HU)) where bolus 
tracking tool will trigger the system to begin the scan. 

Time Attenuation Curve (TAC)  A graph of the contrast enhancement versus time.  TAC 
is used to determine blood flow rate in seconds for 
contrast timing. 

time delay  Monitoring delay: Time from injection to the start of 
monitoring scans. 

Transverse plane Perpendicular to direction of Z axis. 

V 
  

Volume Rendering (VR) image or object A 3D modeling technique that utilizes the entire 
acquired dataset but adjusts the opacity of the voxels 
included in the 3D image according to their tissue 
characteristics. 

voxel Abbreviation of volume element.  Refers to the volume 
of tissue represented by a pixel in the matrix used to 
display the CT image. 

W 
  

Window Level (WL) The range of pixel values assigned a shade of gray in the 
displayed CT image.  Window width controls the 
contrast of the CT image.  The pixel value given in 
Hounsfield Units (HU) is at the center of the window 
width.  Window center controls the brightness (density) 
of the CT image. 
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Appendix B  Error Codes 
Table 57: Error code list 

E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

0 NO_FAULT Success.  No error 
occurred N/A N/A 

1 ACQUISITION_TE
RMINATED Not an error 

Acquisition has 
terminated normally 
(or user clicked 
Cancel) 

N/A 

2 XRAY_TEMPERAT
URE_FAULT 

Temperature fault 
was detected at x-ray 
tube 

X-ray tube 
overheated 

Allow time for x-ray 
tube to cool down 

3 XRAY_ARC_FAULT An x-ray tube arc 
was detected 

An arc occurred in 
x-ray tube or the 
HV Generator 

Contact Technical 
Support for service 

4 XRAY_HIGH_MA
_FAULT 

Monoblock high mA 
condition detected 

Beam current 
exceeds set value by 
more than 5% for 
100 ms or more 

Contact Technical 
Support for service 

5 XRAY_LOW_MA
_FAULT 

Monoblock low mA 
condition detected 

Beam current is less 
than 95% of set 
value for 100 ms or 
more 

Contact Technical 
Support for service 

6 XRAY_LOW_KV_
FAULT 

Monoblock low kV 
condition detected 

X-ray tube voltage is 
less than 95% of set 
value for 100 ms or 
more 

Contact Technical 
Support for service 

7 XRAY_HIGH_KV
_FAULT 

Monoblock high kV 
condition detected 

X-ray tube voltage 
exceeds set value by 
more than 5% for 
100 ms or more 

Contact Technical 
Support for service 

8 XRAY_WATCHD
OG_FAULT 

Monoblock 
watchdog timeout 
condition detected 

Watchdog timer was 
not refreshed at a 
high enough rate 

Contact Technical 
Support for service 

 

 
3 There may be multiple causes that require a trained service technician to conduct an analysis and repair. 
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E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

9 XRAY_POWER_LI
MIT_FAULT 

[Placeholder for 
power limit fault] N/A N/A 

10 XRAY_INTERLOC
K_FAULT 

Interlock was de-
asserted to generator 

E-STOP was 
activated Deactivate E-STOP 

11 XRAY_BELOW_T
HRESHOLD 

Reference detector 
values are reading 
less than threshold 
value 

Indicates x-rays have 
been turned off  
(due to errors 2-10 
above) 

Contact Technical 
Support for service 

12 
CANNOT_WRITE
_TRANSMIT_QU
EUE 

When Data 
Acquisition System 
(DAS) views are 
acquired to disk 
during a scan, they 
are sent to a 
Transmit Queue 
from which they are 
sent to Recon 
computer over 
socket interface 
(ethernet);  if write 
of view to Transmit 
Queue fails, this 
error is flagged 

Likely causes of 
failing this write is if 
downstream data 
path is not 
functioning correctly 
(ethernet unplugged, 
scanner app not 
connected, etc) 
during a scan, and 
transmit queue is 
full and won't allow 
any more writes 

Contact Technical 
Support for service 

13 INCORRECT_RO
TATE_SPEED 

Indicates disk 
detected a rotation 
speed error 

Happens when a 
problem with tick 
fence, or has 
incorrect calibration 
parameters 

Contact Technical 
Support for service 

14 POSITION_ERRO
R 

Centipedes did not 
move specified 
distance 

Could be caused by 
incorrect calibration 
parameters, a 
centipede jam, an 
uneven floor 

Contact Technical 
Support for service 

15 VELOCITY_ERRO
R 

Centipede velocity 
not as expected 
during a Helical 
scan 

Could be caused by 
incorrect calibration 
parameters, a 
centipede jam, an 
uneven floor 

Contact Technical 
Support for service 



NL3000 CereTom Elite User Manual Revision 35 

 

Page 366 of 374 Appendix B    Error Codes 
 

E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

16 OFFSET_CAL_FA
ULT 

Offset calibration 
(done typically at 
beginning of every 
scan) has failed 

Due to bad view 
data from Disk 
Computer Assembly 
(DCA) 

Contact Technical 
Support for service 

17 AIR_CAL_FAULT Air calibration failed An object was in the 
bore 

Remove obstacle 
and perform another 
air calibration 

18 INVALID_PROTO
COL 

[Placeholder for 
invalid protocol 
error] 

N/A N/A 

19 INVALID_COMM
AND 

[Placeholder for 
invalid command 
error] 

N/A N/A 

20 INVALID_COMM
AND_SEQUENCE 

An invalid 
command sequence 
was detected 

Can happen when 
Disk Computer 
Assembly (DCA) 
receives Start Acq 
command from 
Scanner Control 
app, but is not in a 
READY mode. 

Contact Technical 
Support for service 

21 INVALID_PARAM
ETERS 

[Placeholder for 
invalid parameter 
error] 

N/A N/A 

22 XRAY_COMMUNI
CATION_ERROR 

Disk has detected a 
problem with serial 
port connection to 
monoblock 

HV generator fault, 
Disk Control 
Assembly (DCA) 
fault 

Contact Technical 
Support for service 

23 DCB_COMMUNI
CATION_ERROR 

[Placeholder for 
DCB 
communication 
error] 

N/A N/A 

24 
SUBSYTEM_COM
MUNICATION_E
RROR 

[Placeholder for 
subsystem 
communication 
error] 

N/A N/A 

25 RECON_ERROR 
Requested protocol 
has been rejected by 
Reconstruction app 

Recon computer 
error 

Contact Technical 
Support for service 
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E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

26 INSUFFICIENT_T
UBE_CAPACITY 

When preparing for 
a scan, this error is 
flagged if tube 
capacity is lower 
than anticipated 
threshold value for 
that scan 

X-ray tube too hot 
to perform 
prescribed procedure 

Tube needs time to 
cool down before 
scan can be run 

27 
INSUFFICIENT_B
ATTERY_CAPACI
TY 

When preparing for 
a scan, this error is 
flagged if battery 
capacity is lower 
than anticipated 
threshold value for 
that scan 

Battery was not 
recharged per 
instructions 

Battery needs to be 
recharged to 
minimum level by 
connecting it to AC 
outlet before scan 
can be run 

28 ESTOP_INTERLO
CK 

ESTOP button has 
been activated 

User depressed 
ESTOP button 

After respective 
issue has been 
resolved accordingly, 
user can deactivate 
E-STOP 

29 CENTIPEDE_INTE
RLOCK 

Centipedes are not 
engaged 

System is not 
positioned in Scan 
mode 

Lower system using 
Up/Down Rocker-
Switch-Lift to 
position it in Scan 
mode 

30 SAFETY_INTERLO
CK 

[Placeholder for 
safety interlock 
error] 

N/A N/A 

31 DAS_DATA_ERR
OR 

Disk Computer 
Assembly (DCA) 
has detected a Data 
Acquisition System 
(DAS) data error 
from DCB device 

Defective converter 
board assembly 

Contact Technical 
Support for service 

32 DAS_CALIBRATI
ON_ERROR 

Tick calibration data 
is invalid 

Disk Computer 
Assembly (DCA) 
has detected a Data 
Acquisition System 
(DAS) data error 
from Disk Control 
Board (DCB) 

Contact Technical 
Support for service 
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E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

33 HOME_TICK_ER
ROR 

Disk has detected a 
home tick error 
from DCB device 
(no home pulse 
detected) 

Typically this is a 
dirty/dusty tick 
fence assembly or 
defective tick board 
assembly 

Contact Technical 
Support for service 

34 TICK_ERROR 

Disk has detected a 
tick error from DCB 
device (incorrect 
number of ticks 
counted) 

Typically this is a 
dirty/dusty tick 
fence assembly or 
defective tick board 
assembly 

Contact Technical 
Support for service 

35 ROTATE_CONTR
OLLER_ERROR 

Rotate drive 
detected an error 
while performing 
homing operation 

Base computer 
assembly interface 
with rotate motor 
controller has a fault 

Contact Technical 
Support for service 

36 AIR_CAL_WARNI
NG 

Result of air 
calibration was out 
of tolerance 

When requesting a 
new scan, currently 
loaded air cal tables 
were generated from 
a previously failed 
air cal;  requested 
scan will be allowed 
to continue, but 
images may have 
artifacts;  a popup 
window to user is 
presented upon this 
condition 

Contact Technical 
Support for service 

37 RECON_BUSY [Placeholder for 
recon busy error] N/A N/A 

38 INSUFFICIENT_D
ISK_SPACE 

Not enough disk 
space to store 
information on the 
Recon computer 

Hard drive on 
Recon computer 
does not have 
enough space for 
image data 

Contact Technical 
Support for service 
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E r ro r -
code  
number  

Fau l t  d e s c r i p t i on  Exp l ana t i on  Cause 3 Re so l u t i on  

39 XBT_Error (Disk 
HW related) 

X-rays were 
terminated due to a 
software anomaly 

Scans that result in 
x-ray Below 
Threshold (XBT) 
can result in missing 
images due to 
system being 
allowed to complete 
scan 

Contact Technical 
Support for service 
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Appendix C  Revision History 
Table 58: Revision history 

Rev i s i on  
ECO number  
and  e f f e c t i v e  
da t e  

Au thor  Changes  

00 
ECO-000139 
2006/03/17 

Mike Duffy Release System BOM 

01 
ECO-000306 
2006/07/26 

Matt Len Releasing revision 01 of the user manual. 

02 
ECO-000311 
2006/08/09 

Matt Len Releasing revision 02 of the user manual. 

03 
ECO-000337 
2006/08/22 

Matt Len Release service manual and update user 
manual. 

04 
ECO-000399 
2006/11/08 

Matt Len Updating user, service and installation 
manuals for Australian certification. 

05 
ECO-000414 
2006/12/11 

Matt Len Releasing system version 04.00 and 
supporting documentation. 

06 
ECO-000495 
2007/05/29 

Mike Duffy UPDATE SYS RADIATION DOCS AND 
USER MANUAL 

07 
ECO-000759 
2008/07/24 

Matt Len Releasing updated NL3000 user manual. 

08 
ECO-000784 
2008/09/09 

Matt Len Updating manual to include NL3000 and 
NL3100. 

09 
ECO-000790 
2008/09/16 

Matt Len Releasing system version 05.00 software. 

10 
ECO-000817 
2008/12/04 

Stephanie Fillion RELEASING SYSTEM VERSION 05.01 
SOFTWARE 

11 
ECO-000864 
2009/02/04 

Kacey Oreal RELEASING SYSTEM VERSION 05.02 
SOFTWARE 

12 
ECO-000921 
2009/04/04 

Don Fickett USER MANUAL CERETOM 

13 
ECO-001103 
2009/12/23 

Stephanie Fillion UPDATING NL3XXX USER MANUAL 

14 
ECO-001164 
2010/08/03 

David O'Leary Release V05.05 CereTom/OTOscan SW 

15 
ECO-001405 
2011/05/17 

Keith Almeida Release V05.06 CereTom/OTOscan SW 
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Rev i s i on  
ECO number  
and  e f f e c t i v e  
da t e  

Au thor  Changes  

16 
ECO-001686 
2012/04/12 

Christofer 
Krueger/Matt 
Dickman 

Update to current user practice.  Added 
formatting for all subject headers, figures, and 
tables.  Added Chapter 13 for accessories, 
Appendix A for the SDS, and Revision 
History Table 

17 
ECO-001889 
2012/12/05 

Christofer 
Krueger 

Update to meet IEC 60601-1 3rd edition and 
HC requirements.  Added 
Warnings/Cautions on contraindication, 
patient support stability, cleaning, PM, and 
calibration.  New Configuration Manager, 
Main and Options Screen shots for v5.10.  
Product Catalog references and Battery 
Parameters were also added. 

18 
ECO-002008 
2013/07/30 

Christofer 
Krueger 

Added Caution modement Automatic 
Exposure Control (AEC) is not offered on 
this system” to page 17, Section 9. 

19 
ECO-002012 
2013/09/05 

Keith Almeida 

Added additional 3rd edition requirements 
from 60601-2-44 (warnings, cautions, load 
factors, focal spot, filtration, CTDI100 
measurements, scatter measurements, vertical 
plane measurements).  Updates to meet IEC 
60825-1 also added. 

20 
ECO-002167 
2014/05/15 

Keith Almeida Updated to reflect changes made to software 
release V06.01 CereTom/OTOScan  

21 
ECO-002500 
2015/10/09 

Keith Almeida 

Updated to reflect: changes made to software 
release V06.02 CereTom/OTOScan 
(Automatic Exposure Control); Samsung 
additions; updates from Regulatory group 

22 
ECO-002746 
2015/12/11 

William Dalphin 
Updated to reflect: changes made to software 
release V06.02.01 CereTom/OTOScan; 
updates from Regulatory and Service groups 

23 
ECO-002802 
2016/03/01 

Ninad Gujar Updated to reflect the correct storage 
temperature. 

24 
ECO-002984 
2016/08/23 

Courtney Poto Incorporated MPR Slab. 

25 
ECO-003255  
2017/04/13  

Cynthia Crow 
Applied new template/styles, step-by-step 
procedures, and workflow for improved 
audience experience. 
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Rev i s i on  
ECO number  
and  e f f e c t i v e  
da t e  

Au thor  Changes  

OTOScan removed from the manual; 
OTOScan information will (moving forward) 
be documented in its own manual. 

25 
ECO-003317 
2017/05/19 

Cynthia Crow 

The latest release of Revision 25 (under ECO-
003255) contains the changes as described 
above; however, ECO-003255 was never 
distributed.  This submission (ECO-003317) 
includes two notes added to Revision 25 that 
address registrar concerns: external interlocks 
and the method of testing for dose-in-air 
results. 

26 
ECO-003616 
2017/09/21 

Cynthia Crow CereTom changed to CereTom Elite 

27 
ECO-003762 
2017/12/20 

Christofer 
Krueger 

Modified the Intended use to match revised 
510(k) and info on Metal Artifact Reduction 
– update figures 359-360 

28 ECO-003794 
2018/01/12 

Christofer 
Krueger 

Table 54, row 20: From 50 C/5 C (122 F/41 
F) to  
40 C/5 C (104 F/41 F).  Remove MFG 
symbol from table 55. Move I’National reps 
and Itended Use sections to the preface. 

29 
ECO-004219 
2018/11/01 

Christofer 
Krueger 

Adding a note abve Table 11 on EMC 
Characterisitics.  Modified Table 12 to detail 
the correct standard parameters. 
Changed title to include “NL3000 CereTom”.  
Added “CereTom” to the “About this 
Manual” section 

30 
ECO-004754 
2020/03/03 

Christofer 
Krueger 

Added details to comply with IEC 60825-1, 
3rd ed. Table 2 and Laser Safety section of 
Chapter 1.  EU MDR updates: Added Serious 
Injury,  Electronic Copy and Clinical Benefit 
notes to the preface 

31 ECO-004919 
2020/06/17 

Christofer 
Krueger 

Add FDA Laser warning statement and 
updated the marking plate 

32 
ECO-005181  
2021/01/12 

Gina Cunsolo 

Added manufacturers symbol to page 3. 
Removed all reference of CereTom. Updated 
Symbols Table 2 to update the “Refer to 
instructions..” to the booklet symbol. 
Updated Symbols Table 2 and 55 to add all 
symbols currently on system label. 
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Rev i s i on  
ECO number  
and  e f f e c t i v e  
da t e  

Au thor  Changes  

33 
ECO-006215 
2022/06/23 

Gina Cunsolo 

Addition of new CE Mark; update to Brazil 
representatibe; correction of EU AR; update 
to electronic user manual information; 
updated figure 3 and removed previous 
marking plate label.  

34 
ECO-007246 
2024/08/06 

Keith A. Kaser Added Safety Strap information to Chapter 
13 

35 
ECO-007461 
2025/03/12 

Keith A. Kaser 

Added additional contact information related 
to adverse events to resolve Bug# 6322 
Added Warning in Safety Information section 
related to decommissiong system to remove 
health software to resolve Bug# 6201 
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